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Welcome to WebSphere Commerce

This book describes how to install and configure WebSphere Commerce 5.4
for Windows NT or Windows 2000 for use with a DB2 database. It is intended
for system administrators or for anyone else responsible for performing
installation and configuration tasks.

If you have WebSphere Commerce Suite Version 5.1 installed, follow the
migration steps described in the WebSphere Commerce Migration Guide. This
book will be available in the Technical Libraries section of the WebSphere
Commerce Web page.

Updates to this book

To learn about last-minute changes to the product, see the README file in the
root directory of the WebSphere Commerce Disk 1 CD. In addition, a copy of
this book, and any updated versions of this book, are available as PDF files
from the Library →Technical Library section of the WebSphere Commerce Web
site:
v Business Edition:

http://www.ibm.com/software/webservers/commerce/wc_be/lit-tech-general.html

v Professional Edition:
http://www.ibm.com/software/webservers/commerce/wc_pe/lit-tech-general.html

Updates from the last version of this document are identified by revision
characters contained in the margin. This book uses the following conventions
for revision characters:
v The ″+″ character identifies updates that have been made in the current

version of this document.
v The ″|″ character identifies any updates that have been made in the

previous versions of this document.

Conventions used in this book

This book uses the following highlighting conventions:
v Boldface type indicates commands or graphical user interface (GUI)

controls such as names of fields, icons, or menu choices.
v Monospace type indicates examples of text you enter exactly as shown, file

names, and directory paths and names.
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v Italic type is used to emphasize words. Italics also indicate names for which
you must substitute the appropriate values for your system. When you see
the following names, substitute your system value as described:

host_name
The fully qualified host name of your WebSphere Commerce Web
server (for example, server1.torolab.ibm.com is fully qualified).

instance_name
The name of the WebSphere Commerce instance with which you
are working.

drive The letter representing the drive on which you installed the product
or component being discussed (for example, C:).

This icon marks a Tip - additional information that can help you
complete a task.

Important
These sections highlight especially important information.

Warning
These sections highlight information intended to protect your data.

Default installation paths
When this book refers to installation paths, it uses the following default path
names:

drive:\WebSphere\CommerceServer
The WebSphere Commerce installation path.

drive:\WebSphere\sqllib
The IBM DB2 Universal Database 7.1.0.55 installation path.

drive:\WebSphere\HTTPServer
The IBM HTTP Server 1.3.19.1 installation path.

drive:\WebSphere\AppServer
The WebSphere Application Server 4.0.2 installation path.

drive:\dmb
The IBM DB2 Text Extender 7.1 installation path.

drive:\Program Files\IBM\PaymentManager
The IBM WebSphere Payment Manager 3.1.2 installation path.
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Note: If not enough room exists on the default drive, the WebSphere
Commerce installation program is designed to install the product on
the next available drive with sufficient space.

CAUTION:
We strongly suggest that you do not override the default paths of the
mandatory products during their installation. The WebSphere Commerce
installation program is designed to search for products in certain locations
and moving these products to another directory may cause errors.

Products included with WebSphere Commerce

The following products are packaged with WebSphere Commerce:
v WebSphere Commerce Components

– WebSphere Commerce Server
– WebSphere Commerce Accelerator
– WebSphere Catalog Manager
– WebSphere Commerce Administration Console
– Product Advisor
– Blaze Rules Server and Blaze Innovator Runtime
– Macromedia LikeMinds client

v IBM DB2 Universal Database 7.1.0.55
v IBM DB2 Extenders 7.1
v IBM HTTP Server 1.3.19.1
v WebSphere Application Server 4.0.2
v IBM WebSphere Payment Manager 3.1.2, which includes:

– Payment Manager SET Cassette 3.1.2
– Payment Manager Cassette for CyberCash 3.1.2
– Payment Manager Cassette for VisaNet 3.1.2
– Payment Manager Cassette for BankServACH 3.1.2

v IBM WebSphere Commerce Analyzer 5.4
v Brio Broadcast Server 6.2
v IBM SecureWay Directory Server 3.2.1
v Segue SilkPreview 1.0™

v WebSphere Commerce 5.4 Recommendation Engine powered by
LikeMinds™

v QuickPlace 2.9.8
v Sametime 2.5
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Alternative Web servers
Although IBM HTTP Server is the Web server provided with WebSphere
Commerce, Microsoft IIS 5.0 on Windows 2000, Microsoft IIS 4.0 on Windows
NT, iPlanet Web Server, Enterprise Edition 4.1.8 on Windows NT, and Lotus
Domino Web Server 5.0.5, 5.0.6, and 5.0.8 are also supported.

Alternative databases
Although IBM DB2 Universal Database 7.1.0.55 Enterprise Edition is the
database provided with WebSphere Commerce, you can use Oracle Database
8.1.7.2.1, Enterprise Edition, or Standard Edition (also known as Oracle 8i
release 3). If you choose to use Oracle Database 8.1.7, Enterprise Edition or
Standard Edition instead of DB2 Universal Database, you need to refer to the
IBM WebSphere Commerce Installation Guide: Installing WebSphere Commerce 5.4
for use with an Oracle Database.

If you are currently using IBM DB2 Universal Database 7.1.0.55 Workgroup
Edition, you will be required to upgrade it to IBM DB2 Universal Database
7.1.0.55 Enterprise Edition.

Alternative Lightweight Directory Access Protocol software

You can use the following types of Lightweight Directory Access Protocol
(LDAP) directory servers with WebSphere Commerce 5.4:
v IBM SecureWay® Directory

v NT Netscape Directory Server

v 2000 Microsoft Active Directory

Supported Web browsers

You can only access the WebSphere Commerce tools and online help using
Microsoft® Internet Explorer 5.5 from a machine running a Windows
operating system on the same network as your WebSphere Commerce
machine. You must use Internet Explorer full version 5.50.4522.1800 (also
known as Internet Explorer 5.5 Service Pack 1 and Internet Tools) or later with
the latest critical security updates from Microsoft— prior versions do not
support full functionality of WebSphere Commerce tools.

Shoppers can access Web sites by using any of the following Web browsers,
all of which have been tested with WebSphere Commerce:
v Any version of Netscape Navigator supported with Netscape

Communicator 4.6 or above, including Netscape Navigator 4.04, and 4.5
v Netscape Navigator 3.0 and 4.0 or above for Macintosh
v Microsoft Internet Explorer 4 and 5 or above
v AOL 5 and 6 or above

x Installing WebSphere Commerce for use with a DB2 Database



Supported configurations

WebSphere Commerce, its components and its supported alternative software
can be installed in a variety of configurations. The following configurations
are supported and are described in this book:

1-tier install:
In this configuration, all components of WebSphere Commerce are
installed on a single machine. To install this configuration, complete
the steps outlined for your Web server:

IBM HTTP Server

1. Install DB2 Universal Database, IBM HTTP Server,
WebSphere Application Server, and WebSphere Commerce
as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

2. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

3. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Starting the WebSphere Application Server

4. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

5. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages™ files.
v Running the Security Checker tool

6. Complete any optional tasks, such as:
v Creating a store from a sample store archive
v Enabling SSL for production with IBM HTTP Server

iPlanet Web Server

1. Install iPlanet Web Server as outlined in “Install and
Configure iPlanet Web Server” on page 14.

2. Install DB2 Universal Database, WebSphere Application
Server, and WebSphere Commerce as outlined in
Chapter 4, “Installing WebSphere Commerce” on page 19.
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3. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

4. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Upgrading the iPlanet Web Server plug-in level
v Starting the WebSphere Application Server

5. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

6. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Completing your iPlanet Web Server installation
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

7. Complete any optional tasks, such as:
v Creating a store from a sample store archive

Domino Web Server

1. Install Domino Web Server as outlined in “Installing and
Configuring Domino Web Server” on page 15.

2. Install DB2 Universal Database, WebSphere Application
Server, and WebSphere Commerce as outlined in
Chapter 4, “Installing WebSphere Commerce” on page 19.

3. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

4. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Starting the WebSphere Application Server

5. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

6. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
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v Compiling the JavaServer Pages files.
v Running the Security Checker tool

7. Complete any optional tasks, such as:
v Creating a store from a sample store archive

Microsoft IIS

1. Install Microsoft IIS as outlined in “Installing Microsoft IIS
for WebSphere Commerce” on page 13.

2. Install DB2 Universal Database, WebSphere Application
Server, and WebSphere Commerce as outlined in
Chapter 4, “Installing WebSphere Commerce” on page 19.

3. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

4. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Configuring Microsoft IIS
v Starting the WebSphere Application Server

5. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

6. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Completing your Microsoft IIS configuration
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

7. Complete any optional tasks, such as:
v Creating a store from a sample store archive

2-tier install:
In this configuration, the database server is installed on a separate
machine from all other WebSphere Commerce components.

IBM HTTP Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install IBM HTTP Server, WebSphere Application Server,
and WebSphere Commerce as outlined in Chapter 4,
“Installing WebSphere Commerce” on page 19.
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3. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

4. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Complete your remote DB2 Universal Database

installation
v Starting the WebSphere Application Server

5. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

6. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

7. Complete any optional tasks, such as:
v Creating a store from a sample store archive
v Enabling SSL for production with IBM HTTP Server

iPlanet Web Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install iPlanet Web Server as outlined in “Install and
Configure iPlanet Web Server” on page 14.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Complete your remote DB2 Universal Database

installation
v Upgrading the iPlanet Web Server plug-in level
v Starting the WebSphere Application Server
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6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Completing your iPlanet Web Server installation
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
v Creating a store from a sample store archive

Domino Web Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install Domino Web Server as outlined in “Installing and
Configuring Domino Web Server” on page 15.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Complete your remote DB2 Universal Database

installation
v Starting the WebSphere Application Server

6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
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v Creating a store from a sample store archive

Microsoft IIS

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install Microsoft IIS as outlined in “Installing Microsoft IIS
for WebSphere Commerce” on page 13.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Complete your remote DB2 Universal Database

installation
v Configuring Microsoft IIS
v Starting the WebSphere Application Server

6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Completing your Microsoft IIS configuration
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
v Creating a store from a sample store archive

3-tier install:
In this configuration, the database server and Web server are each
installed on separate machines from the WebSphere Commerce server
and WebSphere Application Server.

IBM HTTP Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.
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2. Install IBM HTTP Server, WebSphere Application Server,
and WebSphere Commerce as outlined in Chapter 4,
“Installing WebSphere Commerce” on page 19.

3. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

4. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Complete your remote DB2 Universal Database

installation
v Starting the WebSphere Application Server

5. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

6. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Configuring your IBM HTTP Server in a 3–tier

environment
v Copying assets to your Web server
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

7. Complete any optional tasks, such as:
v Creating a store from a sample store archive
v Enabling SSL for production with IBM HTTP Server

iPlanet Web Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install iPlanet Web Server as outlined in “Install and
Configure iPlanet Web Server” on page 14.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
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v Complete your remote DB2 Universal Database
installation

v Upgrading the iPlanet Web Server plug-in level
v Starting the WebSphere Application Server

6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Completing your iPlanet Web Server installation
v Copying assets to your Web server
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
v Creating a store from a sample store archive

Domino Web Server

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install Domino Web Server as outlined in “Installing and
Configuring Domino Web Server” on page 15.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Starting the WebSphere Application Server

6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in Chapter 8,
“Post-configuration steps” on page 83:
v Copying assets to your Web server
v Configuring Payment Manager to work with WebSphere

Commerce
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v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
v Creating a store from a sample store archive

Microsoft IIS

1. Install your database as outlined in Chapter 2, “Installing
your DB2 Universal Database” on page 9.

2. Install Microsoft IIS as outlined in “Installing Microsoft IIS
for WebSphere Commerce” on page 13.

3. Install WebSphere Application Server, and WebSphere
Commerce as outlined in Chapter 4, “Installing WebSphere
Commerce” on page 19.

4. Install Payment Manager as outlined in Chapter 5,
“Installing IBM WebSphere Payment Manager 3.1.2” on
page 39.

5. Complete the following tasks in Chapter 6,
“Pre-configuration steps” on page 51:
v Configuring Microsoft IIS
v Starting the WebSphere Application Server

6. Create your WebSphere Commerce instance as outlined in
Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

7. Complete the following tasks in the 3–tier section of
Chapter 8, “Post-configuration steps” on page 83:
v Completing your Microsoft IIS configuration
v Copying assets to your Web server
v Configuring Payment Manager to work with WebSphere

Commerce
v Configuring your Payment Manager settings
v Compiling the JavaServer Pages files.
v Running the Security Checker tool

8. Complete any optional tasks, such as:
v Creating a store from a sample store archive
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Port numbers used by WebSphere Commerce

The following is a list of the default port numbers used by WebSphere
Commerce or its component products. Please ensure that you do not use these
ports for non-WebSphere Commerce applications. If you have a firewall
configured in your system, ensure that you can access these ports.

Port Number Used By

80 IBM HTTP Server non-secure Web servers

389 Lightweight Directory Access Protocol (LDAP) Directory
Server

443 IBM HTTP Server secure Web server

900 WebSphere Application Server bootstrap

1099 WebSphere Commerce Configuration Manager

1521 Oracle Listener (default)

8000 WebSphere Commerce Tools

8080 WebSphere Test Environment for VisualAge® for Java™

8620 Payment Manager Cassette for SET™

8888 iPlanet Web Server Administration

9000 WebSphere Application Server Location Server

16999 WebSphere Commerce Cache Daemon (default)

50000 DB2® connect (default)

50001 DB2 interrupt (default)

Quick reference to user IDs, passwords and Web addresses

Administration in the WebSphere Commerce environment requires a variety
of user IDs. These user IDs along with their requisite authorities are described
in the list below. For the WebSphere Commerce user IDs, the default
passwords are identified.

Windows User ID
Your Windows user ID must have Administrator authority. DB2
requires that the user ID and password adhere to the following rules:
v They cannot be more than 8 characters in length.
v They can contain only the characters A to Z, a to z, 0 to 9, @, #, $,

and _.
v They cannot begin with an underscore (_).
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v The user ID cannot be any of the following, in upper, lower, or
mixed case: USERS, ADMINS, GUESTS, PUBLIC, LOCAL.

v The user ID cannot begin with any of the following in upper, lower,
or mixed case: IBM, SQL, SYS.

v The user ID cannot be the same as any Windows service name.
v The user ID must be defined on the local machine, and belong to

the Local Administrator’s group.
v The user ID must have the Act as part of the operating system

advanced user right.

You can perform the installation without the Act as part of the
operating system advanced user right, however, the DB2 setup
program will be unable to validate the account that you specify for
the Administration Server. It is recommended that any user account
used to install DB2 has this advanced user right.

Important
If your Windows user ID does not have Administrator authority,
is more than 8 characters in length, or is not defined on the local
machine, you will be notified of the problem and will not be
able to proceed with the installation.

Later, you will use this user ID as the DB2 database user name
(database user logon ID).

If you need to create a user ID fitting the above criteria, you can
find information on creating a Windows user ID in the Windows
online help.

Configuration Manager user ID
The Configuration Manager tool’s graphical interface allows you to
modify the way WebSphere Commerce is configured. The default
Configuration Manager user ID and password are webadmin and
webibm. You can access Configuration Manager from your WebSphere
Commerce machine, or any machine on the same network as
WebSphere Commerce.

IBM HTTP Server User ID
If you are using IBM HTTP Server, you can access your Web server
home page by opening your Web browser and typing the following
Web address:
http://host_name
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If you have customized your Web server, you may be required to type
the name of your Web server’s front page after the host name.

WebSphere Commerce Instance Administrator
The Instance Administrator user ID and password apply to the
following WebSphere Commerce tools:
v WebSphere Commerce Accelerator. To access the WebSphere

Commerce Accelerator from a remote machine running a Windows
operating system, open your Internet Explorer Web browser, and
type the following Web address:
https://host_name:8000/accelerator

v WebSphere Commerce Administration Console. To access the
WebSphere Commerce Administration Console from a remote
machine running a Windows operating system, open your Internet
Explorer Web browser, and type the following Web address:
https://host_name:8000/adminconsole

v Store Services. You can access your Store Services page by opening
your Web browser and typing the following Web address:
https://host_name:8000/storeservices

v Business Organization Administration Console. You can access the
Organization Administration Console by opening your Web
browser and typing the following Web address:
https://host_name/orgadminconsole

The default Instance Administrator user ID is wcsadmin and the
default password is wcsadmin.

Note: The wcsadmin user ID should never be removed, and should
always have instance administrator authority.

WebSphere Commerce requires that the user ID and password adhere
to the following rules:
v The password must be at least 8 characters in length.
v The password must include at least 1 numeric digit.
v The password does not contain more than 4 occurrences of a

character.
v The password does not repeat the same character more than 3

times.

Payment Manager Administrator

When you install Payment Manager, the WebSphere Commerce
Administrator ID, wcsadmin, is automatically assigned the Payment
Manager Administrator role. Follow the instructions in Chapter 5,
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“Installing IBM WebSphere Payment Manager 3.1.2” on page 39 to
switch the Payment Manager Realm Class to WCSRealm if it has not
already been done.

The Payment Manager Administrator role enables a user ID to control
and administer Payment Manager.

Welcome to WebSphere Commerce xxiii



xxiv Installing WebSphere Commerce for use with a DB2 Database



Part 1. Installing WebSphere Commerce 5.4

Topics covered in this section include:
v Chapter 1, “Preinstallation requirements” on page 3
v Chapter 2, “Installing your DB2 Universal Database” on page 9
v Chapter 3, “Installing your Web server” on page 13
v Chapter 4, “Installing WebSphere Commerce” on page 19
v Chapter 5, “Installing IBM WebSphere Payment Manager 3.1.2” on page 39

You must complete these topics in order to successfully install WebSphere
Commerce.

Important
This book describes how to install WebSphere Commerce on a machine
that does not already have a previous version of WebSphere Commerce
installed. If you have WebSphere Commerce Suite Version 5.1 installed
and you want to upgrade to WebSphere Commerce 5.4WebSphere
Commerce Business Edition, please follow the instructions in the
WebSphere Commerce Migration Guide. This document will be available
from the IBM Web site at the following Web address:
http://www.ibm.com/software/webservers/commerce/wc_be/
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Chapter 1. Preinstallation requirements

This chapter describes the steps you need to perform before you install
WebSphere Commerce.

Knowledge requirements

To install and configure WebSphere Commerce, you require knowledge of the
following:
v Personal computers and your operating system
v The Internet
v Web server operation and maintenance
v DB2 Universal Database
v Basic operating system commands

To create and customize your store or mall, you require knowledge of the
following:
v WebSphere Application Server
v DB2 Universal Database
v HTML and XML
v Structured Query Language (SQL)
v Java programming

Please refer to WebSphere Commerce Programmer’s Guide for more information
on customizing your store or mall. A copy of this book is included with both
WebSphere Commerce and WebSphere Commerce Studio.

If you intend to use Microsoft IIS 4.0, Microsoft IIS 5.0, iPlanet Web Server,
Enterprise Edition 4.1.8, or Lotus Domino Web Server, you should have a
good understanding of them as well.

Prerequisite hardware

You must ensure that you meet the following minimum hardware
requirements before installing WebSphere Commerce 5.4:

You require a dedicated Pentium® III 733 MHz (1 GHz or higher
recommended for a production environment) IBM-compatible personal
computer with the following:
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v A minimum of 768 MB of RAM per processor. Each additional WebSphere
Commerce instance will require an additional 512 MB of RAM per instance.

v A minimum of 2 GB of free disk space on your target installation drive.
– You also need an additional 300 MB on the C: drive. If your machine is

formatted with FAT partitioning and the partition is over 1.024 GB, you
will need twice as much free disk space. The installation will check for
adequate free disk space and will warn you if there is not enough space.

– If your machine is formatted with FAT partitioning and the partition is
over 2049 MB, you will need three times as much free disk space.

v Double the amount of paging space as you have RAM (for example, 512
MB RAM should have 1024 MB paging space). This is adjusted through the
Virtual Memory panel of Windows System Properties.

v A CD-ROM drive.
v A graphics-capable monitor with a color depth of at least 256 colors.
v A mouse or other pointing device.
v A local area network (LAN) adapter that is supported by the TCP/IP

protocol.

Note: When enabling WebSphere Application Server security it is strongly
recommended that your machine meets the following requirements:
v A mininum machine memory of 1 GB.
v A minimum heap size of 384 MB, for the WebSphere Commerce

application.

Prerequisite software

You must ensure that you meet the following minimum software requirements
before installing WebSphere Commerce:
v You have one of the following operating systems installed:

– Windows NT Server Version 4.0 with Service Pack 6a installed on your
WebSphere Commerce server. You can obtain the service pack at the
following Web address:
http://www.microsoft.com

Important
If you do not apply Service Pack 6a before installing WebSphere
Commerce 5.4, you will not be allowed to install WebSphere
Commerce.
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To determine if Service Pack 6a is installed, open a DOS prompt and
type winver from command line. If you have the correct service
pack installed, the system information will include a reference to
Service Pack 6a.

– Windows 2000 Server or Advanced Server Edition with Service Pack 2
installed. You can obtain the service pack at the following Web address:
http://www.microsoft.com

Components already installed

Preparing Secure Sockets Layer protocol for testing
If you have IBM HTTP Server already installed on your system, you must
ensure that you have prepared your system for Secure Sockets Layer (SSL)
protocol for testing. If SSL is enabled, you should be able to open the
following URL in a Web browser:
https://host_name

where host_name is the fully qualified host name of the machine running IBM
HTTP Server. The security key file that you build in this section will not
prevent shopper transactions from being viewed by unauthorized individuals.
Before you open your store to shoppers, follow the instructions in Chapter 12,
“Enabling SSL for production with IBM HTTP Server” on page 131.

If you can not open the URL above, you must prepare SSL on you system. To
prepare your system, do the following:
1. Stop the IBM HTTP Server as described in “Starting and Stopping IBM

HTTP Server” on page 148.
2. Change directory to drive:\WebSphere\HTTPServer\conf.
3. Backup httpd.conf to a temporary directory.
4. Rename httpd.conf to httpd.conf.bak.
5. Backup httpd.conf.sample to a temporary directory.
6. Rename httpd.conf.sample to httpd.conf.
7. Select Start → Programs → IBM HTTP Server → Start Key Management

Utility.
8. In the IBM Key Management window, click the Key Database File

menu, and select New.
9. Enter the file name and the file location as follows in the New window

of IBM Key Management:
drive:/WebSphere/HTTPServer/ssl/keyfile.kdb

Click OK.
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10. The Password Prompt window displays.
11. Enter and confirm your IBM HTTP Server password, and enable Stash

the password to a file. Click OK.
12. Click the Create menu, and select New Self-Signed Certificate.
13. On the window that displays, fill in all fields not listed as optional. Click

OK

14. Start the IBM HTTP Server as described in “Starting and Stopping IBM
HTTP Server” on page 148.

Additional tasks
If you have WebSphere Application Server 4.0.2 or IBM HTTP Server 1.3.19.1
already installed on your machine, you must complete certain tasks before
continuing with your WebSphere Commerce installation.

If you have IBM HTTP Server and WebSphere Application Server already
installed, ensure the IBM HTTP Server plugin has been applied to the
drive:\WebSphere\HTTPServer\conf\httpd.conf file. The following four lines
should exist at the end of the file:
LoadModule ibm_app_server_http_module drive:\WebSphere\AppServer\bin\

mod_ibm_app_server_http.dll
Alias /IBMWebAS/ drive:\WebSphere\AppServer\web\
Alias /WSsamples drive:\WebSphere\AppServer\WSsamples\
WebSpherePluginConfig drive:\WebSphere\AppServer\config\plugin-cfg.xml

If these lines are missing, add it to the end of the file.

If you have DB2 Universal Database installed, ensure that the WebSphere
Application Server Application Development Client is installed, and that JDBC
2 is enabled.

Other requirements

You must also do the following:
1. Ensure that you have a Windows user ID that has Administrator authority.

The user ID and password must adhere to the rules as stated in “Quick
reference to user IDs, passwords and Web addresses” on page xx,
including having the Act as part of the operating system advanced user right.
If you use a remote database you will also use this user ID and password
as the DB2 database user logon ID and password.
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Important
If your Windows user ID does not have Administrator authority, or is
more than 8 characters in length, or is not defined on the local
machine, you will be notified of the problem and will not be able to
proceed with the installation.

2. If you are using Windows, ensure that your Windows user ID has the
following user rights:
v Create Token Object
v Increase Quota
v Replace Quota Level Token

3. If you have any applications running, stop them. You will need to restart
your machine during the installation process, which can cause running
applications to lose data.

4. If you are running Lotus® Notes™, or any other server on your machine,
stop the server. If you have a Web server on your machine that is
currently using port 80, port 443, or port 8000, disable it.

5. Since WebSphere Commerce uses both IP addresses and host names, the IP
address on your system must resolve to a host name. To determine your
IP address, open a command window and type the following:
ping host_name

The desired result is a reply from your correct IP address.
6. If you are using IBM HTTP Server as your Web server, ensure that the

host name of your Web server does not contain an underscore ( _ ). IBM
HTTP Server does not support machines with an underscore in their host
name.

7. If you are using Windows 2000, the default operating system installation
installs a copy of Microsoft IIS Web server on your system. If you choose
to use IBM HTTP Server rather than Microsoft IIS, you must uninstall this
server or stop the following services before installing one of the supported
Web servers:
v IIS Admin Service
v World Wide Web Publishing Service
v Simple Mail Transport Protocol (SMTP)

You should also set these services to manual, or disabled, rather than
automatic so that they do not start when you restart your system.
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Chapter 2. Installing your DB2 Universal Database

If you are installing a DB2 Universal Database on the same computer as your
WebSphere Commerce server, you do not need to complete the steps in this
chapter. Please proceed to Chapter 3, “Installing your Web server” on page 13.

If you are installing DB2 Universal Database on a machine other than your
WebSphere Commerce server, you must complete the steps in this chapter
before installing any other components of WebSphere Commerce.

Installing DB2 on a Remote Machine

To reduce the load on your WebSphere Commerce server, you may want to
install your database on a separate machine. This machine must run on the
same operating system as the WebSphere Commerce machine in a
homogeneous environment. You must complete the steps in this section to
successfully install DB2 Universal Database on a machine other than your
WebSphere Commerce machine.

On your DB2 server machine, complete the following steps:
1. Insert the DB2 Universal Database CD and select setup.exe from the root

of the CD.
2. Choose Install from the Installation window. The DB2 install program

starts.
3. In the Select Products window, select DB2 Enterprise Edition and DB2

Application Development Client. Click Next to continue.
4. In the Select Installation Type window, select Custom. Click Next to

continue.
5. In the Select Components window, ensure the following components are

selected:

Note: To select subcomponents as shown below, click Subcomponents to
open the Select Subcomponents window.

v Application Development Interfaces
– JDBC Support
– SQLJ Support
– IBM enhanced Java Runtime Environment

v DB2 Query Patroller Client
v DB2 Connect Server Support
v Data Warehousing Tools
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– Warehouse Server
– Data Warehouse Center
– Warehouse Local Control Database
– Information Catalog Administrator
– Information Catalog User
– Information Catalog Manager for the Web

v Base DB2 UDB Support
v Administration and Configuration Tools

We recommend installing the following components as well:
v Documentation
v Getting Started

Click Next to continue.
6. In the Create DB2 Instance window, select Yes, and click Next to

continue.
7. In the Configure DB2 Services window, do the following for each service:

a. Select the service and click Protocols.
b. Select the TCP/IP tab.
c. Note the values of Service name and Port number for the service.

These will be required when installing the DB2 client.

Click Next when done.
8. Complete the Define a Local Warehouse Control Database window. Note

the values you enter for Username and Password. These values will be
required when installing the DB2 client. The DB2 instance ID and
password on the DB2 server machine must be the same as the DB2 client
machine user ID and password. When completed, click Next.

9. A summary of your choices displays in the Start Copying Files window.
Use this summary to confirm your selections and the following values
that will be required for the DB2 client installation:
v DB2 Instance Log On Username
v DB2 Instance Log On Password (not shown in summary)
v DB2 Instance TCP/IP Service Name
v DB2 Instance TCP/IP Port Number
v Administration Server Log On Username
v Administration Server Log On Password (not shown in summary)
v Control Server Log On Username
v Control Server Log On Password (not shown in summary)
v Control Server TCP/IP Service Name
v Control Server TCP/IP Port Number
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When you have confirmed your selection and noted the values required
for the DB2 client installation, click Next to complete the install.

Important
The DB2 Universal Database instance ID and password must be the
same on both the server machine and client machine.

10. When the DB2 Universal Database installation is complete, the Setup
Complete window displays. Click Finish to exit the DB2 install program.

11. The Product Registration tool may start after exiting the DB2 install
program. You may choose to complete it at this time.

12. The DB2 First Steps window displays. Select Exit to close the First Steps
window.

You must do the following to complete the DB2 Universal Database
installation:
1. From the Windows Services window, stop the DB2 JDBC Applet Server

service.
2. On the WebSphere Commerce Disk 2 CD navigate to the following

directory:
CD_drive:\Software_Patches\DB2_patch4853\

3. Copy the bin, java11, and java12 directories from the WebSphere
Commerce Disk 2 CD, to the following directory on your remote database
machine:
drive:\WebSphere\sqllib\

Select Yes to All.
4. Navigate to the drive:\WebSphere\sqllib\java12 directory.
5. Run usejdbc2.bat.
6. From the Windows Services window, start the DB2 JDBC Applet Server

service.

After installing DB2 Universal Database on your DB2 server machine,
continue with the installation instructions in Chapter 3, “Installing your Web
server” on page 13.
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Chapter 3. Installing your Web server

Although WebSphere Commerce includes a copy of IBM HTTP Server 1.3.19.1,
you can also use iPlanet Web Server, Enterprise Edition 4.1.8 or Lotus Domino
Web Server 5.0.6 as your Web server. In addition, Windows NT users can use
Microsoft IIS 4.0, and Windows 2000 users can use Microsoft IIS 5.0.

If you are installing IBM HTTP Server you can go directly to Chapter 4,
“Installing WebSphere Commerce” on page 19. If you are using any other Web
server you must complete the steps in this chapter on your Web server
machine before installing WebSphere Commerce.

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.

Installing Microsoft IIS for WebSphere Commerce

If you are using Microsoft IIS as your Web server, complete the following
steps on your web server machine:
1. Install Microsoft IIS according to the instructions provided by Microsoft.

Note: Before installing WebSphere Commerce you must stop all Microsoft
IIS web related services and applications including the IIS Admin
Service, World Wide Web Publishing service, FTP service, the
Default Web Site, the Default FTP Site, and the Default SMTP
Virtual Server. Depending the configuration of your Microsoft IIS
server, you may not find all the services or servers on your Web
server machine. See Microsoft IIS documentation for instructions on
how to stop these services and servers.

2. You must now install WebSphere Commerce and create your WebSphere
Commerce instance.
v To install WebSphere Commerce, see Chapter 4, “Installing WebSphere

Commerce” on page 19.
v To create your WebSphere Commerce instance, see Part 2, “Configuring

WebSphere Commerce” on page 49.
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Note: After installing WebSphere Commerce and creating WebSphere
Commerce instance you must start all Microsoft IIS web related
services and applications including the IIS Admin Service, World
Wide Web Publishing service, FTP service, the Default Web Site, the
Default FTP Site, and the Default SMTP Virtual Server. Depending
the configuration of your Microsoft IIS server, you may not find all
the services or servers on your Web server machine. See Microsoft
IIS documentation for instructions on how to stop these services
and servers.

Install and Configure iPlanet Web Server

Restriction
iPlanet Web Server, Enterprise Edition 4.1.8 is only supported on
Windows NT.

You cannot use iPlanet Web Server, Enterprise Edition 4.1.8 as your Web
server on a Windows 2000 Server machine.

If you are using iPlanet Web Server, Enterprise Edition 4.1.8 as your Web
server, complete the following steps on your Web server machine:
1. Install iPlanet Web Server according to the instructions provided by

Netscape. Ensure that you install the following components:
v Netscape Enterprise Server

Do not select Use Custom JDK.
2. Ensure that you create three Web servers: one server for non-SSL

communication (on port 80), one server for SSL communincation (on port
8000), and another server for SSL communication (on port 443).

3. Install a secure certificate signed by a certifying authority, on port 443 and
port 8000, according to Netscape’s instructions.

4. Disable the iPlanet Servlets. To disable the iPlanet Servlets, do the
following:
a. Start the iPlanet Web Server.
b. Disable the iPlanet Servlet:

1) In the iPlanet Console, select the server that needs to be modified.
2) Click Manage.
3) Select the Servlets tab.
4) For Activate Servlet Engine, select No.
5) Click OK.
6) Click Save and Apply.
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7) Repeat these steps for all iPlanet Web servers.
c. Start a browser and enter the name of the local machine as the URL. If

you see the Web server home page, the server is installed and
configured correctly.

5. You must now install WebSphere Commerce and create your WebSphere
Commerce instance.
v To install WebSphere Commerce, see Chapter 4, “Installing WebSphere

Commerce” on page 19.
v To create your WebSphere Commerce instance, see Part 2, “Configuring

WebSphere Commerce” on page 49.

Important:

By default, outside users can access any file that can be served up by iPlanet
Web Server. For security reasons, you should restrict access to Web directories.
See iPlanet Web Server documentation for information on restricting file and
directory access. In addition, you should open the obj.conf file and search for
the NameTrans entries; ensure that the files in the targeted directories are
protected.

Installing and Configuring Domino Web Server

If you are using Lotus Domino 5.0.5, 5.0.6, or 5.0.8 as your Web server,
complete the following steps on your Web server machine:

Note: An excellent resource for this section are the IBM Redbooks. To obtain a
copy of these books, see the IBM Redbook Web site at:
http://www.redbooks.ibm.com/redbooks/SG245955.html

1. Install Domino Web Server according to the instructions provided by
Lotus.

2. Install the Domino Web Server administration client according to the
instructions provided by Lotus. You must select the following options
during the installation process:
v Ensure that you select Domino Administrator when prompted to

select your setup type.
v Ensure that the Domino Web Services check box is selected when

prompted to choose components.
v Ensure that the HTTP check box in the Web Browser section is selected

when configuring your Domino Web Server.

Domino Administrator on the Domino Administrator window.
3. From your Web server machine, select Start > Programs > Lotus

Application > Lotus Domino Administrator.
4. Ensure that your Domino Web Server is running.
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5. Select File > Open Server.
6. Enter the Server name. For example, host_name/domain_name.
7. Click OK to continue.
8. You must create aliases for the Domino Web Server. To create aliases for

the Domino Web Server, do the following:
a. From the left panel, select All Server Document.
b. Select the server_name.
c. Click the Web Server Configuration button.
d. Select Create URL Mapping/Redirection.
e. Select the Basics tab
f. Select the URL -> Redirection URL option from the What do you

want to setup drop down box.
g. Click the Mapping tab. The Mapping/Redirection window displays.

Enter the incoming URL, and redirection URL as shown in the
following table. Click Save and Close to save each alias.

Note: You must repeat step 8a to 8g for each alias you want to create.

Table 1.

Alias Name Incoming URL Redirection URL

accelerator /accelerator /WebSphere/AppServer/installedApps/
WC_Enterprise_App_instance_name.ear/
wctools.war/tools/common/accelerator.html

adminconsole /adminconsole /WebSphere/AppServer/installedApps/
WC_Enterprise_App_instance_name.ear/
wctools.war/tools/adminconsole/
wcsadmincon.html

orgadminconsole /orgadminconsole /WebSphere/AppServer/installedApps/
WC_Enterprise_App_instance_name.ear/
wcstores.war/tools/buyerconsole/
wcsbuyercon.html

storeservices /storeservices /WebSphere/AppServer/installedApps/
WC_Enterprise_App_instance_name.ear/
wctools.war/tools/devtools/
storeservices.html

9. Additional alias configuration steps are required. To configure your
Domino Web Server, do the following:
a. From the left panel, select All Server Document.
b. Select the server_name.
c. Click the Web Server Configuration button.
d. Select Create URL Redirection/Mapping.
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e. Click the Basics tab.
f. Select URL -> Directory from the What do you want to set up drop

down box.
g. Click the Mapping tab. The Mapping/Redirection window displays.

Enter the incoming URL, and redirection URL as shown in the
following table. Click Save and Close to save each alias.

Table 2.

Alias Name Incoming
URL

Target server directory

wcs /wcs drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war

wcsstore /wcsstore drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.war

webeditor /webeditor drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcwebeditor.war

wcsdoc /wcsdoc drive:\WebSphere\CommerceServer\web\
doc\<locale>

wcshelp /wcshelp drive:\WebSphere\CommerceServer\web\
doc\<locale>

10. Select Web > Web Server Configuration in the left hand window.
11. Expanding server_name > Domino Server will list the aliases that have

been added.
12. You must now restart your Domino Web Server to apply your changes.

To restart your Domino Web Server, do the following:
a. To stop your Domino Web Server by typing Ctrl-C on your keyboard.
b. To restart your Domino Web Server, select Start > Programs > Lotus

Application > Lotus Domino Server.
13. Complete the installation of WebSphere Commerce.
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Chapter 4. Installing WebSphere Commerce

This chapter describes how to install WebSphere Commerce.

If you are using Microsoft IIS, Domino Web Server, iPlanet Web Server, or are
installing DB2 Universal Database on a machine other than your WebSphere
Commerce machine, you must complete the steps in Chapter 2, “Installing
your DB2 Universal Database” on page 9 and Chapter 3, “Installing your Web
server” on page 13 before performing any steps in this chapter.

Important:

v This chapter describes how to install WebSphere Commerce using the CDs
provided with the product box. If you copy one or more of the CDs to a
network for the purposes of installing from a network drive, you must not
change the name of the folders, paths, and directories that are on the CDs.
During the installation process, if you are prompted for a component or
CD, you must specify the location of the component.

v If you are running anti-virus software you must change its startup type to
Manual in the Services window and then restart your machine before
installing WebSphere Commerce. After you finish installing WebSphere
Commerce, remember to set the anti-virus service startup type back to
Automatic.

v If you have already installed components of WebSphere Commerce 5.4, you
must ensure that any associated services have been stopped in the Services
window of the Control Panel.

v If you have installed a web server, please stop any associated services or
applications before installing WebSphere Commerce.

Installation Procedures

To install WebSphere Commerce, do the following:
1. Log on to a Windows user ID that has Administrator authority. Your

Windows user ID must adhere to the criteria outlined in the ″Windows
user ID″ section of “Quick reference to user IDs, passwords and Web
addresses” on page xx.

2. Insert the WebSphere Commerce Disk 1 CD into your CD-ROM drive.
3. Change to the root directory of the WebSphere Commerce Disk 1 CD and

run setup.exe.
4. The Choose Setup Language window opens. Select a language from the

list and click OK.

© Copyright IBM Corp. 1996, 2002 19



5. If your system does not meet the preinstallation requirements, a dialog
box will appear detailing the requirements which have not been met.
Click Cancel and then Exit Setup to exit the installation program. Take
the appropriate steps to meet the preinstallation requirements which were
listed and begin the installation again. If your system meets the
minimum requirements but is not optimized for WebSphere Commerce,
note the suggested improvements to your system so that these can be
made post-installation, and click Next to continue.

6. A Welcome window opens. Click Next to continue.
7. The License Agreement screen opens. Note that a DOS window may

briefly appear on your screen prior to the license agreement being
displayed. Review the terms of the license agreement and either accept or
decline the agreement. If you accept the terms of the license agreement,
the installation program will continue. If you decline the license
agreement, the installation program will exit.

8. On the User ID and Password window, enter an administrative Windows
user ID and password. This user ID and password will be used for DB2,
WebSphere Application Server, and IBM HTTP Server if they are installed
through the WebSphere Commerce install. Verify your password and
click Next to continue.

9. If you have already installed any components of WebSphere Commerce,
the system automatically selects the Custom installation method. Please
turn to “Custom Installation” on page 22 to continue. If you do not have
any elements of WebSphere Commerce installed, the Setup Type window
displays. Click Typical or Custom, and then Next to continue, depending
on which type of installation you want to perform, as follows:

Typical
Installation

Select a Typical installation if you want to install the default
components which are packaged with WebSphere Commerce, and
you want them all installed on your WebSphere Commerce
machine. The following components will be installed:

v IBM DB2 Universal Database 7.1.0.55

v IBM HTTP Server 1.3.19.1

v WebSphere Application Server 4.0.2 with and IBM Developer Kit
for Windows, Java 2 Technology Edition, v1.3

v WebSphere Commerce 5.4

You can change the location in which the WebSphere Commerce
components are installed.
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Custom
Installation

Select a Custom installation if:

v You are using Microsoft IIS 4.0, Microsoft IIS 5.0, iPlanet Web
Server, Enterprise Edition 4.1.8 or Oracle Database 8.1.7,
Enterprise Edition or Standard Edition with your WebSphere
Commerce system.

v You want to select which components are installed.

v You have installed your database or Web server on a machine
other than your WebSphere Commerce server.

10. If you select Typical, continue with the steps in “Typical Installation”
below. If you select Custom, continue with the steps in “Custom
Installation” on page 22.

Typical Installation

If you selected a Typical installation in step 9 on page 20 above, continue with
the steps in this section to complete your installation.
__ 1. The Choose Destination window opens. This window allows you to

override the default installation path for some of the products that are
being installed. When you have chosen your installation paths, click
Next to continue.

By default, the installation program uses the first drive that contains
enough free space.

__ 2. Either accept the default folder name or enter the name of the
subfolder which will be created for WebSphere Commerce in the
Program folder. Click Next to continue.

__ 3. A window displays prompting you for the location where the
installation log file will be stored. Accept the default or enter a new
directory, and click Next.

__ 4. The Summary window displays a summary of the selections you have
made. This window lists the components which will be installed, and
the drives on which they will be installed. Click Next to continue.

__ 5. You will be prompted to do the following:
v Insert the DB2 Universal Database CD to install the DB2 Enterprise

Server, and DB2 Application Development Client. Click OK to
continue.

v Insert the WebSphere Application Server, Advanced Edition CD to
install the IBM HTTP Server, and the WebSphere Application Server.
Click OK to continue. You are prompted to provide the path to the
WebSphere Application Server, Advanced Edition CD. Click the
Browse button and select the following path CD_drive:\nt\httpd.
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v Insert the WebSphere Commerce Disk 2 CD and click OK to
continue. This installation may take several minutes to complete.

v The installation program informs you that the installation of
WebSphere Commerce 5.4 is complete. Click OK to continue.
WebSphere Commerce 5.4 is installed.

__ 6. The installation program informs you that the installation of the
WebSphere Application Server FixPak 2 was completed. Click OK to
continue.

__ 7. After WebSphere Commerce has been installed, you are prompted to
restart. Click Finish.

__ 8. Restart your machine.
__ 9. After your system restarts, log on to the same Windows user ID that

you used to begin the installation. It is important that you wait for
your system to finish creating the WebSphere Application Server
database.

__ 10. Complete the steps in “Verifying and Troubleshooting the installation”
on page 35 to ensure that WebSphere Commerce 5.4 has been

properly installed.

Custom Installation

If you selected a Custom installation in step 9 on page 20, you must now
select from the following choices:
v To install your database, Web server, application server, and WebSphere

Commerce server on this single node, see “A single-tier installation”.
v To install your Web server, application server, and WebSphere Commerce

server on this node, see “A 2–tier installation” on page 25.
v To install the WebSphere Commerce server on this node, see “A 3–tier

installation – WebSphere Commerce server” on page 28.
v To install or configure a Web server on this node, see “A 3–tier installation

– Web server” on page 30

A single-tier installation

1. From the Custom Installation window, select the The commerce server, a
Web server and a database check box and click Next to continue.

2. On the Database and Web Server Selection window, use the drop-down
menus to indicate which Web server and database management system
you will be using with WebSphere Commerce. Use the following points
for guidance:
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Web Server Use the drop-down menu to indicate one of the following:

IBM HTTP Server 1.3.19.1
This is the Web server provided with WebSphere
Commerce.

Microsoft IIS
Select this option from the list to indicate that you will be
using Microsoft IIS 4.0, or Microsoft IIS 5.0, with
WebSphere Commerce. Microsoft IIS must already be
installed, as described in Chapter 3, “Installing your Web
server” on page 13.

NT iPlanet Web Server, Enterprise Edition 4.1.8
Select this option from the list to indicate that you will be
using iPlanet Web Server with WebSphere Commerce.
iPlanet Web Server must already be installed, as described
in Chapter 3, “Installing your Web server” on page 13.
This product is not supported on Windows 2000.

Lotus Domino Web Server 5.0.6
Select this option from the list to indicate that you will be
using Domino Web Server with WebSphere Commerce.
Domino Web Server must already be installed, as
described in Chapter 3, “Installing your Web server” on
page 13.

Database Use the drop-down menu to select the following:

IBM DB2 Universal Database 7.1.0.55
This is the database management system provided with
WebSphere Commerce.

When you have made your selections, click Next.
3. The WebSphere Commerce Component Selection window allows you to

choose if the following WebSphere Commerce components will be
installed:
v Commerce Server Samples. You must select this check box if you want

to use a WebSphere Commerce sample stores.
v Commerce Server Documentation. You must select this check box if

you want to install the full version of the online help.

After making your selections, click Next to continue.
4. The Choose Destination window allows you to override the default

installation path for each component you selected. If a previous version
of a component is already installed, the updated version will be installed
in the same directory path.
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When you have chosen your installation paths, click Next.

By default, the WebSphere Commerce installation program uses the
first drive it finds that has enough space for all your selections. If you
want, you can change the drive for all components, or use a different
drive for each component.

5. On the Select Program Folder window, either accept the default folder
name or enter the name of the folder which will be created for
WebSphere Commerce in the Start menu. Click Next to continue.

6. A window displays prompting you for the location where the installation
log file will be stored. Accept the default or enter a new directory, and
click Next.

7. The Summary window displays a summary of the selections you have
made. This window lists setup type, the components which will be
installed, the drives on which they will be installed, and whether any
applications will be upgraded. Click Next to continue.

8. You will be prompted to do the following:
v Insert the DB2 Universal Database CD to install the DB2 Enterprise

Server, and DB2 Application Development Client. Click OK to
continue.

v Insert the WebSphere Application Server, Advanced Edition CD to
install the IBM HTTP Server (if selected), and the WebSphere
Application Server. Click OK to continue. You are prompted to provide
the path to the WebSphere Application Server, Advanced Edition CD.
Click the Browse button and select the following path
CD_drive:\nt\httpd.

Note: If you are using an iPlanet Web Server, you are prompted to
enter the directory that contains the obj.conf file for your
nonsecure server.

v Insert the WebSphere Commerce Disk 2 CD and click OK to continue.
v The installation program informs you that the installation of

WebSphere Commerce 5.4 is complete. Click OK to continue.
9. The installation program informs you that the installation of the

WebSphere Application Server FixPak 2 was completed. Click OK to
continue.

10. The Installation Complete window opens.
11. After WebSphere Commerce has been installed, you are prompted to

restart. Click Finish.
12. Restart your machine.

24 Installing WebSphere Commerce for use with a DB2 Database



13. After your system restarts, log on to the same Windows user ID that you
used to begin the installation. It is important that you wait for your
system to finish creating the WebSphere Application Server database.

14. Complete the steps in “Verifying and Troubleshooting the installation” on
page 35 to ensure that WebSphere Commerce 5.4 has been properly
installed.

A 2–tier installation

A 2–tier installation is an intermediate configuration where the database is
installed separately from the Web server and the Commerce server. This
option will install the Web server, Application server, and Commerce server
on the current machine. You have to install Database Server on a separate
machine.

To install WebSphere Commerce in a 2–tier configuration, do the following:
1. From the Custom Installation window, select the The commerce server, a

Web server and a database check box and click Next to continue.
2. When presented with the Database and Web Server Selection window,

use the drop-down menus to indicate which Web server and database
management system you will be using with WebSphere Commerce. Use
the following points for guidance:
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Web Server Use the drop-down menu to indicate one of the following:

IBM HTTP Server 1.3.19.1
This is the Web server provided with WebSphere
Commerce.

Microsoft IIS
Select this option from the list to indicate that you will be
using Microsoft IIS 4.0, or Microsoft IIS 5.0 with
WebSphere Commerce. Microsoft IIS must already be
installed, as described in Chapter 3, “Installing your Web
server” on page 13.

NT iPlanet Web Server, Enterprise Edition 4.1.8
Select this option from the list to indicate that you will be
using iPlanet Web Server with WebSphere Commerce.
iPlanet Web Server must already be installed, as described
in Chapter 3, “Installing your Web server” on page 13.
This product is not supported on Windows 2000.

Lotus Domino Web Server 5.0.6
Select this option from the list to indicate that you will be
using Domino Web Server with WebSphere Commerce.
Domino Web Server must already be installed, as
described in Chapter 3, “Installing your Web server” on
page 13.

Database Use the drop-down menu to select the following:

DB2 Universal Database Client V7.2
This is the database management system provided with
WebSphere Commerce.

Although you have installed DB2 on s separate machine,
ensure that this component is selected, as the WebSphere
Commerce installation program installs the client
component of DB2 Universal Database.

When you have made your selections, click Next.
3. The WebSphere Commerce Component Selection window allows you to

choose if the following WebSphere Commerce components will be
installed:
v Commerce Server Samples. You must select this check box if you want

to use a WebSphere Commerce sample stores.
v Commerce Server Documentation. You must select this check box if

you want to install the full version of the online help.

After making selections, click Next to continue.
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4. The Choose Destination window allows you to override the default
installation path for each component you selected. If a previous version
of a component is already installed, the updated version will be installed
in the same directory path.
When you have chosen your installation paths, click Next.

By default, the WebSphere Commerce installation program uses the
first drive it finds that has enough space for all your selections. If you
want, you can change the drive for all components, or use a different
drive for each component.

5. On the Select Program Folder window, either accept the default folder
name or enter the name of the folder which will be created for
WebSphere Commerce in the Start menu. Click Next to continue.

6. A window displays prompting you for the location where the installation
log file will be stored. Accept the default or enter a new directory, and
click Next.

7. The Summary window displays a summary of the selections you have
made. This window lists setup type, the components which will be
installed, the drives on which they will be installed, and whether any
applications will be upgraded. Click Next to continue.

8. You will be prompted to do the following:
v Insert the DB2 Universal Database CD to install the DB2

Administration Client. Click OK to continue.
v Insert the WebSphere Application Server, Advanced Edition CD to

install the IBM HTTP Server (if selected), and the WebSphere
Application Server. Click OK to continue. You are prompted to provide
the path to the WebSphere Application Server, Advanced Edition CD.
Click the Browse button and select the following path
CD_drive:\nt\httpd.

Note: If you are using an iPlanet Web Server, you are prompted to
enter the directory that contains the obj.conf file for your
nonsecure server.

v If you are using iPlanet Web Server as your WebSphere Commerce
Web server, you are prompted to provide the location of the obj.conf
file for your non-secure Web server.

v Insert the WebSphere Commerce Disk 2 CD and click OK to continue.
This installation may take several minutes to complete.

v The installation program informs you that the installation of
WebSphere Commerce 5.4 is complete. Click OK to continue.

9. The installation program informs you that the installation of the
WebSphere Application Server FixPak 2 was completed. Click OK to
continue.
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10. After WebSphere Commerce has been installed, you are prompted to
restart. Click Finish.

11. Restart your machine.
12. After your system restarts, log on to the same Windows user ID that you

used to begin the installation. It is important that you wait for your
system to finish creating the WebSphere Application Server database.

13. Complete the steps in “Verifying and Troubleshooting the installation” on
page 35 to ensure that WebSphere Commerce 5.4 has been properly
installed.

A 3–tier installation

A 3–tier installation is an advanced configuration where the database,
WebSphere Commerce server and the Web server are installed on separate
machines. This section describes how to complete the WebSphere Commerce
server and the Web server installation. You should have already installed the
database server on a separate machine.

A 3–tier installation – WebSphere Commerce server
A 3–tier installation is an advanced configuration where the database,
WebSphere Commerce server and the Web server are installed on separate
machines. This option will install the Commerce server on your WebSphere
Commerce server machine. You should have already installed the database
server on a separate machine.

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.

To install WebSphere Commerce in a 3–tier configuration, do the following on
your WebSphere Commerce server machine:
1. From the Custom Installation window, select the The commerce server

check box and click Next to continue.
2. When presented with the Database and Web Server Selection window,

use the drop-down menus to indicate which database management
system you will be using with WebSphere Commerce. Use the following
points for guidance:
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Database Use the drop-down menu to select the following:

DB2 Universal Database Client V7.2
This is the database management system provided with
WebSphere Commerce.

Although you have installed DB2 on s separate machine,
ensure that this component is selected, as the WebSphere
Commerce installation program installs the client
component of DB2 Universal Database.

Join an existing
WebSphere
Administrative
domain

Select this option to use an existing WebSphere Application Server
domain. You should only select this option if you want to enable
WebSphere Application Server cloning. For more information on
cloning, see Chapter 10, “Cloning” on page 117.

When you have made your selections, click Next.
3. The Use Remote Web server window displays. Enter the fully qualified

name of you remote Web server machine.
4. The WebSphere Commerce Component Selection window allows you to

choose if the following WebSphere Commerce components will be
installed:
v Commerce Server Samples. You must select this check box if you want

to use a WebSphere Commerce sample stores.
v Commerce Server Documentation. You must select this check box if

you want to install the full version of the online help.

After making selections, click Next to continue.
5. The Choose Destination window allows you to override the default

installation path for each component you selected. If a previous version
of a component is already installed, the updated version will be installed
in the same directory path.
When you have chosen your installation paths, click Next.

By default, the WebSphere Commerce installation program uses the
first drive it finds that has enough space for all your selections. If you
want, you can change the drive for all components, or use a different
drive for each component.

6. On the Select Program Folder window, either accept the default folder
name or enter the name of the folder which will be created for
WebSphere Commerce in the Start menu. Click Next to continue.

7. A window displays prompting you for the location where the installation
log file will be stored. Accept the default or enter a new directory, and
click Next.

8. The Summary window displays a summary of the selections you have
made. This window lists setup type, the components which will be
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installed, the drives on which they will be installed, and whether any
applications will be upgraded. Click Next to continue.

9. You will be prompted to do the following:
v Insert the DB2 Universal Database CD to install the DB2

Administration Client. Click OK to continue.
v Insert the WebSphere Application Server, Advanced Edition CD to

install the IBM HTTP Server (if selected), and the WebSphere
Application Server. Click OK to continue. You are prompted to provide
the path to the WebSphere Application Server, Advanced Edition CD.
Click the Browse button and select the following path
CD_drive:\nt\httpd.

Note: If you are using an iPlanet Web Server, you are prompted to
enter the directory that contains the obj.conf file for your
nonsecure server.

v Insert the WebSphere Commerce Disk 2 CD and click OK to continue.
v The installation program informs you that the installation of

WebSphere Commerce 5.4 is complete. Click OK to continue.
10. The installation program informs you that the installation of the

WebSphere Application Server FixPak 2 was completed. Click OK to
continue.

11. After WebSphere Commerce has been installed, you are prompted to
restart. Click Finish.

12. Restart your machine.
13. Complete the steps found in “A 3–tier installation – Web server”, to

install and configure your Web server node.

A 3–tier installation – Web server
A 3–tier installation is an advanced configuration where the database,
WebSphere Commerce server and the Web server are installed on separate
machines. This option will install and configure the Web server on your web
server machine. You must have already installed the database server on a
separate machine.

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.
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If you are using Domino Web Server, Microsoft IIS, or iPlanet Web Server,
these must already be installed as described in Chapter 3, “Installing your
Web server” on page 13 — the installation program will only configure your
Web server to communicate with your WebSphere Application Server.

To install WebSphere Commerce in a 3–tier configuration, do the following on
your Web server machine:
1. From the Custom Installation window, select the A Web server check box

and click Next to continue.
2. When presented with the Database and Web Server Selection window,

use the drop-down menus to indicate which Web server you will be
using with WebSphere Commerce. Use the following points for guidance:

Web Server Use the drop-down menu to indicate one of the following:

IBM HTTP Server 1.3.19.1
This is the Web server provided with WebSphere
Commerce.

Microsoft IIS
Select this option from the list to indicate that you will be
using Microsoft IIS 4.0, or Microsoft IIS 5.0 with
WebSphere Commerce. Microsoft IIS must already be
installed, as described in Chapter 3, “Installing your Web
server” on page 13.

NT iPlanet Web Server, Enterprise Edition 4.1.8
Select this option from the list to indicate that you will be
using iPlanet Web Server with WebSphere Commerce.
iPlanet Web Server must already be installed, as described
in Chapter 3, “Installing your Web server” on page 13.
This product is not supported on Windows 2000.

Lotus Domino Web Server 5.0.6
Select this option from the list to indicate that you will be
using Domino Web Server with WebSphere Commerce.
Domino Web Server must already be installed, as
described in Chapter 3, “Installing your Web server” on
page 13.

When you have made your selections, click Next.
3. The WebSphere Commerce Component Selection window allows you to

choose if the following WebSphere Commerce components will be
installed:
v Commerce Server Samples. Do not select this check box.
v Commerce Server Documentation. You must select this check box if

you want to install the full version of the online help.
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v WebSphere Application Server Plugins V4.0. You must select this
check box to install the WebSphere Application Server Web server
plugins.

Note: Selecting the WebSphere Application Server Plugins V4.0 check
box ensures that your Web server machine can communicate
with your WebSphere Commerce machine.

After making selections, click Next to continue.
4. The Choose Destination window allows you to override the default

installation path for each component you selected. If a previous version
of a component is already installed, the updated version will be installed
in the same directory path.
When you have chosen your installation paths, click Next.

By default, the WebSphere Commerce installation program uses the
first drive it finds that has enough space for all your selections. If you
want, you can change the drive for all components, or use a different
drive for each component.

5. On the Select Program Folder window, either accept the default folder
name or enter the name of the folder which will be created for
WebSphere Commerce in the Start menu. Click Next to continue.

6. A window displays prompting you for the location where the installation
log file will be stored. Accept the default or enter a new directory, and
click Next.

7. The Summary window displays a summary of the selections you have
made. This window lists setup type, the components which will be
installed, the drives on which they will be installed, and whether any
applications will be upgraded. Click Next to continue.

8. You will be prompted to do the following:
v Insert the DB2 Universal Database CD to install the DB2

Administration Client. Click OK to continue.
v Insert the WebSphere Application Server, Advanced Edition CD to

install the IBM HTTP Server (if selected), and the WebSphere
Application Server. Click OK to continue. You are prompted to provide
the path to the WebSphere Application Server, Advanced Edition CD.
Click the Browse button and select the following path
CD_drive:\nt\httpd.

Note: If you are using an iPlanet Web Server, you are prompted to
enter the directory that contains the obj.conf file for your
nonsecure server.

v Insert the WebSphere Commerce Disk 2 CD and click OK to continue.
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v The installation program informs you that the installation of
WebSphere Commerce 5.4 is complete. Click OK to continue.

9. The installation program informs you that the installation of the
WebSphere Application Server FixPak 2 was completed. Click OK to
continue.

10. After WebSphere Commerce has been installed, you are prompted to
restart. Click Finish.

11. Restart your machine.
12. After your system restarts, log on to the same Windows user ID that you

used to begin the installation.
13. Complete the steps in “Verifying and Troubleshooting the installation” on

page 35 to ensure that WebSphere Commerce 5.4 has been properly
installed.

Complete your remote DB2 Universal Database installation

If you are using DB2 on a machine other than your WebSphere Commerce
machine, you should have previously completed the steps outlined in
“Installing DB2 on a Remote Machine” on page 9. You also need to complete
the following steps to allow WebSphere Commerce access to your database:
1. On your DB2 server machine, run the following three commands from a

DB2 command window:
db2set DB2_RR_TO_RS=yes
db2set DB2BIDI=yes
db2set DB2_STPROC_LOOKUP_FIRST=true

Restart your DB2 Universal Database services. For information on
stopping and starting your DB2 Universal Database, see “Starting and
Stopping DB2 Universal Database” on page 149.

2. On your DB2 server machine, verify the services file entry by doing the
following:
a. Open the services file located in the

drive:\WINNT\system32\drivers\etc directory, and find the entries that
have comments referring to your DB2 instance connection port. Record
the service name from the first column that corresponds to the lower
port number. For example, if the following services were displayed:
db2cDB2 50000/tcp # Connection port for DB2 instance DB2
db2iDB2 50001/tcp # Interrupt port for DB2 instance DB2

you would record the db2cdb2 service name.
b. Verify the service name recorded in the database manager

configuration using the following command from a DB2 command
window:
db2 get dbm cfg
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Look at the SVCENAME entry. Verify that a value exists, and that it
matches the value for the service name recorded above. For example,
something similar to the following should be displayed:
TCP/IP Service name (SVCENAME) = db2cdb2inst1

If this value does not exist, update the database manager configuration
using the following command:
db2 update dbm cfg using svcename service_name

where service_name should be replaced with the service name
(SVCENAME) recorded above.

3. On your WebSphere Commerce machine, catalog the remote database
server node by typing the following in a DB2 command window:
db2 catalog tcpip node node_name
remote database_server_hostname server port_number

where:

node_name
Is the unique name of your choice that DB2 will use to identify the
database server TCP/IP node.

database_server_hostname
Is the host name of your database server.

port_number
Is the port being used by DB2 (the default is 50000).

4. Attach to the remote database node by typing the following:
db2 attach to node_name user db2_user_ID using db2_userid_password

where:

node_name
Is the unique name of your choice that DB2 will use to identify the
TCP/IP node.

db2_user_ID
Is your DB2 logon user ID.

db2_userid_password
Is the corresponding password for db2_user_ID.

5. Create your WebSphere Application Server database:
a. On a DB2 command line type:

db2 create db was40

b. Increase the application heap size for the WAS database by typing:
db2 update db cfg for was40 using applheapsz 256
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To verify that the WAS40 database has been properly created on the remote
database machine, type:
db2 list db directory

The WAS database should have a directory entry type of REMOTE and a
catalog node number of –1.

6. Create your Payment Manager database:
a. On a DB2 command line type:

db2 create db payman

b. Increase the application heap size for the payman database by typing:
db2 update db cfg for payman using applheapsz 256

To verify that the payman database has been properly created on the remote
database machine, type:
db2 list db directory

The payman database should have a directory entry type of REMOTE and a
catalog node number of –1.

Verifying and Troubleshooting the installation

You should complete the steps found in this section to verify that WebSphere
Commerce had been installed correctly. Depending on your WebSphere
Commerce installation type, complete the tasks outlined in one of the
following sections:
v “Verifying and Troubleshooting the installation in a single tier and a 2–tier

environment”
v “Verifying and Troubleshooting the installation in a 3–tier environment” on

page 36

Verifying and Troubleshooting the installation in a single tier and a 2–tier
environment

To verify that WebSphere Commerce has been installed properly, ensure that
the following directories have been created on your system:
v drive:\WebSphere\AppServer

v drive:\WebSphere\sqllib

v drive:\WebSphere\HTTPServer (if you are using the IBM HTTP Server)
v drive:\WebSphere\CommerceServer

You should also verify that the following log files do not contain error
messages:
v The drive:\WCinstall.log (the location of which you specified during the

installation) describes any problems encountered during the installation.
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v To verify that WebSphere Application Server has installed properly, check
drive:\WebSphere\AppServer\logs\wssetup.log One error is logged,
indicating that the wrong JDBC level is installed on your machine. This
error can be safely ignored.You should see an Install Complete statement
at the end of the log to indicate a successful installation.

v To verify that the WebSphere Application Server FixPak was applied
properly, check drive:\WebSphere\AppServer\logs\was40_ae_ptf_2.log.

v To verify that the WebSphere Application Server database was created
properly, check drive:\WebSphere\AppServer\logs\wasdb2.log. Ensure that
all DB2 commands completed successfully.

v To verify that the WebSphere Application Server efixes installed properly,
check drive:\WebSphere\AppServer\eFix directory. You should ensure that
all of the efixes were applied correctly by checking the Extractor.Log file in
each directory. The Extractor.Log should not contain any errors or
warnings.

To verify your Web server installation, try to access the following Web page in
a browser:
v http://host_name

Where host_name is the fully qualified host name of your WebSphere
Commerce machine. If the http address does not work, ensure that your Web
server has been started.

Note: WebSphere Commerce Installation and Configuration Checker, or IC
Checker, is a standalone, downloadable problem determination tool
which enables users to verify the installation and configuration of
WebSphere Commerce. IC Checker gathers configuration data and logs,
and performs simple error-checking. For information on the IC Checker,
see “Downloadable tools” on page 167.

Verifying and Troubleshooting the installation in a 3–tier environment
To verify that WebSphere Commerce has been installed properly, ensure that
the following directories have been created on your WebSphere Commerce
machine:
v drive:\WebSphere\AppServer

v drive:\WebSphere\CommerceServer

To verify that DB2 Universal Database has been installed properly, ensure that
the following directories have been created on your database machine:
v drive:\WebSphere\sqllib

To verify that your Web server has been installed properly, ensure that the
following directories have been created on your Web server machine (if you
are using the IBM HTTP Server):
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v drive:\WebSphere\AppServer

v drive:\WebSphere\HTTPServer (if you are using the IBM HTTP Server)
v drive:\WebSphere\CommerceServer

You should also verify that the following log files on your WebSphere
Commerce machine, do not contain error messages:
v The drive:\WCinstall.log (the location of which you specified during the

installation) describes any problems encountered during the installation.
v To verify that WebSphere Application Server has installed properly, check

drive:\WebSphere\AppServer\logs\wssetup.log. One error is logged,
indicating that the wrong JDBC level is installed on your machine. This
error can be safely ignored.You should see an Install Complete statement
at the end of the log to indicate a successful installation.

v To verify that the WebSphere Application Server FixPak was applied
properly, check drive:\WebSphere\AppServer\logs\was40_ae_ptf_2.log.

v To verify that the WebSphere Application Server efixes installed properly,
check drive:\WebSphere\AppServer\eFix directory. You should ensure that
all of the efixes were applied correctly by checking the Extractor.Log file in
each directory. The Extractor.Log should not contain any errors or
warnings.

To verify your Web server installation, open a browser on your Web server
machine and access the following Web page:
v http://host_name

Where host_name is the fully qualified host name of your Web server machine.
If the http address does not work, ensure that your Web server has been
started.

Note: WebSphere Commerce Installation and Configuration Checker, or IC
Checker, is a standalone, downloadable problem determination tool
which enables users to verify the installation and configuration of
WebSphere Commerce. IC Checker gathers configuration data and logs,
and performs simple error-checking. For information on the IC Checker,
see “Downloadable tools” on page 167.
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Chapter 5. Installing IBM WebSphere Payment Manager
3.1.2

This chapter describes how to install and configure Payment Manager on your
local WebSphere Commerce machine, or on a machine that is remote from
your WebSphere Commerce machine. Install Payment Manager on a remote
machine to improve the performance of payment processing. To complete the
steps in this chapter, you will need the IBM Payment Manager 3.1.2 CD.

If you want to install Payment Manager on your local WebSphere Commerce
machine you must install Payment Manager after installing WebSphere
Commerce and before you create your WebSphere Commerce instance, so that
the Payment Manager install program can automatically configure Payment
Manager for WebSphere Commerce.

For additional information, see the IBM WebSphere™ Payment Manager for
Multiplatforms Installation Guide, Version 3.1.2 and the IBM WebSphere Payment
Manager for Multiplatforms Administrator’s Guide, Version 3.1.2 on the Payment
Manager CD.

Prerequisites for installation

If you are installing Payment Manager on your WebSphere Commerce
machine, most of the prerequisites for installing Payment Manager are already
met. You can proceed directly to “Before installing Payment Manager” on
page 42 and install Payment Manager. If you are installing Payment Manager
on a machine that is remote from your WebSphere Commerce machine, you
need to meet the hardware and software prerequisites for your machine as
documented in the following sections.

Hardware requirements
v Intel Pentium II personal computer with a 500 MHz processor or better that

supports Windows NT Version 4.0 or Windows 2000 Server.
v A network communications adapter that supports the TCP/IP protocol

(Ethernet or Token Ring card).
v Network connectivity to the internet
v A CD-ROM drive.
v 512 MB RAM minimum.
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v 150 MB free disk space minimum if you are installing Payment Manager
and WebSphere Application Server on the same file system (or 75 MB on
the Payment Manager system and 75 MB on the WebSphere Application
Server system if installing separately)

v 150 MB of disk space minimum on whichever disk the TEMP environment
variable points to.

Note: Note: On Windows 2000, each user has their own TEMP environment
variable which is set by default to:
c:\Documents and Settings\logon_userid\Local Settings\Temp

v Additional disk space for your database.
v Additional disk space for any payment cassettes you intend to use.

To find the location of your temporary files, at a DOS command prompt enter:
set TEMP

Note: The total recommended disk space is greater than the sum of all
software products packaged with the Payment Manager. This numeric
value allows for database and log file post-installation growth.

Software requirements
v One of the following:

– Windows NT Version 4.0 Workstation or Server with Service Pack 6a, or
higher. You can download the latest service packs from:
http://www.microsoft.com

– Windows 2000 Server or Advanced Server Edition with Service Pack 2.

For information on upgrading your operating system, see your Windows
documentation.

v A database product. The following databases are supported by IBM
Payment Manager 3.1.2:
– IBM DB2 Universal Database 7.1.0.55
– Oracle Database 8.1.7, Enterprise Edition or Standard Edition

v WebSphere Application Server 4.0.2
v IBM SDK for Java. WebSphere Application Server 4.0.2 requires the IBM

Developer Kit for Windows, Java 2 Technology Edition, v1.3 . (This software
is installed by default when you install WebSphere Application Server 4.0.2)
To obtain IBM SDK for Java, see:
http://www.ibm.com/java/jdk/download/index.html

v A Web server (IBM HTTP Server 1.3.19.1 is installed by default when you
install WebSphere Application Server 4.0.2). See the WebSphere Application
Server documentation for supported Web servers.
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v A Web browser to view the Payment Manager user interface. Payment
Manager has been optimized for:
– Netscape Communicator 4.08 or higher.
– Microsoft Internet Explorer 4.01 with Service Pack 2, or higher.

Note: While a Web browser is not required to be installed on the same
machine as Payment Manager, a Web browser is necessary to access the
Payment Manager user interface as well as WebSphere Application
Server.

Standard installation
IBM WebSphere Payment Manager 3.1.2 relies on several software products,
including:
v A database product
v IBM WebSphere Application Server
v A Web server product

The Payment Manager installation program determines whether or not a
suitable set of prerequisite products has been installed. If WebSphere
Application Server and a suitable web server have not been installed, the
Payment Manager installation program will issue a message that they were
not detected on your system. These components must be installed and
running before you install IBM WebSphere Payment Manager 3.1.2.

You can install the following software from the CD-ROMs supplied with the
WebSphere Commerce package:
v IBM DB2 Universal Database 7.1.0.55
v WebSphere Application Server 4.0.2, Advanced Edition
v IBM HTTP Server 1.3.19.1
v IBM Developer Kit for Windows, Java 2 Technology Edition, v1.3 .

If you are using different levels of software than the above, or you are
migrating from an earlier version of Payment Manager, refer to the IBM
WebSphere Payment Manager for Multiplatforms Installation Guide, Version 3.1.2
publication for additional planning and installation considerations.

Installing a database and WebSphere Application Server
If you do not have WebSphere Application Server 4.0.2 installed on the
machine where you are installing Payment Manager, you need to install it:
1. Insert the WebSphere Application Server, Advanced Edition CD supplied

with WebSphere Commerce into your CD-ROM drive. If the WebSphere
Application Server installation program does not get invoked
automatically, double-click setup.exe at the root of the CD. In the Select
Language window, select your language and follow the online install
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instructions to install WebSphere Application Server. Upon restarting your
machine after installing WebSphere Application Server, the WebSphere
Application Server installation program launches a DB2 command window
and then creates and populates the WAS40 database.

Before installing Payment Manager
1. Read the latest readme file, readme.framework.html, accessed through

documentation links on the Payment Manager Web site:
http://www.ibm.com/software/webservers/commerce/paymentmanager/
support.html

and on the Payment Manager CD-ROM.
2. Payment Manager requires IBM Developer Kit for Windows, Java 2

Technology Edition, v1.3 . If you are using earlier versions of WebSphere
Application Server (for example, Version 2.0.3.x or 3.0.2.x) which use
earlier versions of the IBM SDK for Java, you must upgrade WebSphere
Application Server and have the IBM Developer Kit for Windows, Java 2
Technology Edition, v1.3 installed prior to installing Payment Manager.
WebSphere Application Server 4.0.2 uses IBM Developer Kit for Windows,
Java 2 Technology Edition, v1.3 .

3. You must have a database product already installed for use with Payment
Manager:
v If you are using UDB, you must use IBM DB2 Universal Database

7.1.0.55 or higher.
v Create a database for Payment Manager (for example, payman ) by

issuing the following commands in a DB2 Command Line Processor:
create db payman
update db cfg for payman using APPLHEAPSZ 256

v The database must be running during Payment Manager installation.
4. Before installation begins, ensure that:

v WebSphere Application Server is installed. The WebSphere Application
Server administration server should be running at installation. Also,
make sure WebSphere Application Server does not have an application
server named WebSphere Payment Manager configured for another
purpose (such as for use with other products). If so, rename or delete it.
To delete it, do the following:
a. From the WebSphere Application Server Administrative console,

select the Payment Manager application server. Right-click the
selection.

b. Select Remove.
v If you are migrating from Payment Manager Version 2.1 or Version 2.2,

ensure the Payment Manager is not running.
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5. Ensure that WebSphere security is disabled before installing Payment
Manager or any payment cassettes. To disable security, see “Disabling
WebSphere Application Server security” on page 162.After following
subsequent procedures to install Payment Manager and any payment
cassettes, you can re-enable security.

Installing Payment Manager

To install Payment Manager, follow these steps:
1. Log on to a Windows user ID that has Administrator authority. Your

Windows user ID must adhere to the criteria outlined in the ″Windows
user ID″ section of “Quick reference to user IDs, passwords and Web
addresses” on page xx.

2. Ensure the resolution on your display is set to 800 by 600 pixels or higher
to best view the Payment Manager installation program.

3. Insert the Payment Manager for Windows NT and Windows 2000 CD-ROM.
4. Change to the root directory of the CD-ROM
5. From a command prompt, enter Install.
6. On the Payment Manager Install screen, click Next.
7. Accept the default destination directory or enter another directory, and

click Next.
8. If you are migrating from Payment Manager Version 2.2 or Version 2.1

and the installation program finds the Test Cassette, it will delete it and
inform you of the deletion. Click Next to proceed.

9. If WebSphere Application Server 4.0.2 is already installed and the
installation program can not determine which IBM SDK for Java that
WebSphere Application Server is using, you will be asked to enter the
location of the IBM SDK for Java directory. If the location displayed is
correct, click Next. If not, enter the correct location and click Next.

10. Select which database you will use with Payment Manager. Select IBM
DB2 Universal Database, and click Next.

11. When the installation finds the JDBC™ driver information, click Next. If it
does not find the JDBC driver information, use the following information,
depending on your database product:

DB2 Universal Database

v JDBC Driver Class name: COM.ibm.db2.jdbc.app.DB2Driver
v JDBC Class location: DB2_install_directory\java\db2java.zip
v JDBC Driver shared library path: DB2_install_directory\bin\

Note: If you enter incorrect database information and database errors
occur, using the Back button may cause more database error
pop-ups to appear. If this occurs, you can either click Cancel and
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restart the installation, or you can click Back through several
screens and then move forward using the Next buttons (ensuring
that the correct values are entered at each intervening screen) until
you get back to the database entry screen. Once this screen
reappears, you can enter the correct information.

12. On the Payment Manager Database Access Information screen, enter your
values according to what database you will use with Payment Manager,
and click Next to continue:

DB2 Universal Database

v Database owner user ID
v Administrator’s user ID
v Administrator’s password
v Payment Manager database name (for example, payman)
v DB2 instance name

13. On the Payment Manager WebSphere Configuration Information screen,
accept the default node name if it is correct for your machine, or enter
the WebSphere Application Server node name of the machine where you
wish to run Payment Manager. The node name must be the same as what
is listed in the WebSphere Application Server Administration Console for
node name of your machine.

14. On the Installation Summary screen, review the chosen parameters. Click
Next to continue the installation.

Note: At times during the installation, the progress bar may appear to
have stopped. Do not terminate the installation, which is
continuing. The progress bar will resume moving, when system
resources permit.

15. The IBM WebSphere Payment Manager 3.1.2 Readme window opens.
Click Next to continue.

16. The Payment Manager installation is complete.
17. Restart your system.

Windows shortcuts
As part of the installation, shortcuts are provided on the Windows Start
menu. You can use these shortcuts to do the following:
v Log on to Payment Manager
v View the readme file, if you haven’t already done so.
v Uninstall Payment Manager
v View Payment Manager product documentation on an IBM Web site.
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Post installation steps

After you have installed IBM Payment Manager 3.1.2 on your operating
system, perform these activities, as necessary:
v Install the payment cassette or cassettes you will be using with Payment

Manager.
Before installing the payment cassettes:
– Ensure that WebSphere Application Server and your Web server are

started, as shown in “Starting and Stopping WebSphere Application
Server” on page 147 and “Starting and Stopping IBM HTTP Server” on
page 148.

– If it is running, stop the WebSphere Payment Manager Application
Server from the WebSphere Application Server Administrator’s Console.
This ensures that the configuration files for Payment Manager can be
updated by the payment cassette installation program. If you are
installing more that one type of cassette, you must stop the Payment
Manager Application before installing each cassette. For more
information, see “Starting and Stopping Payment Manager” on page 150.

For information on using the CustomOffline Cassette or the OfflineCard
Cassette, which are installed with Payment Manager, see the Payment
Manager Administrator’s Guide.

For information on installing other payment cassettes, see the
cassette-specific supplement for the cassette you are installing. For IBM
cassettes, see the following documents:
– The IBM WebSphere Payment Manager for Multiplatforms Cassette for SET

Supplement , in PDF file format (paymgrset.pdf)
– The IBM WebSphere Payment Manager for Multiplatforms Cassette for

VisaNet Supplement, in PDF file format (paymgrvisanet.pdf)
– The IBM WebSphere Payment Manager for Multiplatforms Cassette for

CyberCash Supplement , in PDF file format (paymgrcyber.pdf)
– The IBM WebSphere Payment Manager for Multiplatforms Cassette for

BankServACH Supplement , in PDF file format (paymgrbank.pdf)

For third-party cassettes, see the information provided with the cassette.

Configuring Lotus Domino Server
If you are using Lotus Domino Server Release 5 with Payment Manager, you
must add the user admin to Lotus Domino Server after installing the Payment
Manager (but before logging into the Payment Manager user interface for the
first time). To add the user admin to the Domino directory:
1. Enter the following URL in a web browser:

http://host_name/webadmin.nsf
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2. Select Directories → People → Add Person.
3. In the Last name field enter: admin.
4. In the User name field enter: admin.
5. In the Internet password field enter: admin.

Note: To access Payment Manager through the WebSphere Commerce
Administration Console you must add the default WebSphere
Commerce Instance Administrator userID and password. For example,
wcsadmin.

Each time you add a Payment Manager user, you must first add the user in
Lotus Release 5 using the above instructions. Users must also be added to
WebSphere realm. Under WebSphere Application Server, Payment Manager
creates its own realm.

To add users to the realm, use the PSDefaultRealm.cmd. For example, at a
command prompt, enter:
PSDefaultRealm realm_file_name add userID password

where realm_file_name is the Payment Manager realm file name (for example,
WCSRealm), and userID, and password are the desired user ID and password.

Configuration for remote Payment Manager

If IBM Payment Manager 3.1.2 is installed on a system remote from
WebSphere Commerce 5.4, IBM Payment Manager 3.1.2 will use the
PSDefaultRealm. If you would like to use IBM Payment Manager 3.1.2 in
conjunction with your WebSphere Commerce, you will need to manually
configure your IBM Payment Manager 3.1.2 system to use the WCSRealm
instead of the PSDefaultRealm.

This can be done by following these steps (on your IBM Payment Manager
3.1.2 system):
1. Open the WebSphere Application Server Administrative Console.
2. Navigate to and access the WebSphere Payment Manager application

server by doing the following:
a. Expand WebSphere Administrative Domain.
b. Expand Nodes.
c. Expand node_name.
d. Expand Application Servers.
e. Select WebSphere Payment Manager. Click the Stop button to stop the

WebSphere Payment Manager application server.
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3. After the WebSphere Payment Manager application server has stopped.
Select the JVM Settings tab page. In the System Properties box, select and
change the value for the wpm.RealmClass initialization parameter.
v Replace com.ibm.etill.framework.payserverapi.PSDefaultRealm with

com.ibm.commerce.payment.realm.WCSRealm

Once the value has been changed, click Apply

4. If the IBM Payment Manager 3.1.2 system is enabled for SSL, add *.443
entries to the default_host window in the WebSphere Application Server
Administrative Console as described in “Adding Port Host Aliases to
WebSphere Application Server” on page 158.

Note: If you do not enable SSL, you must configure the WebSphere
Commerce server to use the non-SSL Payment Manager client in the
Payment Manager setting page of the WebSphere Commerce
Configuration Manager when creating a WebSphere Commerce
instance. You can change the Payment Manager settings after the
instance is created, however, you must restart the instance for your
changes to take effect.

5. Open the WCSRealm.properties file from your WebSphere Payment
Manager directory. This file contains definitions for the WCSHostName and
WCSWebPath.

6. For the WCSHostName, enter the fully-qualified hostname of the remote
machine where WebSphere Commerce is installed. (The default is the
hostname of the system where Payment Manager is installed.) You do not
have to change value specified for the WCSWebPath property.

7. Start the WebSphere Payment Manager Application Server in the
WebSphere Application Server Administrative Console for your changes to
take effect.
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Part 2. Configuring WebSphere Commerce

Topics covered in this section include:
v Chapter 6, “Pre-configuration steps” on page 51
v Chapter 7, “Creating or modifying an instance with Configuration

Manager” on page 55
v Chapter 8, “Post-configuration steps” on page 83

You must complete the appropriate steps inChapter 6, “Pre-configuration
steps” on page 51 and Chapter 8, “Post-configuration steps” on page 83 in
order to successfully configure WebSphere Commerce. You can create your
instance using the Configuration Manager tool by following the steps in
Chapter 7, “Creating or modifying an instance with Configuration Manager”
on page 55.
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Chapter 6. Pre-configuration steps

This chapter contains a list of tasks that must be completed before you
configure your WebSphere Commerce instance. Please complete the
appropriate sections from the following list:
v Modifying your PATH

v Upgrading the iPlanet Web Server plug-in level (iPlanet Web Server users)
v Starting the WebSphere Application Server (all users)

Modifying your PATH

You must ensure that the your PATH Windows System Variable is configured
correctly. To ensure that your PATH is configured correctly, do the following on
your WebSphere Commerce machine:
1. Check your Windows System Variables to ensure that the following line

exists in the PATH:
drive:\WebSphere\AppServer\java\bin;

2. If this line does not exist, open a command line window and enter the
following command:
set PATH=drive:\WebSphere\AppServer\java\bin;%PATH%

3. To test that the PATH is set correctly, run the following:
java -fullversion

You will see a message indicating that the correct version of the software
is installed.

Configuring Microsoft IIS

Before creating your WebSphere Commerce instance, you must configure
Microsoft IIS. To configure Microsoft IIS, do the following on your Web server
machine:
1. Download, and install the Microsoft MetaEdit 2.2 Utility. This utility can

be found on the following Web site:
http://www.microsoft.com/

2. Enter (Q232068) in the Search field, and click Go.
3. Select the FILE: How to Download, Install, and Uninstall the IIS

MetaEdit 2.2 Utility (Q232068) link, and follow the instructions on how to
install and configure the Microsoft MetaEdit 2.2 Utility.
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4. Open the MetaEdit 2.2 Utility and ensure the path names found in the
HKEY LM\\W3SVC\\Filtes\\sePlugins\\FilterPath are long path names.
For example, drive:\WebSphere\AppServer\bin\iisWASPlugin_http.dll.

5. To configure the Microsoft IIS Server, do the following:
a. If you are using Microsoft IIS 5.0, you must ensure that the virtual

pathnames added to IIS Default Web Site are long names.
1) Select Programs >Administrative Tools >Internet Services

Manager.
2) Expand host_name.
3) Click on Default Web Site.
4) Ensure that the pathnames in the following fields appear as long

names. For example, the default pathnames are shown below.

Table 3.

Field name Path

sePlugins drive:\WebSphere\AppServer\bin

IBMWebAS drive:\WebSphere\AppServer\web

WSsamples drive:\WebSphere\AppServer\WSsamples\

theme drive:\WebSphere\AppServer\WSsamples\
images

To modify the pathnames, do the following:
a) Expand the Default Web Site.
b) Right-click the alias.
c) Select Properties.
d) Click Browse and select the correct path.
e) Click OK.
f) Click OK again.
g) Repeat step 5a4b to step 5a4f for each alias.

5) Click Apply.
6. Restart your machine.
7. Ensure that the WebSphere Application Server is started.

Upgrading the iPlanet Web Server plug-in level

Since the WebSphere Commerce installation program upgrades the level of
WebSphere Application Server after the iPlanet Web Server plug-in has been
installed, you must re-install the plug-in in order for it to be at the
appropriate level. To upgrade the iPlanet Web Server plug-in level, do the
following on your iPlanet Web Server machine:
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1. In the drive:\WebSphere\AppServer\bin directory, create backup copies of
plugin_common.dll and ns41_http.dll.

2. Ensure that any iPlanet Web Server associated services have been stopped
in the Services window of the Control Panel.

3. You must now configure the Webserver plugins for iPlanet Web Server
port 443. To install the plugins, do the following:
a. Insert the WebSphere Application Server, Advanced Edition CD and

run the install program, choosing to install the Webserver Plugins
only.

b. On the Websphere Application Server 4.0 configure iPlanet
Enterprise v4.0 window, select https-host_name-https-443 only.
Complete the WebSphere Application Server Webserver Plugins
installation.

4. You must now configure the Webserver plugins for iPlanet Web Server
port 8000. To install the plugins, do the following:
a. Insert the WebSphere Application Server, Advanced Edition CD and

run the install program, choosing to install the Webserver Plugins
only.

b. On the Websphere Application Server 4.0 configure iPlanet
Enterprise v4.0 window, select https-host_name-https-8000 only.
Complete the WebSphere Application Server Webserver Plugins
installation.

5. Restore the backup copies of plugin_common.dll and ns41_http.dll to the
drive:\WebSphere\AppServer\bin directory.

Starting the WebSphere Application Server

To start WebSphere Application Server do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. Ensure that your database has been started on your database machine.
3. Do the following on your Web server machine:

v If your web server is located on the same machine as the WebSphere
Application Server, ensure that your Web server services have been
started. If not, select these services and click Start. For IBM HTTP
Server, the IBM HTTP Server service must be started. If a service will
not start, please see the troubleshooting section of this book.

v If you are using s remote Web server you must copy the
drive:\WebSphere\AppServer\config\plugin-cfg.xml file from your
WebSphere Commerce to the same directory and drive letter on your
Web server machine. If the directory does not exist on your Web server
machine, create it. Restart your webserver.
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4. From the Service list, select IBM WS AdminServer.
5. Click Start.

After starting the WebSphere Application Server, you should verify that it is
working properly. To verify that WebSphere Application Server is working
properly, do the following:
1. Select Start Menu → Programs → IBM WebSphere → Application Server

V4.0 → Administrator’s Console.
2. Expand WebSphere Administrative Domain → Nodes → Node_name →

Application Servers.
3. Select Default Server and right-click. Select Start.
4. Open a web browser and enter the following URL:

Note: If you have installed WebSphere Commerce in a 3-tier configuration,
you must copy the drive:\WebSphere\AppServer\config\plugin-
cfg.xml file from your WebSphere Commerce to the same directory
and drive letter on your Web server machine. If the directory does
not exist on your Web server machine, create it. Restart your
webserver.

http://host_name/servlet/snoop

The test servlet should run without errors.

The Default Server is used for testing purposes only, and can be removed at
any time to conserve system resources. The Default Server is not required by
WebSphere Commerce, and should not be running on a production server.

The next step

After you have completed all the necessary steps in this chapter, you can
create your instance with the Configuration Manager by completing the steps
in the following chapter:
v Chapter 7, “Creating or modifying an instance with Configuration

Manager” on page 55
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Chapter 7. Creating or modifying an instance with
Configuration Manager

This chapter describes how to create or modify an instance with the
Configuration Manager. If you have not completed the steps in Chapter 6,
“Pre-configuration steps” on page 51, you will not be able to create an
instance.

Notes:

1. If you want to use IBM WebSphere Payment Manager 3.1.2 to handle
online transactions for your instance, you should install Payment Manager
before creating your instance. Your instance will be configured to work
with Payment Manager automatically. To install Payment Manager, see
Chapter 5, “Installing IBM WebSphere Payment Manager 3.1.2” on page 39.

2. If you have made any customizations to the XMLConfig.bat file normally
located in the drive:\WebSphere\AppServer\bin directory, you need to
remove these customizations before running Configuration Manager.
Otherwise, the setup of WebSphere Commerce application server in
WebSphere Application Server may fail.

3. In WebSphere Application Server 4.0.2, a single WebSphere Commerce
Server consists of an Installed EJB Module, and an Installed Web Module
to serve client requests to one or more stores. In the WebSphere Commerce
Configuration Manager, each WebSphere Commerce instance appears as a
separate root category in the instances tree. In the WebSphere Application
Server topology view, a WebSphere Commerce instance will appear under
a node entry as a separate WebSphere Commerce application server.

Chapter checklist

v Ensure that your Database server is running.
v Ensure that your Web server is running, if it is installed on the same

machine as WebSphere Commerce.
v Ensure that the IBM WC Configuration Manager server service has been

started by opening the Windows Services panel and selecting IBM WC
Configuration Manager server. If the service is stopped, select Start.
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Important
Leaving the IBM WC Configuration Manager server service running
could potentially pose a security problem. Stop the WC Configuration
Manager server service when you are not using the Configuration
Manager.

To prevent potential security problems, you should also ensure that
the IBM WC Configuration Manager server is set for manual startup,
not automatic.

v Ensure that the WebSphere Application Server has been started. To start the
server, open the Services window, select IBM WS AdminServer V4.0, and
click Start.
Attention: If WebSphere Application Server security is turned on, you
must disable it before creating your instance.

Launch the Configuration Manager

To access the Configuration Manager, complete the following steps:
1. Ensure that the IBM WC Configuration Manager server process is

running in the services panel.

Important
Leaving the IBM WC Configuration Manager server service running
could potentially pose a security problem. Stop the WC
Configuration Manager server service when you are not using the
Configuration Manager.

To prevent potential security problems, you should also ensure that
the IBM WC Configuration Manager server is set for manual startup,
not automatic.

2. From the Start Menu, select Programs → IBM WebSphere Commerce →
Configuration

3. Enter your Configuration manager user ID, and password. The default
Configuration Manager user ID is webadmin, and the default password is
webibm.

4. You will be asked to change your password the first time you log in. To
change the user ID or password at a later time, please refer to “Changing
the Configuration Manager Password” on page 155.
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Instance Creation Wizard

To create your instance, do the following in the WebSphere Commerce
Configuration Manager:
1. Expand your host name.
2. Right-click on Instance List.
3. From the resulting pop-up menu, select Create Instance.
4. The Instance Creation wizard opens. Complete the fields in each of the

following panels.

Instance

Instance name
This is the name that you want to use for your instance. The default
name is demo.

Instance’s root path
Enter the path where you want to store all files related to your
WebSphere Commerce instance. The default path is
drive:\WebSphere\CommerceServer\instances\instance_name

Merchant Key
This is the 16-digit hexadecimal number for the Configuration
Manager to use as the encryption key. You must enter your own key
in the Merchant Key field. Ensure that the key that you enter will be
sufficient to protect your site, especially for a production server. After
you have created a store you can only change this key by using the
Database Update Tool. To use this tool, access Configuration
Manager, right-click on the database node, and select Database
Update Tool.

PDI encrypt
Enable this check box to specify that information specified in the
ORDPAYINFO and ORDPAYMTHD tables should be encrypted. By
selecting this check box, payment information will be stored in the
database in encrypted format.

PVC header enabled
Reserved for future releases.

URL mapping file
Enter the path to the file you will be using for URL mapping. You can
also accept the default file
drive:\WebSphere\CommerceServer\xml\mapping\urlmapper.xml

Database

Database administrator name
Enter the user name of your database administrator. This is the user
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name that is used to perform the installation, unless you have defined
an alternate database administrator name.

Database administrator password
Enter the password associated with the database administrator’s user
ID. This is the password of the user name that is used to perform the
installation, unless you have defined an alternate database
administrator name.

Database name
Enter the name assigned to the database or accept the default.

For DB2, accept the default, or type the name you want to assign to
your database. The name must be eight characters in length or less.

Database type
From the drop-down list, select the name of the database management
system you intend to use.

Database user name
If you have created a DB2 user for the database other than the
database administrator, you can enter their user ID in this field.
Otherwise, use the same user name as the database administrator.

Database user password
This is the password that is associated with the above database user
name.

Run Database Performance Wizard
Select the Run Database Performance Wizard checkbox to perform
DB2 database optimization.

Use staging server
If Use staging server is selected, the Configuration Manager defines
this database as being for use by a staging server. For more
information on staging servers, see the WebSphere Commerce online
information. (See “Using the online help” on page 173 for guidance on
accessing this information.)

Set as active database
Select this option to use this database for this WebSphere Commerce
instance. Disable this option if you want to use another database for
your instance.

Use remote database
Enable this check box if your database server is on a different node
than WebSphere Commerce.

Note: If you have installed your database server on a different node
than WebSphere Commerce (for example, if you are configuring
a two or three tier environment), you must select this check box.
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Database Server Hostname
This field is enabled if you select Use Remote Database. Enter the
fully-qualified hostname of the node on which your database resides.

Database Server Port
This field is enabled if you select Use Remote Database. The default
port for DB2 is 50000.

Database Node Name
This field is enabled if you select Use Remote Database and if you
are using DB2 as your database. If you have not already cataloged a
node for your remote database, the Configuration Manager will
catalog a node for you.

Languages
Use the Languages panel of the Configuration Manager to configure your
database to support all required languages. Choose your default language
from the drop down list. The wcs.bootstrap_multi_xx_XX.xml file that
matches your default language must also be in the Selected Languages
window. To add support for additional languages to your database, complete
the following steps:
1. Select the appropriate language .xml file from the Available Languages

window. The .xml file will be in the form of
wcs.bootstrap_multi_xx_XX.xml, where xx_XX is the four letter locale code
for the language you want to select.

2. Click the arrow that points to the Selected Languages window. The
language you have chosen should now be listed in the Selected Languages
window.

3. Repeat steps 1 and 2 for each language for which support is needed.

Note: If you plan to create stores that support more than one language, for
example, a store that is available in either English or Spanish, you must
select all languages your stores will support. In this case, you must
have both English and Spanish in the Selected Languages window. The
sample stores provided with WebSphere Commerce support more than
one language. If you select only one language on the Languages panel,
then you will not see certain portions of the sample store that does
support multiple languages.

Web Server

Use Remote Web Server
Select this check box if you are installing your Web server on a
separate machine from your WebSphere Commerce server. If this box
is selected, your Web server will not be configured by the
Configuration Manager. If you select this check box, you must
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manually configure your Web server machine as described in
Chapter 8, “Post-configuration steps” on page 83.

Note: If you have installed your Web server on a different node than
WebSphere Commerce (for example, if you are configuring a
three tier environment), you must select this check box.

Hostname
Accept the default, or type the fully qualified host name of your Web
server machine (hostname.domain.com is fully qualified). The default is
the host name of your WebSphere Commerce machine. Ensure that
you do not enter the www prefix in the hostname field. If you want to
accept the default host name, ensure the default host name is fully
qualified before accepting it.

Web Server Type
From the drop-down list, select the Web server software that you
intend to use.

Primary Document Root
Accept the default, or type the path of your Web server document
root.The path you type must already exist.

Server Port
Enter the port number that you want your WebSphere Commerce
Server to use. The default value is 80.

Authentication Mode
Select the authentication mode that you would like to use for this
WebSphere Commerce instance. The choices are as follows:

Basic Authentication will be performed using a custom certificate.

X.509 Authentication will be performed using the X.509 certificate
standard.

Secure Server Configuration Path
Enter the directory path to the obj.conf files for your secure Web
server (port 443). This field only displays if you use Netscape iPlanet
as your Web server. This field does not appear if you are using a
remote Web server.

Non-secure Server Configuration Path
Enter the directory path to the obj.conf files for your non-secure Web
server (port 80). This field only displays if you use Netscape iPlanet
as your Web server. This field does not appear if you are using a
remote Web server.

Secure Tools Server Configuration Path
This field is only visible if you have selected Netscape iPlanet as your
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Web server (port 8000). Enter the full path to your Netscape iPlanet
secure tools server obj.conf file. This field does not appear if you are
using a remote Web server.

WebSphere

DataSource Name
Used to set up the Connection Pool for access to the database with
which WebSphere Commerce works.

Port Number
Enter the port address that WebSphere Application Server is listening
on. You can accept the default unless you specified a different port
when starting the WebSphere Application Server.

JDBC Driver Location
Enter the location of the db2java.zip file on your system or accept the
default.

Stores Web Application
Select this if you want the default Stores web application configured
for you under the WebSphere Commerce Server in WebSphere
Application Server.

Tools Web Application
Select this if you want the default Tools web application configured
for you under the WebSphere Commerce Server in WebSphere
Application Server.

Tools Port Number
The port number used for accessing WebSphere Commerce
administration tools. The default port number is 8000. If you are using
a Domino Web Server you must change this to port number 443.

WebSphere Catalog Manager
If this check box is selected the WebSphere Catalog Manager
WebEditor will be installed. It will be accessible at:
https://host_name:8000/wcm/webeditor. It is installed by default.

Payment Manager

Hostname
Enter the fully qualified host name of the Web server machine. This
defaults to the WebSphere Commerce host name. If you have installed
Payment Manager or your Web server remotely from WebSphere
Commerce, you must ensure that this field contains the fully qualified
host name of the Web server machine that Payment Manager uses.

Profile Path
The full path name of the directory where the Standard WebSphere
Commerce Payment Manager Cashier Profiles are to be stored. The
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default value is
drive:\WebSphere\CommerceServer\instances\instance_name\xml\
payment

Use non-SSL Payment Manager Client
Enable this check box if you want WebSphere Commerce to use the
non-SSL Payment Manager client to communicate with the Payment
Manager server. This allows the WebSphere Commerce to
communicate with Payment Manager without using SSL.

Web Server Port
Enter the Web server TCP port that Payment Manager uses. If you
have selected the Use non-SSL Payment Manager Client check box,
the default value for this field is 80 (the non-secure port). If the Use
non-SSL Payment Manager Client check box has not been enabled, the
default value for this field is 443 (the SSL port).

Use Socks Server
Enable this check box if WebSphere Commerce must go through a
socks server in order to reach Payment Manager.

Socks Hostname
This field is enabled if the Use Socks Server check box is selected.
Enter the fully-qualified host name of your socks server.

Socks Port Number
This field is enabled if the Use Socks Server check box is selected.
Enter the port number that your socks server uses.

Log System

Trace File Location
This is the location of the file collecting debugging information. It
contains debug messages in English. Note: if the Trace File Location is
the same as the Message File Location then the contents of the files
will be merged.

Trace File Size
This is the maximum size of the trace file in MB. Once the trace file
reaches this size, another trace file will be created.

Message File Location
This is the location of the file collecting messages, describing the state
of the WebSphere Commerce system. Messages are locale-sensitive.
Note: if the Trace File Location is the same as the Message File
Location then the contents of the files will be merged.

Message File Size
This is the maximum size of the message file in MB. Once the
message file reaches this size, an additional message file will be
created.
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Activity log Cache Size
Enter the maximum size of the activity log’s cache.

Notification Enabled
Select this check box if you want to be notified of error level
messages. You must also modify the notification information in the
WebSphere Commerce Administration Console to recieve these
messages.

Messaging

User Template File
This is the name of the XML message template definition file that
allows you to add new inbound XML messages to be supported by
your system. An outline should be added to this file for each new
XML message that you want to support. It is recommended that you
use the default user_template.xml which is stored in the template path
directory.

Inbound Message DTD Path
This is the path where all the DTD files for inbound XML messages
are stored. The default is
drive:\WebSphere\CommerceServer\xml\messaging

WebController User ID
This is the ID used by WebSphere Commerce to execute all the
WebSphere Commerce MQSeries® Adapter inbound messages. It
should be an ID that has Site Administrator authority. The default is
wcsadmin. Ensure that only authorized persons have the authority to
update the User Template File and System Template File since the
inbound XML messages can be mapped to execute WebSphere
Commerce commands using this ID.

System Template File
This is the name of the XML message template definition file that
contains the outline of all inbound XML messages supported by the
WebSphere Commerce MQSeries Adapter. This file defines the data
fields for each message, mapping the message to the appropriate
WebSphere Commerce Controller Command, and mapping each field
within the message to the appropriate parameter for that command. It
is recommended that you use the default sys_template.xml which is
stored in the template path directory.

Template Path
This is the path where the User Template File and System Template
File are stored. The default is
drive:\WebSphere\CommerceServer\xml\messaging
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Inbound Message DTD Files
This is the list of the DTD and include files for inbound XML
messages. If you add a new inbound XML message, you need to add
it in this field.

Auction

Enable Auction
Select the Enable checkbox to enable Auctions.

SMTP Server
Define the SMTP server that is used to receive email messages.

Reply Email
Define the sender’s email information

Starting the instance creation
Once you have filled in the necessary information on all the panels, the Finish
button is enabled. Click Finish to create your WebSphere Commerce instance.

Depending on the speed of your system, it will take several minutes to
several hours for your instance to be created. The progress bar that displays
when you start creating the instance will indicate when the process has
finished. After your instance has been created WebSphere Commerce will
attempt to start the WebSphere Commerce Server associated with the instance.
When this has successfully completed click Ok to close the Instance Creation
wizard, then restart your computer.

Verifying the instance creation
To verify that the instance has been properly created, check the following files:
v drive:\WebSphere\CommerceServer\instances\instance_name\xml\

instance_name.xml. This file contains all of the configuration information
about your WebSphere Commerce instance.

v drive:\WebSphere\CommerceServer\instances\instance_name\logs\
createdb.log. This file contains information about the WebSphere
Commerce database creation.

v drive:\WebSphere\CommerceServer\instances\instance_name\logs\
populatedb.log. This file contains information about the WebSphere
Commerce database population process .

v drive:\WebSphere\CommerceServer\instances\instance_name\logs\
WASConfig.log. This file contains information about the installation and
configuration of your new WebSphere Commerce instance, within
WebSphere Application Server.

v drive:\WebSphere\CommerceServer\instances\instance_name\logs\
sec_check.log. This file contains information about potential security
exposures.
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v drive:\WebSphere\CommerceServer\instances\instance_name\logs\wcs.log.
This file describes the operation of the WebSphere Commerce application
server. Use this log to ensure that the server has started correctly.

Start and stop your instance

Once your instance has been created, it will be started automatically. If you
modify your instance at a later time you will need to stop and restart it in the
WebSphere Application Server Administrative Console. To accomplish this,
please complete the following steps:
1. Open the WebSphere Application Server Administration Console from the

Start menu.
2. Expand WebSphere Administrative Domain.
3. Expand Nodes.
4. Expand your hostname.
5. Expand Application Servers.
6. Select WebSphere Commerce Server — instance_name and right-click.

Select Start or Stop as appropriate.

Additional configuration options

Once you have created and started your basic instance, you can configure
additional aspects of WebSphere Commerce through the following nodes:

Instance Properties
All panels that were available in the Instance Creation wizard appear under
the Instance Properties node of the Configuration Manager. The following
panels are either new or modified from the Instance Creation wizard panels:

Database
Use the Database panel of the Configuration Manager to configure WebSphere
Commerce to work with your database. Complete the fields as follows:

Database administrator name
Enter the name of your database administrator.

Database administrator password
Enter the password of the database administrator.

Database name
Enter the name of the database that you want to create for this
instance, or enter the name of an existing database that you want to
associate with the instance that you are creating.

Database type
Select the product you will be using as your database management
system.
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Database user name
Enter the user name for this database.

Database user password
Enter the password associated with the user name for this database.

Run database performance wizard
Select this check box to perform DB2 Universal Database optimization.

Use staging server
Select this check box if you want to use this database for your staging
server.

Set as active database
Select this check box if this database is the database you want to use
with your WebSphere Commerce instance. After you have created
your instance you can create additional databases and select the one
that you want to use for your instance.

Use remote database
Enable this check box if your database server is on a different node
than WebSphere Commerce.

Note: If you have installed your database server on a different node
than WebSphere Commerce, you must select this check box. For
example, if you are configuring a two or three tier environment.

Database Server Host name
This field is enabled if you select Use Remote Database. Enter the
fully-qualified hostname of the node on which your database resides.

Database Server Port
This field is enabled if you select Use Remote Database. The default
port for DB2 is 50000.

Database Node Name
This field is enabled if you select Use Remote Database and if you
are using DB2 as your database. If you have not already cataloged a
node for your remote database, the Configuration Manager will
catalog a node for you.

WebSphere
Use the WebSphere panel of the Configuration Manager to configure the way
that WebSphere Application Server interacts with WebSphere Commerce.
Complete the fields as follows:

Data source name
Used to set up the Connection Pool for access to the database with
which WebSphere Commerce works.
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Port number
Enter the port address to which WebSphere Application Server is
connected. You can accept the default unless you specified a different
port when starting the WebSphere Application Server.

JDBC driver location
Enter the location of the db2java.zip file on your system.

Stores Web Application
Select this if you want the default Stores Web application configured
for you under the WebSphere Commerce Server in WebSphere
Application Server.

Tools Web Application
Select this if you want the default Tools Web application configured
for you under the WebSphere Commerce Server in WebSphere
Application Server.

Tools Port Number
The port number used for accessing WebSphere Commerce
administration tools. The default port number is 8000. If you are using
a Domino Web Server you must change this to port number 443.

WebSphere Catalog Manager
If this check box is selected the WebSphere Catalog Manager
WebEditor will be installed. It will be accessible at:
http://host_name:8000/webeditor. It is installed by default.

Web server
The General tab of the Web server panel contains the same parameters as the
version of the panel that appears in the Instance Creation wizard.

Use the Web server panel of the Configuration Manager to configure
WebSphere Commerce to use your Web server. Complete the fields as follows:

Use Remote Web server
Select this check box if you are installing your Web server on a
separate machine from your WebSphere Commerce server. If this box
is selected, your Web server will not be configured by the
Configuration Manager. If you select this check box, you must
manually configure your Web server machine as described in
Chapter 8, “Post-configuration steps” on page 83.

Note: If you have installed your Web server on a different node than
WebSphere Commerce, you must select this check box. For
example, if you are configuring a three tier environment.

Hostname
Type the fully qualified host name of your WebSphere Commerce
instance (hostname.domain.com is fully qualified). Ensure that you do

Chapter 7. Creating or modifying an instance with Configuration Manager 67



not enter www in the Hostname field. The default is the fully qualified
host name of the machine where your Web server is installed.

Web Server Type
From the drop-down list, select the web server to be used.

Primary Document Root
Accept the default, or type the path of your Web server document
root. The path you type must already exist.

Server port
Enter the port number on which your Web server is running. The
default value is 80.

Authentication Mode
Select the authentication mode that you would like to use for this
WebSphere Commerce instance. The choices are as follows:
v Basic Authentication will be performed using a custom certificate.
v X509 Authentication will be performed using the X509 certificate

standard.

Secure Server Configuration Path
Enter the directory path to the obj.conf files for your secure Web
server (port 443). This field only displays if you use Netscape iPlanet
as your Web server. This field does not appear if you are using a
remote Web server.

Non-secure Server Configuration Path
Enter the directory path to the obj.conf files for your non-secure Web
server (port 80). This field only displays if you use Netscape iPlanet
as your Web server. This field does not appear if you are using a
remote Web server.

Secure Tools Server Configuration Path
This field is only visible if you have selected Netscape iPlanet as your
Web server (port 8000). Enter the full path to your Netscape iPlanet
secure tools server obj.conf file. This field does not appear if you are
using a remote Web server.

The Advanced tab contains a list of all Web server aliases. To add a new alias,
select the Advanced tab, right-click and select Add row. To delete an alias,
select the alias that you want to delete, right-click and select Delete row.

Instance
The Instance panel of the Configuration Manager is used to specify basic
information about the instance. If creating multiple instances ensure that each
instance has a different name and root path.

Instance Name
Enter the name that you want to call your WebSphere Commerce
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instance. You can also accept the default name ″demo.″ You will not
be able to modify this name later, so ensure that you choose a name
carefully.

Instance’s Root Path
Enter the path where you want to store all files related to your
WebSphere Commerce instance. You cannot change this path once the
instance is created. The default path is:
drive:\WebSphere\CommerceServer\instances\instance_name

PDI encrypt
Select this check box to encrypt the information specified in the
ORDPAYINFO and ORDPAYMTHD tables. By selecting this check
box, payment information will be stored in the database in encrypted
format.

PVC header enabled
Reserved for future releases.

URL mapping file
Enter the path to the file you will be using for URL mapping. You can
also accept the default
file:drive:\WebSphere\CommerceServer\properties\urlmapper.xml

Payment Manager

Hostname
Enter the domain qualified host name of the Web server machine. This
defaults to the WebSphere Commerce host name. If you have installed
Payment Manager on a remote machine, you must ensure that this
field contains the fully-qualified host name of your Web server
machine.

Profile Path
The full path name of the directory where the Standard WebSphere
Commerce Payment Manager Cashier Profiles are to be stored. The
default value is
drive:\WebSphere\CommerceServer\instances\instance_name\xml\
payment

Use non-SSL Payment Manager Client
Enable this check box if you want WebSphere Commerce to use the
non-SSL Payment Manager client to communicate with the Payment
Manager server. This allows the WebSphere Commerce Server to
communicate with Payment Manager without using SSL.

Web Server Port
Enter the Web server TCP port that Payment Manager uses. If you
have enabled Use non-SSL Payment Manager Client the default value
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for this field is 80 (the non-secure port). If this check box has not been
enabled the default value for this field is 443 (the SSL port).

Use Socks Server
Enable this check box if WebSphere Commerce must go through a
socks server in order to reach Payment Manager.

Socks Hostname
This field is enabled if the Use Socks Server check box is selected.
Enter the fully-qualified host name of your socks server.

Socks Port Number
This field is enabled if the Use Socks Server check box is selected.
Enter the port number that your socks server uses.

Member Subsystem
Use the Member Subsystem panel of the Configuration Manager to configure
WebSphere Commerce to use a directory server.

Authentication mode
Select LDAP, Database or Other to select an alternate mode of
authentication. If you select LDAP the rest of the fields on this panel
will be enabled.

LDAP Version
The version of the LDAP protocol that the WebSphere Commerce
Server will use to communicate with the LDAP server.

LDAP Type
Select the Directory Server software you are using with WebSphere
Commerce. The choices are SecureWay Directory Server (which is
included with WebSphere Commerce), Netscape’s Directory Server
software, Microsoft Active Directory, or Lotus Domino.

Single Sign-on
Select this check box to allow users who have already been
authenticated by WebSphere Application Server to be recognized by
WebSphere Commerce. Single Sign-on is not supported by WebSphere
Commerce at this time.

Host The fully qualified host name specifying where the LDAP server is
installed.

Port The port used by the LDAP server. The default port is 389.

Administrator Distinguished Name
The distinguished name of the LDAP server administrator.

Administrator Password
The LDAP server administrator’s password.
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Confirm Password
Re-enter the LDAP administrator’s password.

LDAP Authentication Mode
Specifies the authentication mechanism that the LDAP server uses.
None means that WebSphere Commerce does not authenticate to the
LDAP server. Simple means that WebSphere Commerce uses a
distinguished name and password to authenticate to the LDAP server.

Time out
The time in seconds before an LDAP search times out.

Entry File Name
The entry file used for LDAP server initialization.

Messaging

User Template File
This is the name of the XML message template definition file that
allows you to add new inbound XML messages to be supported by
your system. An outline should be added to this file for each new
XML message that you want to support. It is recommended that you
use the default user_template.xml which is stored in the template path
directory.

Inbound Message DTD Path
This is the path where all the DTD files for inbound XML messages
are stored. The default is
drive:\WebSphere\CommerceServer\xml\messaging

WebController User ID
This is the ID used by WebSphere Commerce to execute all the
WebSphere Commerce MQSeries Adapter inbound messages. It should
be an ID that has Site Administrator authority. The default is
wcsadmin. Ensure that only authorized persons have the authority to
update the User Template File and System Template File since the
inbound XML messages can be mapped to execute WebSphere
Commerce commands using this ID.

System Template File
This is the name of the XML message template definition file that
contains the outline of all inbound XML messages supported by the
WebSphere Commerce MQSeries Adapter. This file defines the data
fields for each message, mapping the message to the appropriate
WebSphere Commerce Controller Command, and mapping each field
within the message to the appropriate parameter for that command. It
is recommended that you use the default sys_template.xml which is
stored in the template path directory.
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Template Path
This is the path where the User Template File and System Template
File are stored. The default is
drive:\WebSphere\CommerceServer\xml\messaging

Inbound Message DTD Files
This is the list of the DTD and include files for inbound XML
messages. If you add a new inbound XML message, you need to add
it in this field.

Session Management
The Session Management panel of the Configuration Manager has two tabs:

General tab:

Enable cookies
This check box specifies that the site uses cookies for session
management. This is always enabled for WebSphere Commerce.

Enable URL rewriting
Select this check box to use URL rewriting for session management.

Cookie acceptance test
Select this check box to check if the shopper’s browser accepts cookies
for a site that only supports cookies.

Cookie session manager
You can select whether you want WebSphere Commerce or
WebSphere Application Server to manage your cookies. The default is
WebSphere Commerce.

Advanced tab:

Cookie path
Specifies the path for the cookie, which is the subset of URLs to which
a cookie should be sent.

Cookie age
This field should not be altered. The default is for a cookie to expire
when the browser is closed.

Cookie domain
Specifies a domain restriction pattern. A domain specifies the servers
that should see a cookie. By default the cookie is only sent back to the
WebSphere Commerce server that issued them.

Security
Security can be configured through the Configuration Manager.

Enable security
Select this checkbox to enable EJB security.
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Note: You must enable Global Security Settings within the WebSphere
Application Server before selecting this checkbox.

Authentication mode
Determine which type of registry to use to authenticate users :
Operating system user registry, LDAP user registry

User ID
Enter the user name that allows access to EJBs.

User password
Enter the password associated with the above user ID.

Password Invalidation
Use the Password Invalidation node of the Configuration Manager to enable
or disable the password invalidation feature. This feature, when enabled,
requires WebSphere Commerce users to change their password if the user’s
password has expired. In that case, the user is redirected to a page where they
are required to change their password. Users are not able to access any secure
pages on the site until they have changed their password. To enable this
feature:
1. Go to the Password Invalidation node in the Configuration Manager,

which can be found under instance_name → Instance Properties

2. To activate the password invalidation feature, click the Enable check box.
3. To apply your changes to your instance, click Apply.
4. Upon successfully updating the configuration for your instance, you will

receive a message indicating a successful update.

Login Timeout
Use the Login Timeout node of the Configuration Manager to enable or
disable the login timeout feature. When this feature is enabled, a WebSphere
Commerce user that is inactive for an extended period of time is logged off
the system and requested to log back on. If the user subsequently logs on
successfully, WebSphere Commerce runs the original request that was made
by the user. If the user logon fails, the original request is discarded and the
user remains logged off the system. To enable this feature:
1. Open the Configuration Manager and go to the Login Timeout node for

your instance as follows:
WebSphere Commerce → host_name → Instance List → instance_name →
Instance Properties → Login Timeout

2. To activate the login timeout feature, click the Enable check box.
3. Enter the login timeout value, in seconds, in the Login Timeout Value

field.
4. To apply your changes to your instance, click Apply.
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5. Upon successfully updating the configuration for your instance, you will
receive a message indicating a successful update.

Password Protected Commands
Use the Password Protected Commands node of the Configuration Manager
to enable or disable the password protected commands feature. When this
feature is enabled, WebSphere Commerce requires registered users to enter
their password before continuing a request that runs designated WebSphere
Commerce commands. To enable this feature:
1. Open the Configuration Manager and go to the Password Protected

Commands node for your instance as follows: WebSphere Commerce →
host_name → Instance List → instance_name → Instance Properties →
Password Protected Commands

2. In the General tab:
a. To activate the password protected commands feature, click Enable.
b. Enter number of retries in the Retries field. (The default number of

retries is 3.)
3. In the Advanced tab:

a. Select a WebSphere Commerce command you want to protect from the
list in the Password Protected Command List window and click Add.
The command you have selected is listed in the Current Password
Protected List window.

b. If you want to disable password protection for any WebSphere
Commerce command, select the command in the Current Password
Protected Command list window and click Remove.

4. To apply your changes to your instance, click Apply.
5. Upon successfully updating the configuration for your instance, you will

receive a message indicating a successful update

Note: WebSphere Commerce will only display the commands that are
designated as ″authenticated’ in the CMDREG table in the list of
available commands.

Cross Site Scripting Protection
Use the Cross Site Scripting Protection node of the Configuration Manager to
enable or disable the cross site scripting protection feature. When enabled, this
feature rejects any user requests that contain attributes or characters that are
designated as not allowable. You can specify the disallowed attributes and
characters in this node of the Configuration Manager. To enable this feature:
1. Open the Configuration Manager and go to the Cross Site Scripting

Protection node for your instance as follows:
WebSphere Commerce → host_name → Instance List → instance_name →
Instance Properties → Cross Site Scripting Protection
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2. Use the General tab to activate the cross site scripting protection feature,
as follows:
a. Click Enable.
b. To add attributes that you want to disallow for WebSphere Commerce

commands, right-click on the Prohibited Attributes table and select
Add row. Add the attributes that you want to disallow, separated by
commas (,). For example, user_id, passwd.

c. To remove attributes from the Prohibited Attributes table, highlight and
right-click the line containing the attribute in the table and select
Delete row.

d. To add characters that you want to disallow for WebSphere Commerce
commands, right-click on the Prohibited Characters table and select
Add row. Add the character that you want to disallow, separated by
commas (,). For example, <, >.

e. To remove characters from the Prohibited Characters table, highlight
and right-click the line containing the character in the Prohibited
Characters table and select Delete row.

3. Use the Advanced tab to disable cross site scripting protection for
specified attributes of selected WebSphere Commerce commands, as
follows:
a. Select the commands from the Command List box.
b. Type in a list of attributes, separated by commas, for which prohibited

characters are allowed in the List of Excepted Attributes window and
click Add.

c. To remove a command along with its attributes, select the command
from the List of Excepted Commands window and click Remove.

You can also remove specific attributes from a command by selecting the
attribute and clicking Remove.

4. To apply your changes to Configuration Manager, click Apply.
5. Upon successfully updating the configuration for your instance, you will

receive a message indicating a successful update.

Trading
Trading can be configured through the Configuration Manager.

XML Path
The Path where xml files for trading component are stored.

DTD Path
The Path where dtd files for trading component are stored.

DTD File Name
The dtd file name for the trading component.
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Collaboration – SameTime
Lotus Sametime enables Customer Care collaboration. It provides customer
service real-time support via synchronous text interface (instant messaging -
IM) using Lotus Sametime between customer service representative and store
customers or buyers.

Enable
Select this check box if you want Customer Care collaboration
function available to your site.

Host Name
Type the fully qualified host name of your Sametime server
(hostname.domain.com is fully qualified). Ensure that you do not
enter www in the Hostname field. The default is the fully qualified host
name of the machine where your WebSphere Commerce server is
installed.

Registration URL
Type the Registration URL of your Sametime server. A Site
Administrator can register Customer Service Representatives on the
Sametime server using the WebSphere Commerce Administration
Console’s User list - ″Register Customer Care″ button.

Applet CodeBase URL
Type the Applet CodeBase URL to where all the applet codes are
located. Ensure that the applet codes are installed on the Sametime
server machine.

Monitor Type
Select the type of monitoring that you want to use in Customer Care
applet.
v Monitor Waiting Queue.
v Monitor All Shoppers in Store.
v Monitor Waiting Queue and All Shoppers in Store.

The default is Monitor Waiting Queue.

Initiation Type
Select who can initiates help request during the Customer Care
collaboration.
v Shoppers initiate help.
v Both Customers and CSR initiate help.

Help Session Limit
Type the value to set how many help sessions a Customer Service
Representative can open at one time. The value must be a positive
integer. The default value is 7.
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CollaborativeWorkspaces – DirectoryAccess

Business

You must designate LDAP as the authentication mode for Member Subsystem
in order to properly configure directory access.

BaseDN
This is the LDAP suffix used in the WebSphere Commerce Member
Subsystem (e.g. o=root organization).

CollaborativeWorkspaces – QuickPlace

Business

QuickPlace is a self-service Web tool that is used for team collaboration.
QuickPlace enables the creation of a secure, central workspace on the Web
instantly. Structured for immediate participation, teams may use QuickPlace to
do the following:
v Coordinate: people, tasks, plans, and resources.
v Collaborate: share ideas and discussion, resolve issues, coauthor documents,

exchange files, and manage due diligence.
v Communicate: actions and decisions, key findings and lessons, and publish

knowledge to a broader base of readership.

Teams use QuickPlace for project management, rapid response to ad-hoc
initiatives, and to facilitate discrete business processes that span the extended
enterprise and value chain.

Domain
The domain of your QuickPlace server.

Host Name
The hostname of your QuickPlace server.

Administrator Login
The login name of your Domino administrator, with /domain
appended to the end.

Administrator Password
The password of your Domino administrator.

Collaboration Administrator
The login name of the super user of the Collaborative Workspaces
feature, with /domain appended to the end.

Collaboration Admin Password
The password of the Collaborative Workspaces super user.

Locale The locale of the QuickPlace server.
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Components
The components node contains a list of all components that have been created
for your WebSphere Commerce instance. You can enable or disable any of
these components by selecting it and selecting the Enable Component check
box. For more information on individual components, please refer to the
WebSphere Commerce online help.

You can also create or delete components through this node. To Remove a
component select it, right-click and select Remove Component. To add a
component, select Components, right-click and select Create Component.
Enter the name that you want to call the component, the class that you want
to associate with this component, and select Enable Component.

Protected Parameters
Protected parameters are those parameters whose values will not be exposed
in plain text in the trace files generated by WebSphere Commerce. They
include sensitive information such as credit card numbers and user
passwords. The Protected Parameters panel of the Configuration Manager
displays a list of all parameters that are currently protected.

To add a parameter to the list, complete the following steps:
1. On the Protected Parameters panel, right-click and select Add row.
2. In the table row that is created, enter the name of the parameter that you

want protected.
3. Click Apply.

To remove a parameter from the list, right-click the parameter and select
Delete row.

Registries
A registry is normally used to cache relatively static information that is stored
in the database. During the initialization of the RequestServlet, the registry
manager will initialize all registries that are defined through the Configuration
Manager as well as WebSphere Commerce’s internally defined registries.
Database information is cached in a registry for performance improvement.

To create a registry, right-click Registries and select Create Registry. This will
launch the Registry Creation wizard. Complete the fields as follows:

Registry Name
Enter the name that you want to assign to the registry that you are
creating.

Registry Class Name
Enter the name of the class that you want associated with the new
registry.
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Auction

Enable Auction
Select the Enable checkbox to enable Auctions.

SMTP Server
Define the SMTP server that is used to receive email messages.

Reply Email
Define the sender’s email information

External Server List
The External Server List contains the default LikeMinds server address. It also
contains a list of listener classes that process external events.

The LikeMinds listener is added by default. This listener will add the external
event into the LikeMinds server.

Commerce Accelerator
The Commerce Accelerator node of the Configuration Manager allows you to
configure the Business Intelligence component of WebSphere Commerce, and
integrate it with WebSphere Commerce Analyzer. Commerce Analyzer is an
optional software package that accompanies WebSphere Commerce. For more
information on installing and configuring Commerce Analyzer, please see the
WebSphere Commerce Additional Software Guide.

To configure Business Intelligence, complete the following fields:

Statistic source
Enter the fully qualified host name of the machine where your
statistics data is kept. This can be either a production server or a
staging server. The default value is the machine on which WebSphere
Commerce is installed.

Is WebSphere Commerce Analyzer Installed?
Select Yes if you have installed and configured Commerce Analyzer
and you want to use it with WebSphere Commerce.

Reports Document Root
Enter the path where you want the reports generated by Commerce
Analyzer to be stored. The path entered in this field is appended to
the end of the the instance directory root. The default path is
drive:\WebSphere\CommerceServer\instances\instance_name

Log System
The General tab of the Log System node contains all the parameters that were
contained in the Instance Creation wizard. The Advanced tab allows you to
choose which components you want to appear in the trace file, as well as the
level of defect tracking that you want the trace file to contain. Select the
components you want traced and the trace level, and then click Apply.
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For more information on individual components, please see the WebSphere
Commerce online help.

Caching Subsystem
The Cache node of the Configuration Manager allows you to configure the
cache, add a command to the cache, remove key sets from a command, and
remove keys from a key set.

Configure the cache by selecting the Cache node and entering the appropriate
values. Additional information on these values can be found by clicking Help
in the Configuration Manager, or in the online help under Caching
Parameters.

To add a command to cache, use the Cache wizard. This can be launched by
right-clicking Cache and selecting Add a command to cache. Complete all
fields on the three panels, and click Finish when you entered all parameters.
To remove a command from cache, select the command that you want to
remove, right-click and select Remove a command from cache.

To delete a key set, select the key set that you want to delete, right-click and
select Remove key set from this cached command. To delete a key, select the
associated key set. On the Advanced tab, select the key you want to delete,
right-click and select Delete row.

Configure Store Services
Store Services allows you to quickly create a store archive based on a sample
provided with WebSphere Commerce. For additional information on using
Store Services, please refer to the WebSphere Commerce online help.

The Configure Store Services node of the Configuration Manager allows you
to configure three parameters of Store Services:

Temporary Path
This is the directory that Store Services uses to copy temporary files
during publishing. This directory will be automatically purged of
these files once publishing has completed. The default directory is:
drive:\WebSphere\CommerceServer\tools\devtools\temp

Maximum Errors
This is the maximum number of errors that the publishing process
will allow while loading the store data. If this number is exceeded, the
publish will stop and rollback. The default value is 1.

Commit Count
This number is used during publishing. The database gets committed
after each commit count number of records gets loaded. If there are
errors in the data, the database gets rolled back to the last commit
point. Modify this number depending on the amount of data you are
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loading - setting the commit count to a number greater than the
number of rows in the archive will ensure that if a rollback occurs, the
entire archive will be rolled back. The default value is 1000.

Transports
By default, the e-mail transport system is enabled. However the mail host
must be set to prevent errors from occurring. To set the e-mail host, complete
the following steps:
1. Expand Transports, Outbound, JavaMail and select ConnectionSpec.
2. Select the Advanced tab.
3. In the value field of the host row, enter the fully qualified host name of

your SMTP mail server.
4. In the value field of the protocol row, ensure that the value listed is smtp.
5. Click Apply.
6. Stop and restart the WebSphere Commerce Server in the WebSphere

Application Server Administration Console.

The Configuration Manager cannot be used to configure outbound transports
or interaction specifications for inbound transports. Please refer to the online
help for transport-related tasks.

To configure inbound transport connection specifications, select the Advanced
tab of the connection specification panels and modify the information as
needed. Please see the online help for additional information regarding
transport parameters.

License User Management
Use the License User Management (LUM) panel to enter the number of store
licenses you have purchased for WebSphere Commerce. Complete the fields as
follows:

Store Licenses
Enter the number of licenses purchased.

Hard Stop
Enable Hard Stop if you want WebSphere Commerce to prevent you
from exceeding the number of licenses purchased.

Soft Stop
Enable Soft Stop if you want WebSphere Commerce to display a
message warning you that you have exceeded the number of licenses
purchased.
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The next step

After you have configured and started your WebSphere Commerce instance,
you need to complete the steps in Chapter 8, “Post-configuration steps” on
page 83 in order to finish setting up your system. If you do not complete the
steps in that chapter you will not be able to quickly access the WebSphere
Commerce Accelerator or WebSphere Commerce Administration Console.
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Chapter 8. Post-configuration steps

This chapter contains all the steps that you may need to complete in order to
finish your WebSphere Commerce configuration. The following tasks are
described in this chapter:
v “One and two tier post-configuration steps” on page 83
v “3-tier post-configuration steps” on page 91

One and two tier post-configuration steps

This chapter contains all the steps that you may need to complete in order to
finish your WebSphere Commerce configuration in a one or two tier
environment. The following tasks are described in this chapter:
v Completing your Microsoft IIS configuration (all Microsoft IIS users)
v Completing an iPlanet Web Server installation (all iPlanet Web Server users)
v Configuring Payment Manager to work with WebSphere Commerce (all

users)
v Configuring your Payment Manager settings (all users)
v Compiling the JavaServer Pages files (all users)
v Running the Security Checker Tool (optional)

Completing your Microsoft IIS configuration
Once you have sucessfully installed WebSphere Commerce and created your
WebSphere Commerce instance, proceed with the following steps.

Note: After installing WebSphere Commerce and creating WebSphere
Commerce instance you must start all Microsoft IIS web related services
and applications including the IIS Admin Service, the Default Web Site,
the Default FTP Site, and the Default SMTP Virtual Server. See
Microsoft IIS documentation for instructions on how to start these
services.

1. Install a secure certificate signed by a certifying authority, according to
Microsoft documentation.

2. Create aliases for the Microsoft IIS Server. To create aliases for the
Microsoft IIS Server, do the following:
a. Depending on your operating system, do the following:

v For Windows NT, do the following:
1) From the Start Menu, select Programs → Windows NT 4.0 Option

Pack → Microsoft Internet Information Server → Internet
Services Manager.

© Copyright IBM Corp. 1996, 2002 83



2) Expand Internet Information Server.
3) Expand host_name.

v For Windows 2000, do the following:
1) Select Programs → Administrative Tools → Computer

Management.
2) Expand Internet Information Services.

b. Select Default Web Site.
c. Select Action → New → Virtual Directory.
d. The Alias Generation Wizard displays. Click Next and enter the alias

name and directory name as shown in the following table. Give
execute permission to each alias below.

Note: You must repeat step 2b to 2d for each alias that you want to
create.

Table 4.

Alias Name Directory Default Filename

accelerator drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\common

accelerator.html

storeservices drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\devtools

storeservices.html

orgadminconsole drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.war\tools\buyerconsole

wcsbuyercon.html

wcsstore drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.war

adminconsole drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\adminconsole

wcsadmincon.html

wcs drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war

wcsdoc drive:\WebSphere\CommerceServer\web\
doc\

wcshelp drive:\WebSphere\CommerceServer\web\
doc\<locale>
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Table 4. (continued)

webeditor drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcwebeditor.war

e. Select Default Web Site.
f. Select Action → Properties.
g. Select the Document tab.
h. Click the Add button and add the following documents to the

corresponding alias:
v accelerator.html

v storeservices.html

v wcsadmincon.html

v wcsbuyercon.html

i. Click Apply.
j. Repeat step 2f to step 2i for each file.

3. To add SSL port 8000, do the following:
a. Right click the Default Web Site and select Properties.
b. On the Web Site tab click the Advanced button.
c. Click Add.
d. Add SSL port 8000, and click OK.

4. Restart your machine.
5. Restart the WebSphere Application Server.

If you plan to install and configure Payment Manager after you install
WebSphere Commerce you must perform some additional configuration steps.
To configure Microsoft IIS to work with IBM WebSphere Payment Manager
3.1.2 you must do the following:
1. Select Programs → Administrative Tools → Internet Services Manager.
2. Expand the hostname.
3. Right–click on Default Web Site.
4. Select Properties to open the properties page for the Default Web Site.
5. Select the Directory Security tab from Properties notebook.
6. Click the Edit button on the right to bring up the Authentication Methods

dialog box.
7. Ensure that the checkbox for Anonymous Access is selected and that the

other options are not selected.
8. Click OK to complete the change.
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Completing your iPlanet Web Server installation
Once you have created or updated a WebSphere Commerce instance that uses
iPlanet Web Server, you need to apply the changes you have made to the
obj.conf file for your secure servers and your non-secure server.
1. Launch your iPlanet Web Server administrator, by entering the following

URL in a browser:
http://host_name:8888/

2. Select your non-secure server from the list of available servers and click
Manage.

Note: Depending on the configuration of your iPlanet Web Server, a
warning message may appear. Click OK.

3. Click Apply in the upper right-hand corner.
4. Click Load Configuration Files. A message displays stating that you were

successful. Click OK.
5. Select the server from the dropdown list again, and click Apply in the

upper right-hand corner.
6. Click Apply Changes. A message displays stating that you were

successful. Click OK.
7. Repeat steps 1 through 5 for each of your secure servers (port 8000, and

port 443).

Configuring Payment Manager to work with WebSphere Commerce
To configure Payment Manager to work with WebSphere Commerce, you
must do the following:
1. Open the WebSphere Application Server Administration Console.
2. Create an alias by doing the following:

a. Expand WebSphere Administrative Domain.
b. Select Virtual Hosts.
c. Select default_host in the right-hand panel.
d. On the General tab, click Add.
e. Enter *:443 in the Alias field, and click Apply.

Note: If you do not enable SSL, you must configure the WebSphere
Commerce server to use the non-SSL Payment Manager client in the
Payment Manager setting page of the WebSphere Commerce
Configuration Manager when creating a WebSphere Commerce
instance. You can change the Payment Manager settings after the
instance is created, however, you must restart the instance for your
changes to take effect.

3. Open a command window and change to the following directory:
drive:\WebSphere\AppServer\bin
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4. Enter the following command:
GenPluginCfg.bat -adminNodeName node_name

Where node_name is the short logical name of the node.
5. Stop the WebSphere Application Server. To stop the WebSphere

Application Server, do the following:

Note: Step 5 to 7 are only required if Payment Manager is installed on the
same machine as WebSphere Commerce.

a. Exit the WebSphere Application Server Administration Console.
b. From the Services window, select IBM WS AdminServer 4.0.
c. Click Stop.

6. Open the following file in a text editor:
drive:\WebSphere\AppServer\config\plugin-cfg.xml

7. Add the following line directly below <Config> in the plugin-cfg.xml file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

8. Stop and restart your Web server. If you are using IBM HTTP Server refer
to “Starting and Stopping IBM HTTP Server” on page 148 for additional
information.

9. Start the WebSphere Application Server. To start the WebSphere
Application Server, do the following:
a. From the Services window, select IBM WS AdminServer 4.0.
b. Click Start.
c. Open the WebSphere Application Server Administration Console.

Important
It is recommended that you log into the WebSphere Commerce
Administration Console at least once before using Payment Manager. To
log into the WebSphere Commerce Administration Console, select
Programs → IBM WebSphere Commerce → Administration Console from
the Start menu. Enter the default Administration Console user ID
(wcsadmin), and the default password (wcsadmin). You will be asked to
change your password the first time you log in.

Payment Manager Administrator role
When you install Payment Manager, the WebSphere Commerce Administrator
ID, wcsadmin, is automatically assigned the Payment Manager Administrator
role. The Payment Manager Administrator role enables an ID to control and
administer Payment Manager.
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Notes:

1. Do not delete or rename the logon user ID wcsadmin, and do not change
the preassigned Payment Manager role of wcsadmin. Doing so will stop
some of the functions in WebSphere Commerce related to Payment
Manager integration from working.

2. If you assign a Payment Manager role to a WebSphere Commerce
administrator and then later want to delete or rename the logon user ID of
this administrator, you must remove the administrator’s Payment Manager
role before deleting or renaming it.

Important
In addition to the wcsadmin user ID, Payment Manager has preassigned
the Payment Manager Administrator role to two administrator IDs:
v admin

v ncadmin

To prevent a user from inadvertently obtaining this Payment Manager
Administrator role, you can:
v Create the above administrator ID in WebSphere Commerce using the

WebSphere Commerce Administration Console.
v In the Payment Manager User Interface, select Users.

– Remove the Payment Manager Administrator role from this ID.

Setting up your Payment Manager machine
To configure your Payment Manager machine, please see the ″Getting Started″
chapter of the IBM WebSphere Payment Manager Administrator’s Guide. This
section will guide you through the processes of:
v Starting the Payment Manager user interface
v Creating a Payment Manager merchant and authorizing a cassette
v Assigning user roles
v Creating an account
v Managing Payment Processing

Before you log on to the Payment Manager User Interface, ensure that
WebSphere Commerce is running and that the Payment Manager application
server has also been started and initialized. For more information, see
“Starting and Stopping Payment Manager” on page 150.
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Important
You must ensure that the host name listed in the Payment Manager
Settings panel of the Payment Manager user interface is a fully qualified
host name. If not, you must change the host name field to the fully
qualified host name, click Update, click Disable Payment Manager, and
then click Enable Payment Manager.

Update the Payment node in Configuration Manager for the WebSphere
Commerce instance, as described in “Payment Manager” on page 61, if
this has not already been done.

Note that you can also access the Payment Manager administration
functions from the WebSphere Commerce Administration Console
through the Site Manager’s Payment Manager menu.

Compiling the JavaServer Pages files
It is recommended that you Compile your JavaServer Pages files at this time.
Compiling the JavaServer Pages files will significantly reduce the amount of
time needed to load the WebSphere Commerce tools. To batch compile
JavaServer Pages (JSP) files, do the following:
1. From a command prompt, switch to

drive:\WebSphere\CommerceServer\bin.
2. Run the following command:

Note: This command is case sensitive, please enter the information exactly
as it appears below. If your enterpriseApp, webModule, or
nameServerHost names contain any spaces you must surround them
with double quotation marks, as shown below.

WCSJspBatchCompiler -enterpriseApp "WebSphere
Commerce Enterprise Application - instance_name"

-webModule "WCS Tools" -nameServerHost short_host_name
-nameServerPort port_number

where instance_name is the name of your WebSphere Commerce instance
(the default is demo), short_host_name is the name of your WebSphere
Commerce machine, and port_number is the WebSphere Application Server
bootstrap port (the default is 900).

Several errors may be logged when you perform these compiles. These may
be safely ignored.

Running the Security Checker tool
This section describes how to check your system’s security with WebSphere
Commerce’s security checking tool. The security checker tool inspects your
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system for potential security exposures, identifies files that should be deleted,
verifies permission and ownership of files that contain confidential
information, and checks security level within the IBM HTTP Server, and
WebSphere Application Server.

To access the security checking tool, do the following:
1. From the Start Menu select Programs → IBM WebSphere Commerce →

Administration Console. Enter the default Administration Console user ID
(wcsadmin), and the default password (wcsadmin). You will be asked to
change your password the first time you log in.

2. Select Site from the Site/Store selection page, and click OK to continue.
3. On the Site Administration Console, from the Security menu select

Security Checker.
4. The Security Checker contains a Launch button that launches the Security

Checker, and displays the results of the most recent security check. If the
Configuration Manager parameters are configured correctly, the ″No
security exposures found″ message will display.

5. Click OK when you have finished running the tool.

The following log is created by running the Security Checker tool:
v drive:\WebSphere\CommerceServer\instances\instance_name\logs\

sec_check.log. This file contains information about potential security
exposures.

The next step
After you have finished all of the steps required to complete your
configuration of WebSphere Commerce, you can continue by doing one or
more of the following:
v Create and publish your own store using Store Services. For information on

using Store Services, refer to the WebSphere Commerce online help.
Information on accessing WebSphere Commerce online help is available in
Appendix E, “Where to find more information” on page 173.

v Publish the demonstration store, InFashion, provided with WebSphere
Commerce to see how a typical store is built. Publish InFashion using Store
Services. For information on using Store Services, refer to the WebSphere
Commerce online help. Information on accessing WebSphere Commerce
online help is available in Appendix E, “Where to find more information”
on page 173.

v Configure additional options, such as:
– Chapter 12, “Enabling SSL for production with IBM HTTP Server”
– Chapter 9, “Create Multiple WebSphere Commerce Instances”
– Chapter 13, “Enabling WebSphere Application Server security”
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v Additional software is included with WebSphere Commerce. Information on
installing and configuring the following products is included in the IBM
WebSphere Commerce Additional Software Guide:
– IBM DB2 Text Extender 7.1
– WebSphere Commerce Analyzer
– Using Lightweight Directory Access Protocol (LDAP) with WebSphere

Commerce.
– SilkPreview
– LikeMinds Personalization Server
– Sametime
– QuickPlace

3-tier post-configuration steps

This chapter contains all the steps that you may need to complete in order to
finish your WebSphere Commerce configuration in a 3-tier environment. The
following tasks are described in this chapter:
v Completing your remote IBM HTTP Server configuration (all IBM HTTP

Server users)
v Completing an iPlanet Web Server installation (all iPlanet Web Server users)
v Copying assets to your Web server (all users)
v Completing your Microsoft IIS configuration (all Microsoft IIS users)
v Configuring Payment Manager to work with WebSphere Commerce (all

users)
v Compiling the JavaServer Pages files (all users)
v Running the Security Checker Tool (optional)

Configuring your IBM HTTP Server in a 3–tier environment

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.

In a 3-tier configuration, the httpd.conf file located on the Web server
machine has not been configured. A winaliases.txt file is located on the
WebSphere Commerce Disk 2 CD, in the drive:\Software_Patches directory.
This file lists the alias that you need to configure your httpd.conf file. You
must manually edit the httpd.conf file, by doing the following:
1. Stop your IBM HTTP Server.
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2. On your Web server machine, backup your httpd.conf.
3. Open the httpd.conf file in a text editor.
4. Uncomment the line that begins with #LoadModule ibm_ssl_module

modules/IBMModuleSSL128.dll. To uncomment the line remove the #
character.

5. Uncomment the line that begins with #Listen 443. To uncomment the
line remove the # character.

6. Below the line that begins with Listen 443, add the following lines:

Note: All the lines shown below have been formatted for readability
purposes only. Each line, starting with Alias or containing a path
(for example, drive:\WebSphere\CommerceServer/web/doc) must
appear on a single line in the httpd.conf file.

########## IBM WebSphere Commerce (Do not edit this section)############
Listen 8000
########## End of IBM WebSphere Commerce (Do not edit this section) ####
## VirtualHost: Allows the daemon to respond to requests for more than
## one server address, if your server machine is configured to accept IP
## packets for multiple addresses. This can be accomplished with the
## ifconfig alias flag, or through kernel patches like VIF.
#
## Any httpd.conf or srm.conf directive may go into a VirtualHost command.
## See also the BindAddress entry.
#
########## IBM WebSphere Commerce #################
#Instance name : instance_name
<VirtualHost webserver_IP_address>
ServerName fully_qualified_webserver_name
DocumentRoot "drive:/WEBSPH~1/HTTPSE~1/htdocs"
Alias /wcsdoc "drive:\WebSphere\CommerceServer/web/doc"
Alias /wchelp "drive:\WebSphere\CommerceServer/web/doc/en_US"
Alias /storeservices
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
devtools/storeservices.html"
Alias /adminconsole
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
adminconsole/wcsadmincon.html"
Alias /wcsstore "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcstores.war"
Alias /accelerator
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
common/accelerator.html"
Alias /orgadminconsole
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
buyerconsole/wcsbuyercon.html"
Alias /wcs "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war"
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Alias /webeditor "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcwebeditor.war"
</VirtualHost>
<VirtualHost webserver_IP_address:443>
SSLEnable
SSLClientAuth 0
ServerName fully_qualified_webserver_name
DocumentRoot "drive:/WEBSPH~1/HTTPSE~1/htdocs"
Alias /wcsdoc "drive:\WebSphere\CommerceServer/web/doc"
Alias /wchelp "drive:\WebSphere\CommerceServer/web/doc/en_US"
Alias /storeservices
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
devtools/storeservices.html"
Alias /adminconsole
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
adminconsole/wcsadmincon.html"
Alias /wcsstore "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcstores.war"
Alias /accelerator
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
common/accelerator.html"
Alias /orgadminconsole
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
buyerconsole/wcsbuyercon.html"
Alias /wcs "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war"
Alias /webeditor "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcwebeditor.war"
</VirtualHost>
<VirtualHost webserver_IP_address:8000>
SSLEnable
SSLClientAuth 0
ServerName fully_qualified_webserver_name
DocumentRoot "drive:/WEBSPH~1/HTTPSE~1/htdocs"
Alias /wcsdoc "drive:\WebSphere\CommerceServer/web/doc"
Alias /wchelp "drive:\WebSphere\CommerceServer/web/doc/en_US"
Alias /storeservices
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
devtools/storeservices.html"
Alias /adminconsole
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
adminconsole/wcsadmincon.html"
Alias /wcsstore "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcstores.war"
Alias /accelerator
"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
common/accelerator.html"
Alias /orgadminconsole
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"drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war/tools/
buyerconsole/wcsbuyercon.html"
Alias /wcs "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war"
Alias /webeditor "drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcwebeditor.war"
</VirtualHost>
########## End of IBM WebSphere Commerce ##########

7. Above the line that begins # drive:/WEBSPH~1/HTTPSE~1/cgi-bin, add
the following:
########## IBM WebSphere Commerce #################
#Instance name : instance_name
<Directory "drive:/WEBSPH~1/HTTPSE~1/htdocs">
Options Indexes
AllowOverride None
order allow,deny
allow from all
</Directory>
<Directory drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wctools.war>
<Files *.jsp>
order allow,deny
deny from all
</Files>
</Directory>
<Directory drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcstores.war>
<Files *.jsp>
order allow,deny
deny from all
</Files>
</Directory>
<Directory drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear/wcwebeditor.war>
<Files *.jsp>
order allow,deny
deny from all
</Files>
</Directory>
########## End of IBM WebSphere Commerce##########

8. Uncomment the line that begins with #Keyfile
"drive:/WebSphere/HTTPServer/ssl/keyfile.kdb". To uncomment the
line remove the # character.

9. Save the file.
10. To ensure that your httpd.conf file does not contain syntax errors,

change to the drive:\WebSphere\HTTPServer directory and run the
following command:
apache -t

11. Start the IBM HTTP Server as described in “Starting and Stopping IBM
HTTP Server” on page 148.
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Completing your iPlanet Web Server installation

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.

Once you have created or updated a WebSphere Commerce instance that uses
iPlanet Web Server, you need to apply the changes you have made to the
obj.conf file for your secure servers and your non-secure server.
1. Launch your iPlanet Web Server administrator, by entering the following

URL in a browser:
http://host_name:8888/

2. Select your non-secure server from the list of available servers and click
Manage.

Note: Depending on the configuration of your iPlanet Web Server, a
warning message may appear. Click OK.

3. Click Apply in the upper right-hand corner.
4. Click Load Configuration Files. A message displays stating that you were

successful. Click OK.
5. Select the server from the dropdown list again, and click Apply in the

upper right-hand corner.
6. Click Apply Changes. A message displays stating that you were

successful. Click OK.
7. Repeat steps 1 through 5 for each of your secure servers (port 8000, and

port 443).

Remote iPlanet Web Server configuration
If you are using an iPlanet Web Server which is installed remotely from the
WebSphere Commerce server, complete the following steps:
1. Open the obj.conf file for the Web server on port 8000 in a text editor (the

default path to this file is drive:\Netscapeserver4\https-hostname-https-
8000\config\obj.conf).

2. Search for the <Object name="default"> tag.
3. Add the following below this line:

########### IBM WebSphere Commerce ##########
NameTrans fn="pfx2dir" from="/wcsdoc" dir="drive:\WebSphere\CommerceServer\
web\doc"
NameTrans fn="pfx2dir" from="/wchelp" dir="drive:\WebSphere\CommerceServer\
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web\doc\<locale>"
NameTrans fn="pfx2dir" from="/storeservices"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wctools.war\tools\devtools\
storeservices.html"
NameTrans fn="pfx2dir" from="/adminconsole"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wctools.war\tools\
adminconsole\wcsadmincon.html"
NameTrans fn="pfx2dir" from="/accelerator"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wctools.war\tools\common\
accelerator.html"
NameTrans fn="pfx2dir" from="/wcs"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wctools.war"
NameTrans fn="pfx2dir"from="/webeditor"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcwebeditor.war"
########### End of IBM WebSphere Commerce #######

4. Save the file.
5. Open the obj.conf file for the Web server on port 443 in a text editor (the

default path to this file is drive:\Netscapeserver4\https-hostname-https-
443\config\obj.conf).

6. Search for the <Object name="default"> tag.
7. Add the following below this line:

########### IBM WebSphere Commerce ##########
NameTrans fn="pfx2dir" from="/wcsstore"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcstores.war"
NameTrans fn="pfx2dir" from="/orgadminconsole"
dir="drive:\WebSphere\AppServer\installedApps
\WC_Enterprise_App_instance_name.ear\wctools.war\tools\buyerconsole\
wcsbuyercon.html"
NameTrans fn="pfx2dir" from="/wcs"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wctools.war"
NameTrans fn="pfx2dir"from="/webeditor"
dir="drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcwebeditor.war"
########### End of IBM WebSphere Commerce #######

8. Add aliases to the configuration files for the servers on ports 80:
a. Open the obj.conf file for each Web server in a text editor (the default

path to this file is drive:\Netscapeserver4\https-hostname-https-
80\config\obj.conff).

b. Search for the <Object name="default"> tag.
c. Add the following information below this tag:

NameTrans fn="pfx2dir" from="/wcsstore"
dir="drive:\WebSphere\AppServer\installedApps\
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Copying assets to your Web server
If your Web server is installed remotely from WebSphere Application Server
and WebSphere Commerce, you must copy certain files from the WebSphere
Commerce machine to the Web server.
1. Copy over the contents of the following directory, including sub

directories, from the WebSphere Application Server machine to the Web
server machine:
drive:\WebSphere\AppServer\WSsamples

It may be necessary to create the directories on your Web server machine.
2. Copy over the contents of the following directory, including sub

directories, from the WebSphere Commerce machine to the Web server
machine:
drive:\WebSphere\CommerceServer\web

It may be necessary to create the directories on your Web server machine.

Note: This is necessary each time you change the web assets on your
WebSphere Commerce machine.

3. Copy over the contents of the following directory, including sub
directories, from the WebSphere Commerce machine to the Web server
machine:
v drive:\WebSphere\AppServer\installedApps\

WC_Enterprise_App_instance_name.ear\wcwebeditor.war

v drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcstores.war

v drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcstools.war

It may be necessary to create the directories on your webserver machine.

Note: This is necessary each time you change the web assets on your
WebSphere Commerce machine.

4. Copy over the contents of the following directory, including sub
directories, from the WebSphere Commerce machine to the Web server
machine:
drive:\WebSphere\CommerceServer\instances\instance_name\xml

It may be necessary to create this directory on your Web server machine.
5. Copy over the following file, from the WebSphere Commerce machine to

the Web server machine:
drive:\WebSphere\CommerceServer\instances\wcs_instances

It may be necessary to create the directory on your Web server machine.
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6. On your Web server machine, delete all jsp, sar and xml files found in the
following directories:
drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.wardrive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcstools.war
drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\wcwebeditor.war

Note: This is necessary each time you change the web assets on your
WebSphere Commerce machine.

Setting up your Web server cache
Setting up the Web server cache is only necessary if one or more of your
cacheable Web addresses are session independent. If all of your cacheable Web
addresses are session dependent, skip this section.

You can set up the cache daemon so that requests are made directly from a
Web server cache client on your Web server machine to a cache daemon
running on your WebSphere Application Server machine. If you do not set up
a cache client on each Web server machine as described in this section, cache
pages will still be served using application server cache clients on your
WebSphere Application Server machine communicating with the cache
daemon (also running on the WebSphere Application Server machine).

Given that the code path to any Application server cache client is longer than
the path to any Web server cache client, the Web server cache client can serve
session independent cacheable requests faster and using fewer system
resources. (For more information, see the WebSphere Commerce Suite online
documentation for a discussion on session dependency of cache requests.)

The following instructions explain how to set up a Web server cache client on
your Web server machine:
1. Open the following file in a text editor:

drive:\WebSphere\AppServer\config\plugin-cfg.xml

2. Add the following line directly below <Config> in the plugin-cfg.xml file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

Verifying the Cache Plug-in is working
Before proceeding, ensure that you have successfully published a store.
1. Ensure that the following line appears in the plugin-cfg.xml file:

<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

Restart the web server.
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2. Set the WCS_CACHE_PLUGIN environment variable on your Web server
machine. Click Start → Settings → Control Panel → System → Environment
tab. Under System Variables, add the WCS_CACHE_PLUGIN variable and set it
to a value of drive:\temp\cache.txt. After updating the variable, you
need to restart your machine.

3. Start your Web server.
If you are using IBM HTTP Server, use the command line version of the
startup command instead of starting it as a service. From the
drive:\WebSphere\IBM HTTP Server directory, type:
apache

If you are using Netscape iPlanet, use the command line version of the
startup command for your server instead of starting it as a service. From
the subdirectory for your secure and non-secure servers, run the
startsrv.bat command.

4. Request a product display page from your store, and then request it once
again (for the same product).

5. You should see verification in the cache.txt file by the presence of a CACHE
HIT entry for the second product display request.

6. Remove the WCS_CACHE_PLUGIN enviroment variable from your System
Variables.

Completing your Microsoft IIS configuration

Important
If you install your Web server remotely from your WebSphere Commerce
machine, ensure that both products are installed to the same drive letter.
For example, if you install your Web server software to drive C: on your
remote Web server machine, install WebSphere Commerce to drive C: on
your WebSphere Commerce machine.

Once you have sucessfully installed WebSphere Commerce and created your
WebSphere Commerce instance, proceed with the following steps.

Note: After installing WebSphere Commerce and creating WebSphere
Commerce instance you must start all Microsoft IIS web related services
and applications including the IIS Admin Service, the Default Web Site,
the Default FTP Site, and the Default SMTP Virtual Server. See
Microsoft IIS documentation for instructions on how to start these
services.

1. Install a secure certificate signed by a certifying authority, according to
Microsoft documentation.

2. Create aliases for the Microsoft IIS Server. To create aliases for the
Microsoft IIS Server, do the following:
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a. Depending on your operating system, do the following:
v For Windows NT, do the following:

1) From the Start Menu, select Programs → Windows NT 4.0 Option
Pack → Microsoft Internet Information Server → Internet
Services Manager.

2) Expand Internet Information Server.
3) Expand host_name.

v For Windows 2000, do the following:
1) Select Programs → Administrative Tools → Computer

Management.
2) Expand Internet Information Services.

b. Select Default Web Site.
c. Select Action → New → Virtual Directory.
d. The Alias Generation Wizard displays. Click Next and enter the alias

name and directory name as shown in the following table. Give
execute permission to each alias below.

Note: You must repeat step 2b to 2d for each alias that you want to
create.

Table 5.

Alias Name Directory Default Filename

accelerator drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\common

accelerator.html

storeservices drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\devtools

storeservices.html

orgadminconsole drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.war\tools\buyerconsole

wcsbuyercon.html

wcsstore drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcstores.war

adminconsole drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war\tools\adminconsole

wcsadmincon.html

wcs drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wctools.war
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Table 5. (continued)

wcsdoc drive:\WebSphere\CommerceServer\web\
doc\

wcshelp drive:\WebSphere\CommerceServer\web\
doc\<locale>

webeditor drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear\
wcwebeditor.war

e. Select Default Web Site.
f. Select Action → Properties.
g. Select the Document tab.
h. Click the Add button and add the following documents to the

corresponding alias:
v accelerator.html

v storeservices.html

v wcsadmincon.html

v wcsbuyercon.html

i. Click Apply.
j. Repeat step 2f to step 2i for each file.

3. To add SSL port 8000, do the following:
a. Right click the Default Web Site and select Properties.
b. On the Web Site tab click the Advanced button.
c. Click Add.
d. Add SSL port 8000, and click OK.

4. Restart your machine.
5. Restart the WebSphere Application Server.

If you plan to install and configure Payment Manager after you install
WebSphere Commerce you must perform some additional configuration steps.
To configure Microsoft IIS to work with IBM WebSphere Payment Manager
3.1.2 you must do the following:
1. Select Programs → Administrative Tools → Internet Services Manager.
2. Expand the hostname.
3. Right–click on Default Web Site.
4. Select Properties to open the properties page for the Default Web Site.
5. Select the Directory Security tab from Properties notebook.
6. Click the Edit button on the right to bring up the Authentication Methods

dialog box.
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7. Ensure that the checkbox for Anonymous Access is selected and that the
other options are not selected.

8. Click OK to complete the change.

Remote Microsoft IIS configuration
If you are using a Microsoft IIS Web server which is installed remotely from
the WebSphere Commerce server, complete the following steps:
1. Depending on your operating system, do the following:

v For Windows NT, do the following:
a. From the Start Menu, select Programs → Windows NT 4.0 Option

Pack → Microsoft Internet Information Server → Internet Services
Manager.

b. Expand Internet Information Server.
c. Expand host_name.

v For Windows 2000, do the following:
a. Select Programs → Administrative Tools → Computer Management.
b. Expand Internet Information Services.

2. Navigate to WSsamples, and select Action > Properties.
3. On the Documents tab, select Enable Default Document, and click Add.
4. Enter index.html and click OK.
5. Click OK again.
6. Navigate to Theme, and select Action > Properties.
7. On the Virtual Directory tab click Browse. Select

drive:\WebSphere\AppServer\WSsamples\image, and click OK.
8. Click OK again.

Configuring Payment Manager to work with WebSphere Commerce
To configure Payment Manager to work with WebSphere Commerce, you
must do the following:
1. Open the WebSphere Application Server Administration Console.
2. Create an alias by doing the following:

a. Expand WebSphere Administrative Domain.
b. Select Virtual Hosts.
c. Select default_host in the right-hand panel.
d. On the General tab, click Add.
e. Enter *:443 in the Alias field, and click Apply.

Note: If you do not enable SSL, you must configure the WebSphere
Commerce server to use the non-SSL Payment Manager client in the
Payment Manager setting page of the WebSphere Commerce
Configuration Manager when creating a WebSphere Commerce
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instance. You can change the Payment Manager settings after the
instance is created, however, you must restart the instance for your
changes to take effect.

3. Open a command window and change to the following directory:
drive:\WebSphere\AppServer\bin

4. Enter the following command:
GenPluginCfg.bat -adminNodeName node_name

Where node_name is the short logical name of the node.
5. Stop the WebSphere Application Server. To stop the WebSphere

Application Server, do the following:

Note: Step 5 to 7 are only required if Payment Manager is installed on the
same machine as WebSphere Commerce.

a. Exit the WebSphere Application Server Administration Console.
b. From the Services window, select IBM WS AdminServer 4.0.
c. Click Stop.

6. Open the following file in a text editor:
drive:\WebSphere\AppServer\config\plugin-cfg.xml

7. Add the following line directly below <Config> in the plugin-cfg.xml file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

8. Copy the plugin-cfg.xml file to your Web server machine.
9. Stop and restart your Web server. If you are using IBM HTTP Server refer

to “Starting and Stopping IBM HTTP Server” on page 148 for additional
information.

10. Start the WebSphere Application Server. To start the WebSphere
Application Server, do the following:
a. From the Services window, select IBM WS AdminServer 4.0.
b. Click Start.
c. Open the WebSphere Application Server Administration Console.

Important
It is recommended that you log into the WebSphere Commerce
Administration Console at least once before using Payment Manager. To
log into the WebSphere Commerce Administration Console, select
Programs → IBM WebSphere Commerce → Administration Console from
the Start menu. Enter the default Administration Console user ID
(wcsadmin), and the default password (wcsadmin). You will be asked to
change your password the first time you log in.
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Additional Payment Manager configuration steps
Payment Manager requires additional configuration steps when WebSphere
Commerce is installed in a 3–tier environment. To complete the additional
Payment Manager configuration, do the following:
1. Ensure that the Payment Manager Application Server is stopped within

the WebSphere Application Server Administration Console.
2. On your Payment Manager machine, navigate to the following directory:

drive:\Program Files\IBM\PaymentManager

3. Open the WCSRealm.properties file in a text editor.
4. Ensure that the WCSHostName entry contains the fully qualified hostname

of your Web server machine.
5. Save the file.
6. On your WebSphere Commerce machine, navigate to the following

directory:
drive:\WebSphere\CommerceServer\instances\instance_name\xml

7. Open the instance_name.xml file in a text editor.
8. Ensure that the HostName within the PaymentManager section of the xml file

contains the fully qualified hostname of your Web server machine.
9. Save the file.

10. Open the WebSphere Application Server Administration Console.
11. Expand WebSphere Administrative Domain → Nodes → node_name →

Application Servers → WebSphere Payment Manager.
12. Select the JVM Settings tab.
13. In the System Properties box, set wpmui.PaymentServerHostname, and

change the value to the fully qualified hostname of your Web server
machine.

14. Click Apply.
15. Start the Payment Manager Application Server.

Payment Manager Administrator role
When you install Payment Manager, the WebSphere Commerce Administrator
ID, wcsadmin, is automatically assigned the Payment Manager Administrator
role. The Payment Manager Administrator role enables an ID to control and
administer Payment Manager.

Notes:

1. Do not delete or rename the logon user ID wcsadmin, and do not change
the preassigned Payment Manager role of wcsadmin. Doing so will stop
some of the functions in WebSphere Commerce related to Payment
Manager integration from working.
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2. If you assign a Payment Manager role to a WebSphere Commerce
administrator and then later want to delete or rename the logon user ID of
this administrator, you must remove the administrator’s Payment Manager
role before deleting or renaming it.

Important
In addition to the wcsadmin user ID, Payment Manager has preassigned
the Payment Manager Administrator role to two administrator IDs:
v admin

v ncadmin

To prevent a user from inadvertently obtaining this Payment Manager
Administrator role, you can:
v Create the above administrator ID in WebSphere Commerce using the

WebSphere Commerce Administration Console.
v In the Payment Manager User Interface, select Users.

– Remove the Payment Manager Administrator role from this ID.

Setting up your Payment Manager machine
To configure your Payment Manager machine, please see the ″Getting Started″
chapter of the IBM WebSphere Payment Manager Administrator’s Guide. This
section will guide you through the processes of:
v Starting the Payment Manager user interface
v Creating a Payment Manager merchant and authorizing a cassette
v Assigning user roles
v Creating an account
v Managing Payment Processing

Before you log on to the Payment Manager User Interface, ensure that
WebSphere Commerce is running and that the Payment Manager application
server has also been started and initialized. For more information, see
“Starting and Stopping Payment Manager” on page 150.
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Important
You must ensure that the host name listed in the Payment Manager
Settings panel of the Payment Manager user interface is a fully qualified
host name. If not, you must change the host name field to the fully
qualified host name, click Update, click Disable Payment Manager, and
then click Enable Payment Manager.

Update the Payment node in Configuration Manager for the WebSphere
Commerce instance, as described in “Payment Manager” on page 61, if
this has not already been done.

Note that you can also access the Payment Manager administration
functions from the WebSphere Commerce Administration Console
through the Site Manager’s Payment Manager menu.

Compiling the JavaServer Pages files
It is recommended that you Compile your JavaServer Pages files at this time.
Compiling the JavaServer Pages files will significantly reduce the amount of
time needed to load the WebSphere Commerce tools. To batch compile
JavaServer Pages (JSP) files, do the following on your WebSphere Commerce
machine:
1. From a command prompt, switch to

drive:\WebSphere\CommerceServer\bin.
2. Run the following command:

Note: This command is case sensitive, please enter the information exactly
as it appears below. If your enterpriseApp, webModule, or
nameServerHost names contain any spaces you must surround them
with double quotation marks, as shown below.

WCSJspBatchCompiler -enterpriseApp "WebSphere
Commerce Enterprise Application - instance_name"

-webModule "WCS Tools" -nameServerHost short_host_name
-nameServerPort 900

Several errors may be logged when you perform these compiles. These may
be safely ignored.

Running the Security Checker tool
This section describes how to check your system’s security with WebSphere
Commerce’s security checking tool. The security checker tool inspects your
system for potential security exposures, identifies files that should be deleted,
verifies permission and ownership of files that contain confidential
information, and checks security level within the IBM HTTP Server, and
WebSphere Application Server.
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To access the security checking tool, do the following:
1. From the Start Menu select Programs → IBM WebSphere Commerce →

Administration Console. Enter the default Administration Console user ID
(wcsadmin), and the default password (wcsadmin). You will be asked to
change your password the first time you log in.

2. Select Site from the Site/Store selection page, and click OK to continue.
3. On the Site Administration Console, from the Security menu select

Security Checker.
4. The Security Checker contains a Launch button that launches the Security

Checker, and displays the results of the most recent security check. If the
Configuration Manager parameters are configured correctly, the ″No
security exposures found″ message will display.

5. Click OK when you have finished running the tool.

The following log is created by running the Security Checker tool:
v drive:\WebSphere\CommerceServer\instances\instance_name\logs\

sec_check.log. This file contains information about potential security
exposures.

The next step
After you have finished all of the steps required to complete your
configuration of WebSphere Commerce, you can continue by doing one or
more of the following:
v Create and publish your own store using Store Services. For information on

using Store Services, refer to the WebSphere Commerce online help.
Information on accessing WebSphere Commerce online help is available in
Appendix E, “Where to find more information” on page 173.

v Publish the demonstration store, InFashion, provided with WebSphere
Commerce to see how a typical store is built. Publish InFashion using Store
Services. For information on using Store Services, refer to the WebSphere
Commerce online help. Information on accessing WebSphere Commerce
online help is available in Appendix E, “Where to find more information”
on page 173.

v Configure additional options, such as:
– Chapter 12, “Enabling SSL for production with IBM HTTP Server”
– Chapter 9, “Create Multiple WebSphere Commerce Instances”
– Chapter 13, “Enabling WebSphere Application Server security”

v Additional software is included with WebSphere Commerce. Information on
installing and configuring the following products is included in the IBM
WebSphere Commerce Additional Software Guide:
– IBM DB2 Text Extender 7.1
– WebSphere Commerce Analyzer
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– Using Lightweight Directory Access Protocol (LDAP) with WebSphere
Commerce.

– SilkPreview
– LikeMinds Personalization Server
– Sametime
– QuickPlace
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Part 3. Advanced Configuration

This section contains information on how to perform advanced configuration
tasks for WebSphere Commerce. This section describes how to create multiple
instances, and perform vertical and horizontal cloning.

The following topics are covered:
v Chapter 9, “Create Multiple WebSphere Commerce Instances” on page 111
v Chapter 10, “Cloning” on page 117
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Chapter 9. Create Multiple WebSphere Commerce
Instances

WebSphere Commerce 5.4 supports the creation of multiple WebSphere
Commerce instances. That is, with WebSphere Commerce, you can run two or
more instances of WebSphere Commerce concurrently by using a different
host name for each WebSphere Commerce instance. In this case, a customer
can access host1.domain.com and host2.domain.com. This method involves the
use of virtual host names.

Notes:

1. The following examples refer to demo1, demo2, host1, host2, htdocs1, and
htdocs2. These examples represent the parameter values for your first and
second instance and are intended to show that these values are unique
between instances.

2. Normally, you will have an operational pre-existing WebSphere Commerce
instance and you simply need to create an additional instance or instances.
If you have a pre-existing instance, you do not have to modify any of the
parameter values for that instance in order to add an additional instance.
You can optionally modify some parameters of your original instance in
order to better organize your multi-instance environment. For example,
you could consider renaming your document root directory from
...\htdoc to ...\htdoc1 to correspond to your first instance.

Important
For each additional WebSphere Commerce instance that is created, you
must install and configure Payment Manager on a separate, unique
machine.

Multiple Instances Using Virtual Host Names

This section shows you how to create multiple WebSphere Commerce
instances using virtual host names.

Prerequisites
1. Normally, you require one Internet Protocol (IP) address for each instance,

plus one additional IP address for the machine. For example, for two
instances, you would normally require a total of three IP addresses. The
three IP addresses must be valid on the network, with associated host
names in the Domain Name System (DNS) server. The example that
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follows assumes that you have a pre-existing instance and shows you how
to create an additional instance. In this example, the IP addresses and host
names for the instances are:
v m.mm.mm.mmm with host name host1.domain.com (pre-existing)
v n.nn.nn.nnn with host name host2.domain.com (for the additional

instance)

v You can also use the IP address and host name of the machine for
one of the instances. In this case, you need just two IP addresses
for two instances.

v You cannot share host names between instance. Each instance
requires a unique host name.

Note: IBM HTTP Server 1.3.19.1 does not allow underscore characters in
the name of a virtual host.

2. The host name for each instance must resolve fully to separate IP
addresses. For example, to verify that you can run Configuration Manager
and create multiple instances, run the nslookup command on both the host
name and IP address for each instance. The host name should resolve to
its correct IP address, and the IP address should resolve to its correct host
name:
nslookup host1.domain.com
nslookup m.mm.mm.mmm

nslookup host2.domain.com
nslookup n.nn.nn.nnn

3. There must be one valid document root for each instance. The simplest
way to do this is to copy the existing document root and rename it.
If you are using IBM HTTP Server, copy
drive:\WebSphere\HTTPServer\htdocs and rename it to
drive:\WebSphere\HTTPServer\htdocs2. Optionally, you can copy
drive:\WebSphere\HTTPServer\htdocs again, and rename it to
drive:\WebSphere\HTTPServer\htdocs1.

4. Before you create the second instance, ensure that the IBM WS AdminServer
service is started in the Windows Services window.

5. For each additional instance, you should increase your machine memory
by 512 MB.

Create the Multiple Instances
Assuming you have already created your first WebSphere Commerce instance,
you can create each additional instance that you require by following the
instructions in Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55. In the following table, the existing
instance is represented by Instance 1 and the new instance is represented by
Instance 2. You do not have to modify the values for an existing instance. The
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table lists the modified default values for the new instance. Replace these
values with the actual values (such as your instance name, your host name,
and so on) that you want to use for your instance.

Field in
Configuration
Manager

Instance 1 Instance 2

Instance - Instance
name

demo1 demo2

Instance - Instance
root path

drive:\WebSphere\
CommerceServer\
instances\demo1

drive:\WebSphere\
CommerceServer\
instances\demo2

Database - Database
name

mall1 mall2

Webserver -
hostname

host1.domain.com host2.domain.com

Webserver - Primary
Document Root

(for IBM HTTP
Server)

drive:\WebSphere\HTTPServer\
htdocs1

drive:\WebSphere\HTTPServer\
htdocs2

Payment Manager -
hostname

host1.domain.com host2.domain.com

If you are going to use caching with your instance, you need to modify the
instance_name.xml file manually. Stop your instances in the WebSphere
Application Server Administration Console, and then modify the following
entries within the instance_name.xml file so that they contain the correct
information for each instance:
Cache AutoPageInvalidation="true"

CacheDaemonBindAddress="<IP_address_of_the_instance>"

CacheDaemonPort="<port_number_of_the_instance>"

After you have made and saved these changes, restart your instance.

Start Your Instances
Once the WebSphere Commerce instances have been created:
1. Check that the following entries have been created in the WebSphere

Application Server Administration Console:
v WebSphere Commerce Server demo1

v WebSphere Commerce Server demo2

v WebSphere Commerce DB2 DataSource demo1
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v WebSphere Commerce DB2 DataSource demo2

v WebSphere Commerce DB2 JDBC Driver demo1

v WebSphere Commerce DB2 JDBC Driver demo2

v default_host (corresponding to demo1)
v VH_demo2

2. If you are using IBM HTTP Server, check that the following <VirtualHost>
sections exist in the Virtual Host section of the IBM HTTP Server
configuration file (drive:\WebSphere\HTTPServer\conf\httpd.conf):

Note: In a 3-tier configuration, you must manually add the following lines
to your httpd.conf file.

<VirtualHost m.mm.mm.mmm>
ServerName host1.domain.com
DocumentRoot "drive:/WebSphere/HTTPServer/htdocs1
</VirtualHost>
.
.
.
<VirtualHost m.mm.mm.mmm:443>
SSLEnable
SSLClientAuth 0
ServerName host1.domain.com
DocumentRoot "drive:/WebSphere/HTTPServer/htdocs1"
.
.
.
<VirtualHost n.nn.nn.nnn>
ServerName host2.domain.com
DocumentRoot "drive:/WebSphere/HTTPServer/htdocs2
</VirtualHost>
.
.
.
<VirtualHost n.nn.nn.nnn:443>
SSLEnable
SSLClientAuth 0
ServerName host2.domain.com
DocumentRoot "drive:/WebSphere/HTTPServer/htdocs2"

Note that in the above example, the SSLClientAuth 0 directive represents
the case where you have chosen Basic authentication mode in the Web
server node of Configuration Manager for your instance. If you have
selected X.509 authentication mode in the Web server node, the directive
will be SSLClientAuth 2.

3. If you are using IBM HTTP Server, check that the following two
<Directory> sections exist in the Document Root section of the IBM HTTP
Server configuration file (drive:\WebSphere\HTTPServer\conf\httpd.conf:
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<Directory "drive:/WebSphere/HTTPServer/htdocs1">
Options Indexes
AllowOverride None
order allow,deny
allow from all
</Directory>

<Directory "drive:/WebSphere/HTTPServer/htdocs2">
Options Indexes
AllowOverride None
order allow,deny
allow from all
</Directory>

4. Ensure that you are able to load the Web server home page for each
instance (for example, http://host1.domain.com and
http://host2.domain.com )

5. Ensure that you are able to load the secure Web server home page for each
instance (for example, https://host1.domain.com and
https://host2.domain.com )

6. Start each instance in the WebSphere Application Server Administration
Console.

7. Ensure that you are able to load each instance’s WebSphere Commerce
Accelerator.
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Chapter 10. Cloning

This chapter shows you how to use the WebSphere Application Server cloning
mechanism assuming a 3–tier configuration (remote Web server and remote
database). Note that you can also use the WebSphere Application Server
cloning mechanism for simpler WebSphere Commerce configurations such as
a single-tier or two-tier (that is, using a remote database) configuration. Read
this chapter if you want to use WebSphere Application Server horizontal
cloning model to add WebSphere Commerce machines for enhanced load
sharing.

An excellent resource for this section are the IBM Redbooks. To obtain a copy
of these books, see the IBM Redbook Web site at:
http://www.redbooks.ibm.com/

Horizontal cloning

Horizontal cloning refers to the traditional practice of defining clones of an
application server on multiple physical machines, thereby allowing a single
WebSphere application to span several machines while presenting a single
system image. Horizontal cloning can provide increased throughput.

To configure a horizontal clone, do the following:
1. Install WebSphere Commerce in a 3–tier configuration.

v Machine A is your Web server
v Machine B is your database server
v Machine C is your WebSphere Commerce Server

2. On the machine where you want to create a clone, install and configure
WebSphere Commerce. This machine is called Machine D. You must select
the following options during the installation:

Important
You must install Machine C and Machine D to the same drive letter,
and with the same directory structure.

a. On the Setup Type window, select Custom.
b. On the Custom Installation window, select The commerce server.
c. On the Database and Web Server Selection window, select join an

existing WebSphere Domain.
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d. Enter the fully qualified host name of your remote web server.
e. Enter remote database. You are prompted to enter the fully qualified

host name of your database machine, and the your database name.
f. Complete the installation of WebSphere Commerce.
g. Before restarting your WebSphere Commerce machine, you must do

the following:
1) Open the Windows Services window and start the DB2 Secure

Server and DB2 JDBC Applet Server services.
2) Open a DB2 command line processor, and issue the following

commands:
catalog tcpip node node_name remote database_server_hostname
server port_number
attach to node_name user db2_user_ID using db2_userid_password
catalog database WAS40 as WAS40 at node node_name
catalog database MALL as MALL at node node_name
quit

h. Reboot your machine.
3. Restart the WebSphere Application Server.

You must configure your WebSphere Commerce machines. To configure your
machines, do the following:
1. Configure the datasource for Machine D:

a. Ensure that the WebSphere Application Server has been started.
b. Open the WebSphere Application Server Administration Console.
c. Expand WebSphere Administrative Domain → Resources → JDBC

Providers.
d. Select WebSphere Commerce DB2 JDBC Driver instance_name and

click the Nodes tab.
e. Click Set, then Install.
f. Click Apply.

2. Create a Server Group on Machine C.
a. Start the WebSphere Application Server.
b. Open the WebSphere Application Server Administration Console.
c. Expand WebSphere Administrative Domain → Nodes → host_name →

Application Servers.
d. Stop the WebSphere Commerce Server – instance_name application

server.
e. Right click on the WebSphere Commerce Server – instance_name and

select Create Server Group (unless a Server Group already exists).
f. Enter the Server Group name and click OK.

3. Add a horizontal clone to the WebSphere Commerce Server Group.
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a. Open the WebSphere Application Server Administration Console on
Machine C.

b. Expand WebSphere Administrative Domain → Server Groups.
c. Right click the WebSphere Server Group.
d. Select New → Clone.
e. Enter the new clone name (for example, WebSphere Commerce –

instance_name).
f. Select the node on Machine D and click Create.

4. Copy the following directory from Machine C to Machine D:
drive:\WebSphere\AppServer\installedApps\
WC_Enterprise_App_instance_name.ear

5. Rename this directory, on Machine D, to match the following:
drive:\WebSphere\AppServer\installedApps\
WebSphere_Commerce_Enterprise_Application_-_instance_name.ear

6. In order to differentiate WebSphere Commerce application server clones
on Machine D from those on Machine C, a unique instancename value
must be assigned for Machine D:
a. Edit the

drive:\WebSphere\AppServer\installedApps\WebSphere_Commerce_Enterprise_Application_-_
instance.ear\wcstores.war\WEB_INF\web.xml file.

b. Search for the following line: <param-name>instancename</param-
name>

c. On the line immediately below, alter the parameter value (between
the <param-value> tags) to a unique name, different from those values
used on other WebSphere Commerce machines. A good choice would
be to use the host name of that node. This change is needed to allow
scheduled or broadcast commands to reach all clones.

d. The same change needs to be made to the
drive:\WebSphere\AppServer\WebSphere_Commerce_Enterprise_Application_-_instance.ear\wctools.w
file.

7. Copy the following directory from Machine C to Machine D, overwriting
the existing directories:
drive:\WebSphere\CommerceServer\instance

8. On Machine D, open the following file in a text editor:
drive:\WebSphere\CommerceServer\instance\instance_name\xml\
instance_name.xml

Change all occurrences of WC_Enterprise_App_instance_name.ear to
WebSphere_Commerce_Enterprise_Application_-_instance_name.ear.

9. Enter the following command:
GenPluginCfg.bat -adminNodeName node_name
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Where node_name is the short logical name of the node.
10. Open the following file in a text editor:

drive:\WebSphere\AppServer\config\plugin-cfg.xml

11. Add the following line directly below <Config> in the plugin-cfg.xml
file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

12. Copy the plugin-cfg.xml file to your Web server machine (Machine A)
and to Machine D.

13. Restart your Web server (Machine A).
14. Open the WebSphere Application Server Administration Console, and

start the Server Group.

Vertical cloning

Vertical cloning refers to the practice of defining multiple clones of an
application server on the same physical machine. Experience has shown that a
single application server, which is implemented by a single JVM process,
cannot always fully utilize the CPU power of a large multiprocessor machine.
Vertical cloning provides a straightforward mechanism to create multiple JVM
processes, that together can fully utilize all the processing power available.

To configure a vertical clone, do the following:
1. Open the WebSphere Application Server Administration Console.
2. To create the WebSphere Commerce clone, do the following:

a. Expand WebSphere Administrative Domain → Nodes → host_name →
Application Servers.

b. Select WebSphere Commerce Server → instance_name and right-click.
Select Stop.

c. Right-click on WebSphere Commerce Server → instance_name and select
Create Server Group (unless a Server Group has already exists).

d. Enter the Server Group name (for example, WebSphere Commerce
Server Group), and click OK.

e. Expand the WebSphere Administrative Domain → Server Groups.
f. Right-click on the new Server Group (for example, WebSphere

Commerce Server Group), and select New → Clone.
g. Enter a name for the cloned application server.
h. Click Create.

3. Regenerate your WebSphere Application Server plug-in. To regenerate the
plug-in, do the following:
a. Open a command window and change to the following directory:
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drive:\WebSphere\AppServer\bin

b. Enter the following command:
GenPluginCfg.bat -adminNodeName node_name

Where node_name is the short logical name of the node.
c. Stop the WebSphere Application Server.
d. Open the following file in a text editor:

drive:\WebSphere\AppServer\config\plugin-cfg.xml

e. Add the following line directly below <Config> in the plugin-cfg.xml
file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

Note: If you are using a remote Web server, copy the plugin-cfg.xml
from your WebSphere Application Server, to your Web server
machine.

f. Restart your Web server.
4. Start the WebSphere Application Server.
5. Open the WebSphere Application Server Administration Console.
6. Expand WebSphere Administrative Domain → Server Groups →

server_group_name.
7. Right-click the server group, and select Start.
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Part 4. Optional Configurations

This section contains information on how to use advanced configuration
options with WebSphere Commerce. The following topics are covered:
v Chapter 11, “Creating a store from a sample store archive” on page 125
v Chapter 12, “Enabling SSL for production with IBM HTTP Server” on

page 131
v Chapter 13, “Enabling WebSphere Application Server security” on page 135
v Chapter 14, “Single sign-on” on page 143

For a production server, chapters Chapter 5, “Installing IBM WebSphere
Payment Manager 3.1.2” on page 39 and Chapter 12, “Enabling SSL for
production with IBM HTTP Server” on page 131 must be completed. All other
chapters are optional depending on your needs.

© Copyright IBM Corp. 1996, 2002 123



124 Installing WebSphere Commerce for use with a DB2 Database



Chapter 11. Creating a store from a sample store archive

This chapter guides you through the process of creating a sample store from
one of the store archives provided with WebSphere Commerce. For
information on additional store creation methods and store customization,
refer to the WebSphere Commerce online help.

In WebSphere Commerce, the fastest and easiest way to create an online store
is to use one of the sample stores provided with WebSphere Commerce and
the browser-based tools available in Store Services. Sample stores are provided
as store archives.

A store archive is a compressed file that contains all the assets necessary
(including Web and database assets) to create a store. In order to create your
own store, you create a new store archive based on one of the sample store
archives, using the tools in Store Services. Since your new store archive is
based on the sample store archive, it is an exact copy of the assets in the
sample store archive, saved under a new file name and directory structure.

At this point you have two options. You can publish the store archive to the
commerce server to create a functional store based on one of the sample
stores, or you can make changes to your new store archive first and then
publish it to the server.

To change the database information in the store archive, edit the assets
directly or use the tools in Store Services: the Store Profile notebook, the Tax
notebook and the Shipping notebook.

To change the Web assets (store pages) contained in the store archive or to
create new Web assets, use the tools in WebSphere Commerce Studio, or tools
of your choice.

For more information on store creation, see the IBM WebSphere Commerce Store
Developer’s Guide.

To create a store using one of the sample stores, do the following:
1. Create a store archive.
2. Publish a store archive.

© Copyright IBM Corp. 1996, 2002 125



Creating a store archive

To create a store archive using one of the sample stores, do the following:
1. Ensure the following services are running:

v DB2-DB2
v DB2-DB2DAS00
v IBM WS AdminServer 4.0
v Websphere Commerce Server – instance_name

v Any Web server related services

Note: To ensure that the WebSphere Commerce Server instance_name is
running check the WebSphere Application Server Administration
Console.

2. Ensure the Payment Manager Application Server is started in the
WebSphere Application Server Administration Console.

3. Start Payment Manager by doing the following:
a. Open a command window and change directory to the directory

where IBM Payment Manager is installed.
b. Enter the following command:

IBMPayServer

If Payment Manager is installed remotely from your Web server, start
it using the following command:
IBMPayServer -pmhost fully_qualified_Web_server_host_name

You are prompted to enter your Payment Manager password. This is the
password of the user you specified to use when connecting to the
Payment Manager database.

4. From the Start menu, select Programs → IBM WebSphere Commerce →
Store Services. The Store Services Logon page displays. Enter your
Instance Administrator user ID and password and click Log on. You will
be asked to change your password the first time you log in.

5. The Create Store Archive page displays. In the Store archive field, type
the name of your store archive. The extension .sar is added to the name
you type, for example, Mystore.sar. This name becomes the filename for
the store archive. When you finish creating your store archive, it is saved
in the following location:
drive:\WebSphere\CommerceServer\instances\instance_name\sar

6. In the Store directory field, type the directory name for your store. The
directory name defines the directory to which the web assets will be
published on the server. When the store archive is published, it will be
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published to the store directory defined here by default. For example, if
you enter the directory name ″Mystore″ in the Store directory field, the
following directory is created:
drive:\WebSphere\AppServer\installedApps\WC_Enterprise_App_
instance_name.ear\wcstores.war\Mystore

7. Business From the Store owner drop-down list, select the organization
that owns the store, for example Seller Organization.

Note: The Default Organization is available for customers who do not
have a buying organization. Do not select the default organization
as your store owner.

8. From the View drop-down list, select which sample store you would like
to view.

9. From the Sample list box, select the store archive on which you will base
your store. A description of the sample displays in the Sample
description box. To view the sample store first, click Preview.

10. Click OK.
11. A dialog box opens informing you that your store archive was created

successfully. Click OK.
12. The Store Archive list displays. Note that the store archive you created

displays in the list and that the name in the Store name field is the same
as the name of the sample store. You can change this name using the
Store Profile notebook.

You have now created a new store archive, based on a sample store. As a
result, the new store archive contains all of the same information as the
sample store. When you are creating your own store, you will want to change
this information. For more details on changing this information, see the
WebSphere Commerce online help and the IBM WebSphere Commerce Store
Developer’s Guide. For the purpose of this guide, do not change this
information now.

Publish a store archive

Publishing a store archive to a WebSphere Commerce Server allows you to
create a running store. You have two options for publishing a store archive:
v Publish a store archive from Store Services
v Publish a store archive from the command line

This section will only cover publishing from Store Services. Additional
information on publishing is available in the WebSphere Commerce online
help and IBM WebSphere Commerce Store Developer’s Guide.
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Publish a store archive from Store Services
Publishing a store archive to a WebSphere Commerce Server allows you to
create a running store. To publish a store archive, complete the following
steps:
1. Ensure the following services are running:

v DB2-DB2
v DB2-DB2DAS00
v IBM WS AdminServer 4.0
v Websphere Commerce Server – instance_name

v Any Web server related services

Note: To ensure that the WebSphere Commerce Server instance_name is
running check the WebSphere Application Server Administration
Console.

2. Ensure the Payment Manager Application Server is started in the
WebSphere Application Server Administration Console.

3. If Payment Manager is not running, start IBM Payment Manager, by
doing the following:
a. Open a command window and change directory to the directory

where IBM Payment Manager is installed.
b. Enter the following command:

IBMPayServer

If Payment Manager is installed remotely from your Web server, start
it using the following command:
IBMPayServer -pmhost fully_qualified_Web_server_host_name

You are prompted to enter your Payment Manager password. This is the
password of the user you specified to use when connecting to the payman
database.

4. Ensure that you have Site Administrator or Store Administrator access. If
you have Store Administrator access, ensure that the access is for all
stores.

5. From the Store Archive list in Store Services, select the check box beside
the store archive you want to publish.

6. Click Publish. The Publish Store Archive page displays.
7. Select your desired publishing options. For more information on

publishing options, click Help.

Note: To create a fully functional store, select all publishing options,
including the product data option, the first time you publish a
store archive.
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8. Click OK. While the store publishes you are returned to the Store
Archive list page. The publishing state is reflected in the Publish status
column. Depending on the speed of your system, it may take several
minutes to complete the publishing process. Click Refresh to update the
status.

9. Select the store archive from the list and click Publish Summary to see
the results of the publish.

10. If your Web server is remote from your WebSphere Commerce machine,
copy over the contents of the following directory, including sub
directories, from the WebSphere Commerce machine to the Web server
machine:
drive:\WebSphere\AppServer\installedApps\

WC_Enterprise_App_instance_name.ear\wcstores.war\Mystore

On your Web server machine, delete all the JSP files within this directory.
11. When publishing is complete, click Launch Store to view and test your

store. When you have finished, bookmark the site and close the browser.

Compiling the JavaServer Pages files
Compiling the JavaServer Pages files will significantly reduce the amount of
time needed to load the load your store. To batch compile JavaServer Pages
(JSP) files, do the following on your WebSphere Commerce machine:
1. From a command prompt, switch to

drive:\WebSphere\CommerceServer\bin.
2. Run the following command:

WCSJspBatchCompiler -enterpriseApp "WebSphere
Commerce Enterprise Application - instance_name"

-webModule "WCS Stores" -nameServerHost "short_hostname"
-nameServerPort 900

Several errors may be logged when you perform these compiles. These may
be safely ignored

Important:

v Only one store archive can be published at a time. Concurrent publishing is
not supported and may cause the publish of both stores to fail.

v During publish, the consistency checker confirms that the files referenced
by the store archive exist. If the consistency check finds an error, the error
will be written to the log. Publishing continues as normal.

v Before republishing a store, delete the files from following directory:
drive:\WebSphere\CommerceServer\instances\instance_name\cache.
While in the store development phase, you should disable caching. To do
this, open the Caching panel of the Configuration Manager, and ensure that
Enable Cache is deselected.
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v When you launch the store from Store Services, you are logged into the
store with the same user name and password that you used to log into
Store Services. If you change your password in the store, you are also
changing it for that user. Instead, to test the features in the store, including
changing your password, bookmark the site, close the browser, then log on
to the store again. You can also launch your store by entering the following
URL in a browser:
https://host_name/webapp/wcs/stores/servlet/store_directory/index.jsp

Placing a test order at your store
To place a test order at your store, do the following:
1. Open your store by doing the following:

a. In the Store Services window, select your store and click Publish
Summary.

b. On the Publish Summary screen, select Launch Store.
c. A window opens asking for the Web application Web path for the

store. Enter the appropriate path (the default is /webapp/wcs/stores).
d. Bookmark your store’s location in your Web browser.
e. Close all of your existing Web browsers, and open a new Web browser.
f. Navigate to your Store’s home page.

2. On the home page, select product. On the product page click Add to
shopping cart.

3. Complete the order process. For testing purposes you can use the credit
card number 0000000000000000 (16 zeros) for VISA. An order confirmation
page displays, confirming that your order is complete.
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Chapter 12. Enabling SSL for production with IBM HTTP
Server

After you create your WebSphere Commerce instance with IBM HTTP Server,
SSL is enabled for testing purposes. Before you open your site to shoppers,
you must enable SSL for production by following the steps in this chapter.

About security

IBM HTTP Server provides a secure environment for your business
transactions by using encryption technology. Encryption is the scrambling of
information transactions on the Internet so that they cannot be read until they
are unscrambled by the receiver. The sender uses an algorithmic pattern or
key to scramble (encrypt) a transaction, and the receiver uses a decryption
key. These keys are used by the Secure Sockets Layer (SSL) protocol.

Your Web server uses an authentication process to verify the identity of the
person with whom you are conducting business (that is, to make sure they are
whom they say they are). This involves obtaining a certificate signed by a
trusted third party called a certification authority (CA). For IBM HTTP Server
users, the CA may be Equifax® or VeriSign® Inc. Other CAs are available as
well.

To create a production key file, complete the following steps:
1. Create a security key file for production.
2. Request a secure certificate from a certifying authority.
3. Set your production key file as the current key file.
4. Receive the certificate and test the production key file.

These steps are described in detail below.

Notes:

1. If you are already using a production key file signed by a certifying
authority, you may be able to skip these steps. Read this chapter to make
this determination.

2. As you perform these steps, your browser may display security messages.
Review the information in each message carefully and decide how to
proceed.
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Create a security key file for production

To create a security key file for production, do the following on your web
server machine:
1. Stop the IBM HTTP Server as described in “Starting and Stopping IBM

HTTP Server” on page 148.
2. Change directory to drive:\WebSphere\HTTPServer\conf.
3. Create a backup copy of httpd.conf.
4. Open httpd.conf in a text editor.
5. Ensure that the following lines are uncommented for port 443:

a. #LoadModule ibm_ssl_module modules/IBMModuleSSL128.dll

b. #Listen 443

c. #<VirtualHost host.some_domain.com:443>. You must also substitute
your fully qualified host name in this line.

d. #SSLEnable

e. #</VirtualHost>

f. Keyfile ″drive:/WebSphere/HTTPServer/ssl/keyfile.kdb″.
6. Ensure that the following lines are uncommented for port 8000:

a. #Listen 8000

b. #<VirtualHost host.some_domain.com:8000>. You must also substitute
your fully qualified host name in this line.

c. #SSLEnable

d. #</VirtualHost>

7. Save your changes.
8. To ensure that your httpd.conf file does not contain syntax errors, change

to the drive:\WebSphere\HTTPServer directory and run the following
command:
apache -t

9. Start the IBM HTTP Server as described in “Starting and Stopping IBM
HTTP Server” on page 148.

Request a secure certificate from a certifying authority

To validate the security key file that you just created in the previous step, you
need a certificate from a certifying authority (CA) such as Equifax or VeriSign.
The certificate contains the server’s public key, the Distinguished Name
associated with the server’s certificate, and the serial number and expiration
date of the certificate.

If you want to use a different CA, contact it directly for information on the
procedure to follow.
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Equifax users
To request a secure server certificate from Equifax, refer to the following Web
address and follow the instructions provided:
http://www.equifax.com

You should receive the secure server certificate through E-mail from Equifax
in 2 to 4 business days.

VeriSign users
To request a secure server certificate from VeriSign, refer to the following URL
and follow the instructions provided:
http://www.verisign.com

Follow the instructions provided. Once you submit your request, your
certificate should arrive within three to five working days. When you receive
it, create the production key file as described in the previous section, if you
have not already done so.

Receive and set your production key file as the current key file

After the certificate arrives from the CA, you must make the Web server use
your production key file. Perform the following steps:
1. Copy the certificatename.kdb, certificatename.rdb, and

certificatename.sth files you received from the certificate authority into
the drive:\WebSphere\HTTPServer\ssl directory, where certificatename is
the certificate name you supplied with your certificate request.

2. Stop the IBM HTTP Server as described in “Starting and Stopping IBM
HTTP Server” on page 148.

3. Open the Key Management Utility (ikeyman).
4. Open the certificatename.kdb file, and enter your password when

prompted.
5. Select Personal Certificates, and click Receive.
6. Click Browse.
7. Select the folder where you have stored the files you received from the

certificate authority. Select the certificatename.txt file and click OK.
8. The Personal Certificates list box should now list either VeriSign

certificatename certificate or Equifax certificatename certificate.
9. Exit the Key Management Utility.

10. Change directory to drive:\WebSphere\HTTPServer\conf.
11. Create a backup copy of httpd.conf.
12. Open httpd.conf in a text editor.
13. Ensure that the lines listed in step 5 on page 132 are not commented.
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14. Search for Keyfile "drive:/IBM/IBM HTTP SERVER/ssl/keyfile.kdb", and
change the path name to point to the file created in the above steps.

15. Restart the IBM HTTP Server as described in “Starting and Stopping IBM
HTTP Server” on page 148.

Test the production key file

To test the production key, do the following:
1. Go the following URL with your browser:

https://host_name

Notes:

a. If you have customized your Web server, you may need to type the
name of the Web server’s front page after the host name.

b. Be sure to type https, not http.

If your key is defined correctly, you will see several messages about your
new certificate.

2. On the New Site Certificate panel, if you want to accept this certificate,
select the Accept this certificate forever (until it expires) radio button.

3. From your Web browser, restore your caching and proxy (or socks) server
settings to their original states.

You have now enabled SSL on your server.
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Chapter 13. Enabling WebSphere Application Server
security

This chapter describes how to enable security for WebSphere Application
Server. Enabling WebSphere Application Server security prevents all
Enterprise JavaBean components from being exposed to remote invocation by
anyone.

Note: When enabling WebSphere Application Server security it is strongly
recommended that your machine meets the following requirements:
v A minimum machine memory of 1 GB.
v A minimum heap size of 384 MB, for the WebSphere Commerce

application.

Before you begin

Before you begin to enable security, you will need to know how the
WebSphere Application Server you are enabling security on validates user IDs.
WebSphere Application Server can use either LDAP or the operating system’s
user registry as the WebSphere Application Server user registry.

Enabling security with an LDAP user registry

To enable WebSphere Application Server security when you are using LDAP
as the WebSphere Application Server user registry, log into the system as a
user with administrative authority and do the following steps:
1. Start the WebSphere Application Server Administration Server and open

the WebSphere Application Server Administrator’s Console.
2. In the Console, modify the global security settings as follows:

a. From the Console menu, select Security Center.
b. On the General tab, select the Enable Security.
c. On the Authentication tab, select Lightweight Third Party

Authentication (LTPA). Fill in the LTPA settings, and uncheck the
Enable Single Sign On check box if you do not want to use this
functionality. Fill in the LDAP Settings tab as follows, depending on
the type of directory server you are using:
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Table 6. SecureWay Users

Field Name Definition Sample Values Notes

Security Server ID User ID user_ID v This must not be
the LDAP
administrator.

v Do not use a user
that has been
specified as
cn=xxx.

v Ensure that the
objectclass of this
user is
compatible with
the objectclass
specified in the
User Filter field
of the LDAP
Advanced
Properties
window.

Security Server
password

User Password password

Host Host name of the
LDAP server

hostname.domain

Directory Type Type of LDAP
server

SecureWay

Port Port that the LDAP
server is using

Base Distinguished
Name

Distinguished
Name under which
searching occurs

o=ibm,c=us

Bind Distinguished
Name

Distinguished
Name for binding
to the directory
when searching

This field is not
required

Bind Password Password for the
Bind Distinguished
Name

This field is not
required
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Table 7. Netscape Users

Field Name Definition Sample Values Notes

Security Server ID User ID user_ID v This must not be
the LDAP
administrator.

v Do not use a user
that has been
specified as
cn=xxx.

v Ensure that the
objectclass of this
user is
compatible with
the objectclass
specified in the
User Filter field
of the LDAP
Advanced
Properties
window.

Security Server
password

User Password password

Host Host name of the
LDAP server

hostname.domain

Directory Type Type of LDAP
server

Netscape

Port Port that the LDAP
server is using

This field is not
required

Base Distinguished
Name

Distinguished
Name under which
searching occurs

o=ibm

Bind Distinguished
Name

Distinguished
Name for binding
to the directory
when searching

This field is not
required

Bind Password Password for the
Bind Distinguished
Name

This field is not
required
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Table 8. Active Directory Users

Field Name Definition Sample Values Notes

Security Server ID sAMAccountName user_ID v User Logon
Name of any
ordinary user.

v Do not use a user
that has been
specified as
cn=xxx.

v Ensure that the
objectclass of this
user is
compatible with
the objectclass
specified in the
User Filter field
of the LDAP
Advanced
Properties
window.

Security Server
password

User Password password

Host Host name of the
LDAP server

hostname.domain

Directory Type Type of LDAP
server

Active Directory

Port Port that the LDAP
server is using

This field is not
required

Base Distinguished
Name

Distinguished
Name under which
searching occurs

CN=users,
DC=domain1,
DC=domain2,
DC=com

Bind Distinguished
Name

Distinguished
Name for binding
to the directory
when searching

CN=user_ID,
CN=users,
DC=domain1,
DC=domain2,
DC=com

The user_ID value is
the Display Name.
This is not
necessarily the same
as the User Logon
Name.

Bind Password Password for the
Bind Distinguished
Name

bind_password This should be the
same as the Security
Server Password.

d. On the Role Mapping tab, select WebSphere Commerce Enterprise
Application and click Edit Mappings.
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1) Select the WCSecurityRole and click the Select button.
2) Select the Select users/groups check box, enter the user ID that was

used in step 2c on page 135 into the Search field, and click Search.
Select that user from the Available Users/Groups list and click Add
to add it to the Selected Users/Groups list. Then click OK on each
panel until you exit the Security Center.

e. The first time you select LTPA as the user registry, you will be
prompted for an LTPA password. Enter a password for LTPA.

3. Open the WebSphere Commerce Configuration Manager and select
Instance List → instance_name → Instance Properties→ Security and select
the Enable Security check box. Select Operating System User Registry for
the authentication mode, and enter the user name and password that you
entered in step 2c on page 135. Click Apply then exit Configuration
Manager.

4. Stop and restart the WebSphere Application Server administration server.
From now on, when you open the WebSphere Application Server
Administrator’s Console, you will be prompted for the Security Server ID
and password.

Enabling security with an operating system user registry

To enable WebSphere Application Server security when you are using the
operating system user validation as the WebSphere Application Server user
registry, log in as a user with administrative authority and do the following
steps:
1. In the WebSphere Application Server Administration Console, modify the

global security settings as follows:
a. From the Console menu, select Security Center.
b. On the General tab, select the Enable Security checkbox.

2. Select the Authentication tab and select the Local Operating System radio
button

3. Enter your security server ID in the Security Server ID field. Enter the
user name you as follows:

Table 9.

Field Name Sample Values Notes
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Table 9. (continued)

User ID user_ID The user ID with operating
system administrative
privileges that you logged
in with. If the machine
belongs to a domain, use
the fully-qualified user ID.
For example:
DomainXYZ\user_id.
Ensure that this account
exists in the domain server
and is a member of the
Administrator’s group.

Security Server Password password This is the password
belonging to the user with
operating system
administrative privileges
that you logged in with.

4. On the Role Mapping tab, select the WC enterprise application and click
the Edit Mappings button.
a. Select the WCSecurityRole and click the Select button.
b. Select the Select users/groups check box, enter the user ID that was

used in step 3 on page 139 into the Search field, and click Search.
Select that user from the Available Users/Groups list and click Add to
add it to the Selected Users/Groups list. Then click OK on each panel
until you exit the Security Center.

5. Open the WebSphere Commerce Configuration Manager and select
Instance List → instance_name → Instance Properties→ Security and select
the Enable Security check box. Select Operating System User Registry for
the authentication mode, and enter the user name and password that you
entered in step 3 on page 139. Click Apply then exit Configuration
Manager.

6. Stop and restart the WebSphere Application Server administration server.
From now on, when you open the WebSphere Application Server
Administration Console, you will be prompted for the Security Server ID
and password.

Disabling WebSphere Commerce EJB security

WebSphere Commerce allows you to disable EJB security. To disable
WebSphere Commerce EJB Security, do the following:
1. Start the WebSphere Application Server Administration Console.
2. Click Console → Security Center and deselect the Enable Security check

box on the General tab.
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3. Open the WebSphere Commerce Configuration Manager and select
Instance List → instance_name → Instance Properties→ Security and clear
the Enable Security check box.

4. Stop and restart the WebSphere Application Server administration server.

WebSphere Commerce security deployment options

WebSphere Commerce supports various security deployment configurations.
The following table illustrates the security deployment options available to
you.

Table 10. Single machine security scenarios

WebSphere Application Server security is
enabled.

v Use the operating system as the
WebSphere Application Server registry.

v Use the database as the WebSphere
Commerce registry.

v Use LDAP as the WebSphere
Application Server registry.

v Use LDAP as the WebSphere
Commerce registry.

v Use LDAP as the WebSphere
Application Server registry.

WebSphere Application Server security is
disabled, and your WebSphere Commerce
site is located behind a firewall.

v A WebSphere Application Server
registry is not required.

v Use the database as the WebSphere
Commerce registry.

v A WebSphere Application Server
registry is not required.

v Use LDAP the WebSphere Commerce
registry.
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Table 11. Multiple machine security scenarios

WebSphere Application Server security is
enabled. LDAP is always deployed.

v Use LDAP as the WebSphere
Application Server registry.

v Use LDAP as the WebSphere
Commerce registry.

v Use LDAP as the WebSphere
Application Server registry.

v Use a database as the WebSphere
Commerce registry.

v You will need to set up LDAP, and
place one administrative entry into the
LDAP registry.

WebSphere Application Server security is
disabled, and your WebSphere Commerce
site is located behind a firewall.

v Use a database as the WebSphere
Commerce registry.

v A WebSphere Application Server
registry is not required.

v Single sign-on is not supported.

v Use LDAP as the WebSphere
Application Server registry.

v A WebSphere Application Server
registry is not required.

Note: If you operate your WebSphere Commerce site from behind a firewall,
you can disable WebSphere Application Server security. You should
only disable WebSphere Application Server security if you are sure that
no malicious applications are running behind the firewall.
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Chapter 14. Single sign-on

This chapter outlines how to set up single sign-on for WebSphere Commerce.
For more information on single sign-on, see the IBM WebSphere Commerce
Security Guide, Version 5.4.

Prerequisites

To enable single sign-on, you must meet the following requirements:
v There must be an existing LDAP server installed and configured. To

configure an LDAP server see the IBM WebSphere Commerce Version 5.4
Additional Software guide.

v WebSphere Commerce must be installed and configured.
v WebSphere Application Server security must be enabled. To enable

WebSphere Application Server security see Chapter 13, “Enabling
WebSphere Application Server security” on page 135.

Enabling single sign-on

Limitations and Prerequisites
There are several key limitations of single sign-on when it is used with
WebSphere Commerce. These limitations are:
v The LPTA cookies may flow across different web server ports.
v You may need to modify the ldapentry.xml file and add the object

class ePerson. That is as an attribute of ldapocs element.
v You need to modify the instance.xml and ensure that migration is

″on″ for user in the LDAP component.
v The machines participating in the single sign-on configuration must

have their system clocks synchronized.
v Single sign-on is only supported between applications that can read

and issue the WebSphere Application Server Light Weight Third Party
Authentication (LTPA) token.

To enable single sign-on you must do the following:
1. Enable single sign-on within the WebSphere Application Server. For more

information, search for ″single sign-on″ in the WebSphere Application
Server InfoCenter available at:
http://www.ibm.com/software/webservers/appserv/doc/v40/ae

/infocenter/index.html
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Select Single Sign-On: WebSphere Application Server and complete the
following sections:
v Configuring SSO for WebSphere Application Server.

– Modify WebSphere Application Server security settings.

Note: The step that details how to fill in the LDAP fields can be
safely ignored.

– Export the LTPA keys to a file.
2. On your WebSphere Commerce machine, start the WebSphere Commerce

Configuration Manager.
3. To configure the Member Subsystem node, do the following:

a. Expand WebSphere Commerce → host_name → Instance List →
instance_name → Instance Properties → Member Subsystem.

b. In the Authentication Mode drop-down menu, select LDAP.
c. Enable the Single sign-on checkbox.
d. In the Host field, enter the fully qualified host name of your LDAP

server.
e. Enter the administrator’s distinguished name in the Administrator

Distinguished Name field. This should be the same name that was
used on your LDAP server.

f. In the Administrator Password field, enter the administrator’s
password. This should be the same password that was used on your
LDAP server. Confirm the password in the Confirm Password field.

g. Complete each of the remaining fields.
h. Click Apply, then click OK.

4. Restart the WebSphere Application Server.
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Part 5. Appendixes
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Appendix A. Starting and Stopping Components

At various times during the installation process you will be required to start
and stop components of WebSphere Commerce. Please follow the instructions
below to start and stop the components successfully. To start and stop
Oracle8i Database, iPlanet Web Server, or Microsoft IIS, please refer to the
documentation that accompanies these products.

Opening the Windows Services panel

Some WebSphere Commerce components run as Windows services. In order
to start and stop these components, you will need to open the Windows
Services panel.

To open the Windows Services panel in Windows NT, do the following:
1. Select Start → Settings → Control Panel.
2. On the Control Panel window, double-click the Services icon.

To open the Windows Services panel in Windows 2000, select Start → Settings
→ Control Panel → Administrative Tools → Services.

Starting and Stopping the WebSphere Commerce Server

To start or stop your WebSphere Commerce instance, do the following:
1. Ensure that your database management system is started. Refer to

“Starting and Stopping DB2 Universal Database” on page 149.
2. While logged on to a Windows user ID with Administrator authority,

launch the WebSphere Application Server Administration Console.
3. Expand WebSphere Administrative Domain.
4. Expand Nodes.
5. Expand Application Server.
6. Expand your node_name.
7. Select WebSphere Commerce Server —instance_name and right-click. Select

Start or Stop as appropriate.

Starting and Stopping WebSphere Application Server

To start WebSphere Application Server do the following:
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1. While logged in as a Windows user ID with Administrator authority, open
the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM WS AdminServer.
3. Click Start.

To stop WebSphere Application Server do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM WS AdminServer.
3. Click Stop.

Starting and Stopping IBM HTTP Server

To start IBM HTTP Server, do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM HTTP Server.
3. Click Start.

To stop IBM HTTP Server, do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM HTTP Server.
3. Click Stop. When asked to confirm that you want to stop the service, click

Yes.

Starting and Stopping the WebSphere Commerce Configuration Manager

To start the WebSphere Commerce Configuration Manager server, do the
following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM WC Configuration Manager Server.
3. Click Start.

To stop the IBM WebSphere Commerce Configuration Manager Server, do the
following:
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1. While logged in as a Windows user ID with Administrator authority, open
the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM WC Configuration Manager Server.
3. Click Stop.

Starting and Stopping the IBM HTTP Administrator

To start the IBM HTTP Administrator, do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM HTTP Administrator.
3. Click Start.

To stop the IBM HTTP Administrator, do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. From the Service list, select IBM HTTP Administrator.
3. Click Stop. When asked to confirm that you want to stop the service, click

Yes.

Starting and Stopping DB2 Universal Database

To start DB2, do the following:
1. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

2. For each service in the Service list that begins with DB2, select the service
and click Start. The DB2–DB2 service must be the first one started.

To stop DB2, do the following:
1. Stop the WebSphere Application Server according to the instructions in

“Starting and Stopping WebSphere Application Server” on page 147.
2. While logged in as a Windows user ID with Administrator authority, open

the Services window. For instructions on opening the Services window,
see “Opening the Windows Services panel” on page 147.

3. For each started service in the Service list that begins with DB2, select the
service and click Stop. When asked to confirm that you want to stop the
service, click Yes. The DB2–DB2 service must be the last one stopped.
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Note: When you stop DB2 Security Server services a window opens
informing you that this will also stop system will stop the
Warehouse logger and Warehouse Server services. Click OK.

Starting and Stopping Payment Manager

After you have installed Payment Manager and restarted your system, start
your database, WebSphere Application Server, and your Web server (if they
are not already started), and then start Payment Manager.

To start WebSphere Payment Manager, do the following:
1. Open the control panel, click Services, and ensure the IBM WS

AdminServer service is started.
2. Start the WebSphere Application Server Administration Console and make

sure the WebSphere Payment Manager Application server is started.
3. Payment Manager requires a password so that it can both connect to the

database and also decrypt any sensitive data that is stored in the database.
Protection of this password is therefore critical to protecting the security of
your payment data. When you start Payment Manager, you must specify
the database password of the user you use to connect to the Payment
Manager database. There are two ways to specify the Payment Manager
password:
v Enter the Payment Manager password directly from the command line.

This method is recommended for optimal security.
v Use a password file to run Payment Manager in unattended operation

mode. This method allows Payment Manager to start when there is no
user present to enter the password.

Starting Payment Manager by entering the password
To start Payment Manager in a one or two-tier environment, open a command
window and change directory to the directory where Payment Manager is
installed. Then, enter the following command:
IBMPayServer

You are prompted to enter your Payment Manager password. This is the
password of the user you specified to use when connecting to the database.

To start Payment Manager in a three-tier environment, open a command
window and change directory to the directory where Payment Manager is
installed. Then, enter the following command:
IBMPayServer -pmhost webserver_hostname

Where webserver_hostname is the fully qualified hostname of your webserver
machine.
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You are prompted to enter your Payment Manager password. This is the
password of the user you specified to use when connecting to the database.

Starting Payment Manager in unattended operation mode
If you need Payment Manager to be startable when there is no user present to
enter the password, you need to create a password file. The default password
file name is .payment and the file should reside in the same directory as the
Payment Manager installation directory. The file should contain a single line
as follows:
DBPassword=yourpassword

To start Payment Manager using this password file, open a command window
and change directory to the Payment Manager installation directory. Then
enter the following command:
IBMPayServer -file

Instead of prompting you for the password, Payment Manager reads the
password directly from the .payment file.

Important
If you use a password file to start Payment Manager, be aware that you
are making it easier for people to penetrate the security of your payment
data. If they can read the password file, they can potentially obtain
access to the database and decrypt the sensitive payment data it
contains. To avoid this security limitation, you can either start Payment
Manager by entering a password every time, or you can take measures
to put extra security on your password file to make sure that no
unauthorized users can read it. However, if you choose to protect the
password file, you must ensure that at least the user who will start
Payment Manager can both read and write to the file.

If you do not want to use the .payment file to start Payment Manager,
you should delete the file from the Payment Manager install directory.
This prevents the exposure of the Payment Manager database password
to unauthorized personnel.

Starting the Payment Manager User Interface
After starting the WebSphere Application Server and Payment Manager, to
start the Payment Manager user interface:
1. Point your web browser to:

http://host_name/webapp/PaymentManager

where host_name is the machine where you installed your Web server.
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Note: As part of the installation, shortcuts are provided on the Windows
Start menu. You can use these shortcuts to login to Payment
Manager. If you configured Payment Manager to use SSL, you can
point your browser to the following URL:
https://host_name/webapp/PaymentManager

2. On the Payment Manager Logon window, enter the Payment Manager
administrator’s user ID and password, and click OK. The default user ID
and password are both wcsadmin.

If you are using Payment Manager with WebSphere Commerce, all WebSphere
Commerce administrators are also Payment Manager users. However, only the
administrator ID wcsadmin has been assigned the Payment Manager
administrator role. In order to log in to the Payment Manager user interface
you must use an administrator ID that has been assigned to one of the four
Payment Manager roles:
v Payment Manager administrator
v Merchant administrator
v Supervisor
v Clerk

For information on the Payment Manager roles, see the Payment Manager
Administrator’s Guide.

To assign Payment Manager roles to other WebSphere Commerce
administrators, log in to the Payment Manager user interface using the
administrator ID wcsadmin and navigate to the Users administration screen.
From there, you could assign any one of the four Payment Manager roles to
other WebSphere Commerce adminstrators listed.

Before using the wcsadmin ID to log in to the Payment Manager user interface,
you must have changed the default password of the ID by logging into the
WebSphere Commerce Administration Console using the wcsadmin ID. At that
time, you will be asked to change the password.

You can also access the Payment Manager administration functions from the
WebSphere Commerce Administration Console.

Stopping the Payment Manager
To stop the Payment Manager, you need to:
v Stop Payment Manager
v Stop the Payment Manager application server under WebSphere Application

Server
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Stopping Payment Manager with the StopIBMPayServer command
To stop Payment Manager, open a command window and change directory to
the directory where you installed Payment Manager. Then enter the following
command:
StopIBMPayServer

You will be prompted to enter your Payment Manager password. This is the
password of the user you specified to use when connecting to the database.

Stopping Payment Manager in unattended operation mode
If you need to stop Payment Manager when there is no user present to enter
the password, you need a password file. To stop Payment Manager using this
file, open a command window and change directory to the Payment Manager
installation directory. Then, enter the following command:
StopIBMPayServer -file

Stopping Payment Manager Servlets Using WebSphere Application
Server
When using WebSphere Application Server 4.0.2, you can stop all servlets by
stopping the WebSphere Payment Manager application server. To stop the
WebSphere Payment Manager application server:
1. Go to the WebSphere Application Server Administration Client. Click Start

→ Programs → WebSphere Application Server → Administrator’s Console

2. Select the WebSphere Payment Manager application server.
3. Click Stop next to WebSphere Payment Manager application server.
4. Exit the Administration Client.
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Appendix B. Administrative Tasks

This chapter contains a variety of tasks that an administrative user may have
to perform during the installation and maintenance of WebSphere Commerce.

Changing the Configuration Manager Password

You can change the Configuration Manager password when you launch the
Configuration Manager by clicking Modify in the window where you enter
your user ID and password.

Alternately, to change the Configuration Manager user ID or password type
the following in a command window:
cd drive:\WebSphere\CommerceServer\bin
config_env
java com.ibm.commerce.config.server.PasswordChecker -action [action type]

-pwfile [password file] -userid [user ID]
-password [userid password] [-newpassword [new userid password]]

where action types are Add, Check, Delete or Modify. The parameters are
explained below:

pwfile
The path to the file where the file will be stored. The default path is
drive:\WebSphere\CommerceServer\bin. This parameter is always
required.

userid
Enter the user ID that you want to add, check, delete or modify. This
parameter is always required.

password
Enter the password that you want to create, check, delete or modify. This
parameter must be used in conjunction with the userid parameter. This
parameter is always required.

newpassword
Use this parameter to change the password for a particular user ID. This
parameter must be used in conjunction with the userid and password
parameters. This parameter is required when you specify the action type
Modify.
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Updating a WebSphere Commerce instance

If you want to change any of the configuration settings for your WebSphere
Commerce instance, you can do so from the Configuration Manager.

To update a WebSphere Commerce instance using the Configuration Manager,
do the following:
1. Open Configuration Manager.
2. From the list of instances, select the instance you want to configure and

select the node for which you want to alter the settings. Follow the
guidelines in Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55 to determine which fields you need to
change to update your instance.

3. After you update your instance, click Apply to apply your changes.

Deleting a WebSphere Commerce instance

If you need to remove a WebSphere Commerce instance, complete the
following steps:
1. To back up your exisiting instance_name.xml file, do the following:

a. Switch to the following directory:
drive:\WebSphere\CommerceServer\instances\instance_name\xml

b. Copy the instance_name.xml file to a backup directory.
2. Start the WebSphere Application Server. For instructions on how to start

the WebSphere Application Server see “Starting the WebSphere
Application Server” on page 53.

3. From a command prompt, type the following:
cd drive:\WebSphere\CommerceServer\bin
rmCommerceServer host_name instance_name

Where host_name is the short host name of your machine, and
instance_name is the name of your WebSphere Commerce instance.

4. Delete the WebSphere Commerce instance by doing one of the following:
v In the WebSphere Commerce Configuration Manager, right-click your

instance and select Delete instance. Click Yes to confirm that you want
to delete your instance. Click OK upon notification that your instance
was successfully deleted.

v In a command prompt window, run the command:
cd drive:\WebSphere\CommerceServer\bin
config_client.bat -startCmdLineConfig deleteInstance <instance_name>

5. To drop your WebSphere Commerce database, do the following::
v If you are using DB2 locally, do the following:

a. Open a DB2 Command Window.
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b. Type the following to drop your WebSphere Commerce database:
drop db db_name

Where db_name is the name of the WebSphere Commerce database
that you entered in the Configuration Manager.

v If you are using DB2 remotely, do the following:
a. Open a DB2 Command Window.
b. Type the following to attach your WebSphere Commerce remote

node:
db2 attach to node_name user DB2_admin_ID using DB2_admin_password

Where node_name is the name entered on the Database panel of the
Instance Creation Wizard, DB2_admin_ID is your database
administration ID, and DB2_admin_password is the database
administration password.

c. Type the following to drop your WebSphere Commerce database:
db2 drop db db_name
db2 uncatalog node node_name

Where db_name is the name of the WebSphere Commerce database
that you entered in the Configuration Manager and node_name is the
name of the node you cataloged for for these databases. The default
node name is the short version (that is, not fully qualified) of your
machine’s host name.

v After you have dropped the database, ensure that the following
directory is empty:
drive:\db2inst1_home_dir\sqllib\function\routine\sqlproc\db_name

where db_name is the name of the database you have dropped.
6. Delete the drive:\WebSphere\CommerceServer\instances\instance_name

directory.
7. Delete the following directory:

drive:\WebSphere\sqllib\function\routine\
sqlproc\db_name\schema_name

Other command line configuration tasks

Through the command line you can:
v Update an instance:

config_client -startCmdLineConfig updateInstance <xml_file>

v Delete an instance:
config_client -startCmdLineConfig deleteInstance <instance_name>

v List existing instances:
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config_client -startCmdLineConfig getInstances

v Find information about an instance:
config_client -startCmdLineConfig getInstanceInfo <instance_name>

v Print configuration information for an instance to a file:
config_client -startCmdLineConfig getInstanceConfig

instance_name print_to_file_name

Opening the WebSphere Application Server Administrative Console

To open the WebSphere Application Server Administrative Console, from the
Start menu, select Programs → IBM WebSphere → Application Server V4.0 →
Administrator’s Console.

Adding Port Host Aliases to WebSphere Application Server

Two port host aliases must be added to WebSphere Application Server: the
non-secure server port (port 80) and the secure server port (port 443). The
non-secure port is added automatically. To manually add the secure port host
alias, perform the following steps:
1. Start the WebSphere Application Server Administrative Console.
2. Expand the WebSphere Adminstrative Domain.
3. Select Virtual Host on the left-hand console frame.
4. For a single instance environment, select default_host.
5. Select the General tab.
6. If the port number does not appear in the Alias field, click the Add

button and add the port number.

Note: You must add port 443 if it does not already exist.
7. When done click Apply.
8. Right-click on node_name and select Regen WebServer Plugin

9. If your WebSphere Commerce instance has already been created, you
must do the following:
a. Open the following file in a text editor:

drive:\WebSphere\AppServer\config\plugin-cfg.xml

b. Add the following line directly below in the plugin-cfg.xml file:
<Property name="CacheLibrary" value="drive:\WebSphere\CommerceServer\
bin\wccache.dll" />

10. Restart your Web server, and the WebSphere Application Server.
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Connecting to the IBM HTTP Server Home Page

If you are using IBM HTTP Server, follow the steps below to connect to the
Web server home page.
1. Click Start → Settings → Control Panel.
2. In the Control Panel window, double-click the Services icon.
3. In the Services window, look for the name IBM HTTP Server, and ensure

that the status of the Web server is Started. If it is not started, select the
Web server and click Start.

4. To access the Web server front page, enter the following Web address on
your browser:
http://host_name

If you have customized your Web server, you may be required to type the
name of your Web server’s front page after the host name.

You have now successfully accessed the Web server front page.

Setting Your IBM HTTP Server Administrator Password

To set your IBM HTTP Server administrator password,
1. Switch to the following directory:

drive:\WebSphere\HTTPServer

2. Type the following command:
htpasswd -b conf\admin.passwd user password

where user and password are the user ID and password that you want to
have administrative authority for IBM HTTP Server.

You have now successfully set your IBM HTTP Server administration
password.

Changing Your SSL Key File Password

If you are using IBM HTTP Server, follow the steps below to change your SSL
key file password.
1. Click Start Menu → Programs → IBM HTTP Server → Key Management

Utility.
2. From the Key Database File menu, select Open.
3. Switch to the following directory:

drive:\WebSphere\HTTPServer\ssl
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Your key file (which has the file extension .kdb) should be in this folder. If
not, create a new key file by following the instructions outlined in
Chapter 12, “Enabling SSL for production with IBM HTTP Server” on
page 131.

4. From the Key Database File menu, select Change Password. The Change
Password window displays.

5. Enter your new password, and enable Stash the password to a file.
6. Click OK. Your password has been changed.

You have now successfully changed your SSL key file administration
password.

Cataloging a Remote DB2 Database

Enable the database client/server connection, and catalog the node and the
database on the client by entering the following commands on a DB2
command window from the database client machine:
db2 catalog tcpip node node_name remote host_name server port_num
db2 attach to node_name user db2_user using db2_user_password
db2 catalog db db_name at node node_name

where the variable information is defined as follows:

node_name
A unique name of your choice that DB2 will use to identify the
TCP/IP node. To ensure that your name is unique, you can enter the
following command in a DB2 command window:
db2 list node directory

and look for the name in the response. If the name is not listed, you
can use it as your node name.

host_name
The fully qualified host name of the machine on which the WebSphere
Commerce database resides.

port_num
The port number that identifies the TCP/IP connection. To determine
the port number, do the following from the database server machine:
1. On a DB2 command window on the machine running your

database, enter the following command:
db2 get dbm cfg

and note the value of SVCENAME (which is also identified by the text
TCP/IP Service Name).
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2. On the machine running your database, open the file
drive:\winnt\system32\drivers\etc\services and look for the
line that begins with the name you noted in the previous step. The
port number appears in the second column of the same line (with
the string \tcp appended to it). The default port number for DB2
Universal Database is 50000.

db_name
The name of the database that your WebSphere Commerce instance is
using. This is the name that you entered on the Database tab of the
Configuration Manager.

Changing your WebSphere Commerce Database

To change the database that your WebSphere Commerce instance uses, do the
following:
1. From the Start Menu → Programs → IBM WebSphere Commerce →

Configuration

2. Enter the Configuration manager user ID and password.
3. Right —click the Databases node and select Create Database.

Note: If you are using an Oracle database, you should drop the tablespace
and user then delete the tablespace files for the instance. You must
then create a new tablespace and user before you recreate the
instance.

4. Enter the database information in the available fields. For more
information, see Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.

5. Make sure the Set as active database check box is selected.
6. Select Finish.
7. A Database created successfully message displays. Your WebSphere

Commerce instance is configured to use the new database.

Generating WebSphere Commerce encrypted passwords

WebSphere Commerce allows you to generate encrypted passwords. To
generate encrypted passwords, do the following:
1. Go to the drive:\WebSphere\CommerceServer\bin directory and run the

following script from a command line:
wcs_password.bat password SALT merchant_key

where
v password is the plain text password.
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v SALT is a random string that is used in the generation of an encrypted
password. This is found in the SALT column of the USERREG database
table for the particular user whose password is being updated.

v merchant_key is the merchant key that was entered during instance
creation.

Generating Payment Manager encrypted passwords

WebSphere Commerce allows you to generate encrypted passwords for
Payment Manager. To generate encrypted passwords, do the following:
1. Go to the drive:\WebSphere\CommerceServer\bin directory and run the

following script from a command line:
wcs_pmpassword.bat password SALT

where
v password is the plain text password.
v SALT is a random string that is used in the generation of an encrypted

password. This is found in the SALT column of the USERREG database
table for the particular user whose password is being updated.

Disabling WebSphere Application Server security

To disable WebSphere Application Server security, do the following:
1. Open the WebSphere Application Server Administration Console.
2. Click Console → Security Center and deselect the Enable Security check

box on the General tab.
3. Click Finish.
4. Click OK.
5. Restart the WebSphere Application Server administration server.
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Appendix C. Uninstalling WebSphere Commerce
components

If you encounter problems installing WebSphere Commerce, you may want to
uninstall one or more components and start again. This appendix explains
how to uninstall each component of WebSphere Commerce, and provides
guidance on the reinstall process.

Uninstalling WebSphere Commerce components

Before you uninstall any WebSphere Commerce components, you must do the
following:
1. Delete your WebSphere Commerce instance, as described in “Deleting a

WebSphere Commerce instance” on page 156.
2. Stop the following services:

a. Stop your WebSphere Commerce Configuration Manager Service, as
described in “Starting and Stopping the WebSphere Commerce
Configuration Manager” on page 148.

b. Stop your IBM HTTP Server, as described in “Starting and Stopping
IBM HTTP Server” on page 148.

c. Stop your WebSphere Application Server, as described in “Starting and
Stopping WebSphere Application Server” on page 147.

d. Stop your DB2 Universal Database, as described in “Starting and
Stopping DB2 Universal Database” on page 149.

3. If you created or customized any files in the
drive:\WebSphere\CommerceServer directory or its subdirectories, and you
want to retain them, back them up to a different directory.

4. If you want to uninstall any other WebSphere Commerce components you
must to the following:
v To uninstall the IBM HTTP Server, do the following:

a. If you created or customized any files in the
drive:\WebSphere\HTTPServer directory or its subdirectories, and
you want to retain them, back them up to a different directory.

b. If any IBM HTTP Server windows are open, ensure that you close
them before attempting to uninstall the Web server.

c. If you uninstall IBM HTTP Server, you must also uninstall
WebSphere Application Server.

v To uninstall the WebSphere Application Server, do the following:
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Note: If you have installed WebSphere Application Server to a directory
that contains a space (for example, Program Files) you may
encounter problems uninstalling the WebSphere Application
Server efixes. For more information, see WebSphere Application
Server documentation.

a. If you want to uninstall the WebSphere Application Server you must
also uninstall the IBM HTTP Server.

b. Uninstall IBM WebSphere Payment Manager 3.1.2, before uninstall
the WebSphere Application Server. For more information see
“Uninstalling Payment Manager” on page 166.

v To uninstall the DB2 Universal Database, do the following:
a. If you want to save your database, back it up as described in the

DB2 online information (see “DB2 Universal Database information”
on page 175 for instructions on accessing the DB2 online

information). After you have completed the backup, move the
backed up database to a directory that is not used by WebSphere
Commerce component.

b. Delete all WebSphere Commerce databases, by doing the following:
1) From a DB2 command window, list all databases by typing:

db2 list db directory

2) For each WebSphere Commerce database listed, type the
following command:
db2 drop db db_name

where db_name is the name of the WebSphere Commerce
database.

c. Stop DB2 using the directions in “Starting and Stopping DB2
Universal Database” on page 149. If you are having trouble stopping
services, type db2 force applications all in a DB2 command
window.

d. If you created or customized any files in the drive:\IBM\Sqllib or
drive:\Db2 directories or their subdirectories, and you want to retain
them, back them up to different directories.

5. To uninstall WebSphere Commerce, DB2 Universal Database, WebSphere
Application Server, or IBM HTTP Server, do the following:
a. While logged on to a Windows user ID with Administrator authority,

click Start > Programs > IBM WebSphere Commerce > Uninstall
WebSphere Commerce Server.

b. The Information window displays. Click OK to continue.
c. An uninstall panel opens. Select the components that you want to

uninstall, and click Remove.
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d. The Confirmation window displays. Click Yes to continue or No to
cancel.

e. A window opens asking you to confirm that you want to uninstall.
Click Yes.

f. When the uninstall program has completed, restart your machine.
g. Once the uninstall is complete, proceed to “Post uninstall steps”.

Post uninstall steps

There are several uninstall steps that must be completed depending on the
products that you have uninstalled. To complete the uninstall process you
must do the following:
1. Delete the drive:\WebSphere\CommerceServer along with all its

subdirectories and files.
2. If you have uninstalled any other WebSphere Commerce components you

must to the following:
v If you have uninstalled the IBM HTTP Server, do the following:

a. Delete the drive:\WebSphere\HTTPServer directory, along with all its
subdirectories and files (if not done for you during the uninstall
process).

v If you have uninstalled the WebSphere Application Server, do the
following:
a. If you have not uninstalled your database software, remove your

WebSphere Application Server database by doing the following:

DB2 Type the following in a DB2 command window:
db2 drop db db_name

where db_name is the name of your WebSphere Application
Server database. The default name if the database was
created automatically is WAS.

b. Remove the drive:\WebSphere\AppServer directory.
c. Remove the

drive:\WebSphere\sqllib\function\routine\sqlproc\db_name
directory.

Note: Any changes and customization you made to your Web server
configuration file before installing WebSphere Application Server
reside in a backup configuration file. To make these settings
active again, you must transfer them from the backup file into the
active Web server configuration file when you reinstall your Web
server.
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v If you have uninstalled DB2 Universal Database, do the following:
a. Switch to the drive\winnt directory and delete any DB2-related files,

including db2*.*.
b. Remove the following directories:

– drive:\DB2

– drive:\DB2CTLSV

– drive:\WebSphere\sqllib

3. Empty the Recycle Bin.
4. Continue uninstalling components or reinstall WebSphere Commerce as

described in “Reinstalling WebSphere Commerce and its Components”.

Uninstalling Payment Manager

To uninstall IBM Payment Manager 3.1.2, refer to your IBM WebSphere
Payment Manager for Multiplatforms Install Guide. For details on where to find
this document, refer to “Payment Manager information” on page 174.

Reinstalling WebSphere Commerce and its Components

If you are reinstalling the entire WebSphere Commerce package follow the
instructions in Part 1, “Installing WebSphere Commerce 5.4” on page 1.

If you are reinstalling portions of WebSphere Commerce, follow these general
rules:
v Install all components through the WebSphere Commerce install program.

To do this insert the WebSphere Commerce Professional Edition CD and
double-click setup.exe.

v Uninstall all the components that you want to uninstall, and then reinstall
them all (rather than uninstalling and reinstalling one component at a time).

v You cannot uninstall and reinstall your Web server without uninstalling and
reinstalling WebSphere Application Server.

v You will need to delete and recreate your instance following the
instructions in Chapter 7, “Creating or modifying an instance with
Configuration Manager” on page 55.
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Appendix D. Troubleshooting

This appendix is divided into two sections:
v Downloadable tools
v Log files and how to use them
v Specific troubleshooting steps

Downloadable tools

WebSphere Commerce Installation and Configuration Checker
WebSphere Commerce Installation and Configuration Checker, or IC Checker
is a standalone, downloadable problem determination tool, which enables
users to verify the installation and configuration of WebSphere Commerce. IC
Checker gathers configuration data and logs, and performs simple
error-checking. The following are some details pertaining to WebSphere
Commerce IC Checker:
v Products currently supported include WebSphere Commerce Suite 5.1 Start

and Pro, WebSphere Commerce 5.1 Business Edition, and WebSphere
Commerce 5.4 Pro, and Business Edition.

v Platforms currently supported are Windows NT 4.0, Windows 2000, AIX,
Solaris, and OS/400.

v The tool can be accessed and downloaded online from the following URL
locations:

Business

www.ibm.com/software/webservers/commerce/whats_new_support.html
www.ibm.com/software/webservers/commerce/wc_be/support-tools.html

Professional

www.ibm.com/software/webservers/commerce/whats_new_support.html
www.ibm.com/software/webservers/commerce/wc_pe/support.html

Log files

WebSphere Commerce produces the following logs:

WASConfig.log
Found in your
drive:\WebSphere\CommerceServer\instances\instance_name\logs
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directory. This log describes WebSphere Application Server actions
such as importing WebSphere Commerce entity beans and creating the
data source.

createdb.log
Found in your
drive:\WebSphere\CommerceServer\instances\instance_name\logs
directory. This log describes the WebSphere Commerce schema
creation.

WCSconfig.log
Found in your drive:\WebSphere\CommerceServer\instances directory.
This log describes what the Configuration Manager is doing. You can
modify the level of detail in this log through the menu options in the
Configuration Manager.

populatedb.log
Found in your
drive:\WebSphere\CommerceServer\instances\instance_name\logs
directory. This log describes the population of the database that is
created during instance creation.

populatedbnl.log
Found in your
drive:\WebSphere\CommerceServer\instances\instance_name\logs
directory. This log describes the population of national language data
into the database that is created during instance creation.

wcs.log
Found in your
drive:\WebSphere\CommerceServer\instances\instance_name\logs
directory. This log describes the startup of the WebSphere Commerce
application server.

Troubleshooting

WebSphere Commerce installation problems
The following section describes possible problems you may encounter when
you install WebSphere Commerce 5.4.
v Configuration Manager error message for new customers: Cannot create

database.

One or more of the DB2 services are not running. The possible causes are:
1. Your machine was only logged off instead of performing a complete

restart when you installed WebSphere Commerce.
Reboot the machine and recreate the WebSphere Commerce instance
using the Configuration Manager.
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2. The DB2 install failed and the services are not able to start. To install
DB2, do the following:
a. Uninstall DB2 by following the instructions in Appendix C,

“Uninstalling WebSphere Commerce components” on page 163.
Ensure the drive:\Db2 and drive:\WebSphere\sqllib directories
have been deleted from the drive you are installing on.

b. Reinstall DB2 from the DB2 Universal Database CD. To install DB2,
see “Installing DB2 on a Remote Machine” on page 9.

c. Recreate the WebSphere Commerce database using the Configuration
Manager.

v The setup.exe program halts with an ″UninstallShield is running″ message.
– Ensure that you have logged on to your Windows operating system with

a user ID that has administrator authority.

WebSphere Application Server problems
v The IBM WS Admin Server service fails to start with a service specific

error 10 message:
A common cause of this problem is the presence of stray java processes
which were not completely terminated when the IBM WS Admin Server
service was previously stopped. Check for and delete these processes in
Task Manager and restart the IBM WS Admin Server service.
This problem may also result from database connection problems with the
WebSphere Application Server repository database. Check the WebSphere
Application Server tracefile found in the drive:\WebSphere Application
Server\logs directory for more information. Also confirm that the
admin.config file contains the correct com.ibm.ejs.sm.adminServer.dbUrl,
and that the JDBC driver, db2java.zip is located the
com.ibm.ejs.sm.adminserver.classpath.
This problem can also be caused by a blank line at the end of the
drive:\WebSphere\AppServer\bin\admin.config file. Delete the blank line
and attempt to restart the service.

Database problems
The following describes possible problems you may encounter with DB2
Universal Database and WebSphere Commerce 5.4.
v If DB2 Universal Database does not appear to install properly (the progress

indicator bar hangs at 95% during the install), check the db2.log file. If
Error 106 appears near the end of the log, you should exit the installation
and reinstall DB2 Universal Database by itself from the DB2 Universal
Database CD. After DB2 Universal Database has been installed, attempt to
install WebSphere Commerce again from the WebSphere Commerce
Professional Edition CD.

v Your DB2 database services do not start when you reboot Windows.
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Check the Windows Event Viewer (normally found under Start Menu —>
Programs —> Administrative Tools). The failure of a DB2 service to start
will normally generate an error report stating why the service could not be
started.

Database instance problems
The following describes possible problems you may encounter with your DB2
Universal Database instance and WebSphere Commerce 5.4.
v The WebSphere Commerce server fails to start after configuration has

completed.
The possible causes are:
1. The WebSphere Commerce server cannot connect to the database. The

possible causes for not connecting to the database are:
– The database user logon ID and password are incorrect or contain

invalid characters. To check the database user logon or password, run
the Configuration Manager. Ensure that the database user ID
specified in the Configuration Manager has Administrator authority
on the Windows machine.

– The DB2 database for your WebSphere Commerce instance does not
exist. Use the Configuration Manager to create a new database.

– The DB2 database for your WebSphere Commerce instance is not
cataloged. This may have been caused by uninstalling and then
reinstalling DB2. Catalog the instance by typing the following
command in a DB2 command window:
db2 catalog db db_name

where db_name is the name of your database.
– DB2 services are not running.

2. The WebSphere Commerce server has detected a back-level database.
The following error message will be found in your db2.log:
The database has not been migrated to version 5.1 of
WebSphere Commerce.

This problem occurs for existing WebSphere Commerce customers or
new WebSphere Commerce customers with existing databases. The
possible causes for the database not being migrated are:
– The database user logon ID or password contains invalid characters.

To correct this, do the following:
a. Change the logon ID and password to one with administrative

authority. Run the Configuration Manager and select Settings to
correct the user ID and password on the Database page. Ensure
that the database user logon ID specified in the Configuration
Manager has Administrator authority on the Windows machine.
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b. Start the WebSphere Commerce server from Windows Services
Manager.

– The WebSphere Commerce server detected a communication error as
indicated in the log file. This error occurs for new WebSphere
Commerce customers. The probable cause is an improper TCP/IP
configuration for the machine. Configure TCP/IP within the
Windows Network service, and then delete and create the WebSphere
Commerce instance using the Configuration Manager.

v If you have uninstalled and reinstalled DB2 Universal Database, and you
attempt to start an instance that was created before DB2 Universal Database
was uninstalled, it initially appears that the instance still exists. When you
look at this instance in the services menu it is listed as running, but in the
Configuration Manager it is listed as being inactive. You must remove this
instance and recreate it.

Web Server problems
The following describes possible problems you may encounter with your Web
server and WebSphere Commerce 5.4.
v IBM HTTP Server will not start after you have installed WebSphere

Application Server
Try to start the IBM HTTP Server in debug mode. To do this, at a command
prompt change to the drive:\WebSphere\HTTPServer directory and type
Apache

If the server will not start the error preventing the service from starting will
be listed. Correct the error and attempt to run Apache.exe again until all
errors are resolved.

v IBM HTTP Server will not start after you have installed WebSphere
Application Server.
Your httpd.conf may contain incorrect syntax. Check the syntax of your
httpd.conf file by doing the following:
1. Log in as a Windows user with Administrative authority..
2. From a command prompt, enter the following commands:

cd drive:\WebSphere\HTTPServer
apache -t

v IBM HTTP Server will not start after you have installed WebSphere
Application Server.
You may be missing a line in your httpd.conf file. Open
drive:\WebSphere\HTTPServer\conf\httpd.conf. Uncomment the following
lines, or add them if they do not exist:
LoadModule ibm_app_server_http_module

drive:\WebSphere\AppServer\bin\mod_ibm_app_server_http.dll

Alternately, the
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LoadModule ibm_app_server_http_module
drive:\WebSphere\AppServer\bin\mod_ibm_app_server_http.dll

and the
AddModule mod_app_server_http.c

drive:\WebSphere\AppServer\bin\mod_ibm_app_server.dll

lines may have been switched during installation. Ensure that LoadModule
precedes AddModule in the httpd.conf file.

Note: All the LoadModule lines shown above have been formatted for
readability purposes only. Each line, starting with LoadModule or
AddModule and ending with mod_ibm_app_server.dll appears on a
single line in the httpd.conf file.

WebSphere Commerce problems
v You cannot access a WebSphere Commerce JavaServer Pages (JSP) file.

Ensure that the JSP file is in the correct location.
Ensure that the WebSphere Commerce server has been started in the
WebSphere Application Server Administrator’s console.

v Response is slow.
Check the system load using operating system utilities
Check the Web server access logs to determine the user load on the system.
For IBM HTTP Server, these can be found in the
drive:\WebSphere\HTTPServer\logs directory.
Enable the WebSphere Commerce performance monitor to identify accessed
components. This component can be enabled through the Configuration
Manager. See “Components” on page 78 for more information.
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Appendix E. Where to find more information

More information about the WebSphere Commerce system and its components
is available from a variety of sources in different formats. The following
sections indicate what information is available and how to access it.

WebSphere Commerce information

The following are the sources of WebSphere Commerce information:
v WebSphere Commerce online help
v WebSphere Commerce portable document format (PDF) files
v WebSphere Commerce Web site

Using the online help
The WebSphere Commerce online information is your primary source of
information for customizing, administering, and reconfiguring WebSphere
Commerce. After you have installed WebSphere Commerce, you can access
the information in either of the following ways:

Note: The WebSphere Commerce online information is only available if you
selected the WebSphere Commerce documentation option during the
installation process.

v Select Start → Programs → IBM WebSphere Commerce → Documentation.
v Open your browser and type the following Web address:

http://host_name/wchelp

where host_name is the fully qualified TCP/IP name of the machine where
you have installed WebSphere Commerce.

Locating the printable documentation
Some of the online information is also available on your system in PDF files,
which you can view and print using Adobe® Acrobat® Reader. You can
download Acrobat Reader for free from the Adobe Web site at the following
Web address:
http://www.adobe.com

Viewing the WebSphere Commerce Web site
WebSphere Commerce product information is available at the WebSphere
Commerce Web site:
v Business Edition:

http://www.ibm.com/software/webservers/commerce/wc_be/lit-tech-general.html
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v Professional Edition:
http://www.ibm.com/software/webservers/commerce/wc_pe/lit-tech-general.html

A copy of this book, and any updated versions of this book, are available as
PDF files from the Library section of the WebSphere Commerce Web site. In
addition, new and updated documentation may also be available from the
Web site.

IBM HTTP Server information

IBM HTTP Server information is available at the following Web address:
http://www.ibm.com/software/webservers/httpservers/

The documents are in HTML format, PDF files, or both.

Payment Manager information

Additional Payment Manager information is available through the library link
on the Payment Manager Web site:
http://www.ibm.com/software/webservers/commerce/payment

Payment Manager documentation is available in the following locations:
v In the \docs\locale directory of the IBM Payment Manager 3.1.2 CD.
v In the \docs\locale directory of the IBM Payment Manager 3.1.2 Cassette

CDs.
v Installed in the following location:

drive:\WebSphere\AppServer\InstalledApps\PaymentManager.ear\
PaymentManager.war\locale

The following Payment Manager documentation is available:
v The IBM WebSphere Commerce Payments for Multiplatforms Installation Guide

PDF file format (paymgrinstall.pdf)
v The IBM WebSphere Commerce Payments Administrator’s Guide PDF file format

(paymgradmin.pdf)
v The IBM WebSphere Commerce Payments for Multiplatforms Pogrammer’s Guide

and reference PDF file format (paymgrprog.pdf)
v The IBM WebSphere Commerce Payments for Multiplatforms for SET Supplement

, in PDF file format (paymgrset.pdf)
v The IBM WebSphere Commerce Payments for Multiplatforms Cassette for VisaNet

Supplement PDF file format (paymgrvisanet.pdf)
v The IBM WebSphere Commerce Payments for Multiplatforms for CyberCash

Supplement , in PDF file format (paymgrcyber.pdf)
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v The IBM WebSphere Commerce Payments for Multiplatforms for BankServACH
Supplement , in PDF file format (paymgrbank.pdf)

v The WebSphere Commerce Payments README file, in HTML format
(readme.framework.html)

v The IBM Cassette for SET README file, in HTML format
(readme.set.html)

v The IBM Cassette for VisaNet README file, in HTML format
(readme.visanet.html)

v The IBM Cassette for CyberCash README file, in HTML format
(readme.cybercash.html)

v The IBM Cassette for BankServACH README file, in HTML format
(readme.bankservach.html)

The Secure Electronic Transactions section of the WebSphere Commerce online
help also contains Payment Manager information.

WebSphere Application Server

WebSphere Application Server information is available at the WebSphere
Application Server Web site:
http://www.ibm.com/software/webservers/appserv

DB2 Universal Database information

DB2 information is available on your system after you install DB2. To access
it, click Start, point to Programs, point to DB2 for Windows NT or DB2 for
Windows 2000, and click Information Center.

For the most recent information, refer to the RELEASE.TXT file. This file is
located in the directory where the product is installed.

For a complete list of the available DB2 documentation, and how to view or
print it, refer to the DB2 Quick Beginnings for Windows book. Additional DB2
information is available at the following Web address:
http://www.ibm.com/software/data/db2

Other IBM publications

You can purchase copies of most IBM publications from your IBM authorized
dealer or marketing representative.
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Appendix F. Program specifications and specified
operating environment

This version of WebSphere Commerce supports the following operating
environments:
v Windows NT Server 4.0 with Service Pack 6a
v Windows 2000 Server or Advanced Server

WebSphere Commerce 5.4 includes the following components:

WebSphere Commerce Server
The WebSphere Commerce Server handles the store, and
commerce-related functions, within your e-commerce solution.
Functionality is provided by the following components:
v Tools (Store Services, Loader package, Commerce Accelerator,

Administration Console)
v Subsystems (catalog, member, negotiation, order)
v Product Advisor
v Common server run time
v System management
v Messaging services
v WebSphere Application Server

Store Services
The Store Services provides a central location for creating,
customizing, and maintaining certain operational features of a store.

Loader package
The Loader package allows the initial load of product information
through ASCII and XML files, as well as incremental updates of
complete or partial information. Online catalogs are updated using
this tool.

WebSphere Commerce Accelerator
Once your store and product data have been created, use the
WebSphere Commerce Accelerator to manage your store and to
facilitate your business strategies. WebSphere Commerce Accelerator
provides an integration point for all functionality that WebSphere
Commerce delivers for operating an online store, such as store and
product management, marketing, customer orders, and customer
service.
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WebSphere Commerce Administration Console
The Administration Console allows a Site Administrator or Store
Administrator to perform tasks related to site and store configuration,
including the following:
v User and group management (access control)
v Performance monitoring
v Messaging configuration
v IBM WebSphere Payment Manager functions
v IBM Payment Manager functions
v Brokat Blaze Rules administration

The following products are bundled with, and supported by, WebSphere
Commerce 5.4:

IBM DB2 Universal Database 7.1.0.55
DB2 Universal Database is a full-feature relational database used by
WebSphere Commerce as a repository for all of the information about
the site. This includes product and category data, pointers to graphical
elements for the pages, order status, address information, and many
other types of data.

DB2 Extenders
DB2 Extenders is an optional component for DB2 which provide
additional search capabilities to your site. DB2 Text Extender adds the
ability to support numerous search types by your customers including
searching for synonyms, inexact matches and words in close
proximity, as well as boolean and wildcard searches.

IBM HTTP Server 1.3.19.1
IBM HTTP Server is a robust Web server that provides extensive
management capabilities; support for Java deployment; proxy server
services; and security features including support for SSL 3, such as
client and server authentication, and data encryption.

IBM Payment Manager 3.1.2
Payment Manager provides real-time Internet payment processing for
merchants using a variety of methods including SET (Secure
Electronic Transaction), and Merchant Initiated Authorization.

WebSphere Application Server 4.0.2
WebSphere Application Server is a Java-based application
environment for building, deploying and managing Internet and
Intranet Web applications. This product includes the IBM Developer
Kit for Windows, Java 2 Technology Edition, v1.3 .

IBM WebSphere Commerce Analyzer 5.4
IBM WebSphere Commerce Analyzer is a new, optionally installed
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feature of WebSphere Commerce. A WebSphere Commerce-specific
entry edition of IBM WebSphere Commerce Analyzer provides reports
for customer profiling and monitoring campaign performance. The
reports cannot be customized. Note that you cannot install IBM
WebSphere Commerce Analyzer without Brio Broadcast Server.

Brio Broadcast Server
The Brio Broadcast Server is a batch processing server that automates
query processing and report distribution. Although the Brio Broadcast
Server can deliver large amounts of data to many people, security
safeguards are built into the product to enable administrators to
tightly control database access and document distribution.

IBM SecureWay Directory Server 3.2.1
IBM SecureWay Directory provides a common directory for you to
reduce the high costs associated with application-specific directories.
IBM SecureWay Directory is an LDAP cross-platform, highly scalable,
robust directory server for security, and e-business solutions. The
version of SecureWay that was shipped with WebSphere Commerce
was 3.1.1.5, however support is now offered for IBM SecureWay
Directory Server 3.2.1, which is available for Web download.

Segue SilkPreview 1.0
Segue SilkPreview provides a repository of information to analyze and
report results throughout application development.

WebSphere Commerce 5.4 Recommendation Engine powered by LikeMinds
Macromedia LikeMinds provides product recommendations and
targeted promotions for each individual Web visitor. It is a
personalization server based on collaborative filtering and market
basket analysis.

WebSphere Commerce 5.4 also supports the following:
v Oracle Database 8.1.7, Enterprise Edition or Standard Edition
v Lotus Domino Web server, 5.0.5, 5.0.6, and 5.0.8
v iPlanet Web Server, Enterprise Edition 4.1.8
v Microsoft IIS 4.0
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Notices

This information was developed for products and services offered in the
U.S.A.

IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

Any reference to an IBM licensed program in this publication is not intended
to state or imply that only IBM’s licensed program may be used. Any
functionally equivalent product, program, or service that does not infringe
any of IBM’s intellectual property rights may be used instead of the IBM
product, program, or service. Evaluation and verification of operation in
conjunction with other products, except those expressly designated by IBM, is
the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504–1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan
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The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Canada Ltd.
Office of the Lab Director
8200 Warden Avenue
Markham, Ontario
L6G 1C7
Canada

Such information may be available, subject to appropriate terms and
conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement or any equivalent
agreement between us.
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Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments
may vary significantly. Some measurements may have been made on
development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some
measurement may have been estimated through extrapolation. Actual results
may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change
or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is
subject to change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include
the names of individuals, companies, brands, and products. All of these
names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

Credit card images, trademarks and trade names provided in this product
should be used only by merchants authorized by the credit card mark’s owner
to accept payment via that credit card.

Trademarks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States, other countries, or both:

WebSphere DB2 DB2 Extenders
DB2 Universal Database VisualAge IBM
SecureWay

Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated.

Notes, and Lotus are trademarks or registered trademarks of Lotus
Development Corporation in the United States, other countries, or both.
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Microsoft, IIS, Windows, Windows NT, and the Windows logo are trademarks
or registered trademarks of Microsoft Corporation in the United States, other
countries, or both.

Netscape is a registered trademark of Netscape Communications Corporation
in the United States and other countries.

Oracle is a registered trademark and Oracle9i is a trademark of Oracle
Corporation.

Pentium is a trademark of Intel Corporation in the United States, other
countries, or both.

Solaris, Solaris Operating Environment, JDK, JDBC, Java, HotJava and all
Java-based trademarks and logos are trademarks or registered trademarks of
Sun Microsystems, Inc.

UNIX is a registered trademark of The Open Group in the United States and
other countries.

Other company, product or service names may be the trademarks or service
marks of others.
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